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GENERAL INTRODUCTION 

INTRODUCTION 

BRAIN QUICK SOFTWARE is the software that handles all of Micromed acquisition and Review systems for EEG, 
EMG and EP, which means that according to the enabled key options, BRAIN QUICK SOFTWARE integrates all 
types of exams in a single application, such as:  

• EEG  

• Video EEG  

• Long term monitoring of Epilepsy - Stereo EEG  

• Ambulatory EEG/PSG  

• EEG Recording during functional MRI  

• Electromyography  

• Evoked Potentials  

• Intra-Operative Monitoring  
 
The configurations are opened towards external systems and are organized according to the criteria of 
maximum working flexibility. The single archive and project design guarantee that all the standard activities 
of Acquisition, Review, Analysis, Report and Archive of all exams can be managed in a single unit or on several 
systems distributed over a network. The program has been designed to be offered in various 
performance/feature levels. Hence, some of the features described in the present manual could be not 
available on the software installed on your system. 
 
This document includes updated features available from BRAIN QUICK SOFTWARE version 3.05. 
 

It is intended to manage the following hardware devices: 

• SD PLUS FLEXI amplifier 

• SD PLUS FLEXI HIGHRATE amplifier  

• SD PLUS FLEXI CLINIC amplifier  

• SD PLUS RESEARCH amplifier  

• MORPHEUS amplifier  

• BRAIN SPY PLUS amplifier  

• SD LTM 32 PLUS, SD LTM 64 PLUS amplifiers 

• SD LTM 32 EXPRESS, SD LTM 64 EXPRESS amplifiers 

• SD LTM STIM cortical stimulator 

• BQ NET POE M interface 

• BQ NET POE 2 interface 

• BQ NET POE PLUS interface 

• BQ USB interface 

• BQ USB EXPRESS interface 

• BQ USB PLUS interface 

• BQ USB MULTI interface 

• BOX TERMINAL EXPRESS interface 

• BOX TERMINAL MULTI interface 
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This manual describes the functionality of the software and how to carry out the examination programs for 
neurophysiologic studies. 

SYSTEM REQUIREMENTS 

PROCESSOR: Intel® i7 minimum, 2.1 GHz or faster 
MEMORY: 16 GB RAM minimum  
HARD DISK: 512 Gb minimum  
OPERATING SYSTEM: Windows 10 – 64bit  
DISPLAY: 22’’ minimum  
SCREEN RESOLUTION: 1920x1080 minimum (FullHD aspect ratio 16:9) 
NETWORK CARD: 1Gb 
OUTPUT PERIPHERALS: Any display meeting IEC 60950 requirements and printer supported by the installed 
operating system.  
NETWORK: Systems meant to be connected to the local network will need an Ethernet cord with RJ45 
connector. 
INPUT PORT FOR USB CONNECTION 

 

If Brain Quick software shall be installed in a Citrix environment, the server shall satisfy the following minimum 
specifications:  

PROCESSOR: 4 vCPUs  
OPERATING SYSTEM: Windows Server 2016 (10.0.14393) minimum 
MINIMUM CITRIX XENAPP/VAD VERSION: 7 (1903.1) minimum 
MEMORY: 16 GB RAM minimum 
HARD DRIVE STORAGE (USABLE): 80 GB OS minimum and 40 GB App (Optional)  
OPERATING SYSTEM FEATURES:  
- PDF reader and default application set for .pdf file type  
- .Net 4.0 or later  
 
Separation devices: Parts of the system that are in the “Patient Area” or are electrically linked (i.e. data cable, 
network or triggers) to devices in the patient area needs proper isolation from the mains voltage and measure 
to lower the leakage currents on the enclosures of IT-devices included in the system. Hence, the use of a 
separation transformer on their mains connection, or proper separation devices between devices in patient 
area and devices outside it (e.g. BQ USB interfaces) is mandatory. The user must not the system configuration 
made by authorized technicians at the installation. 

Failure to use Separation Transformer Units or complete systems from our company will void any declaration 
of compliance with the standards from our company.  

INTENDED USE 

BRAIN QUICK SOFTWARE is explicitly designed to help physicians in recording, archiving, and reviewing data 
coming from Micromed digital acquisition systems.  
 
BRAIN QUICK SOFTWARE can be used for EEG, EMG, and EP exams and other neurophysiologic studies based 
on the data recorded from the patient through Micromed acquisition devices. The software could also be used 
for cortical stimulation during electroencephalography examinations (i.e. stereoEEG) in combination with 
specific stimulators.  
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Some analysis functional tools are provided as default or software options. Results coming from these tools 
must never substitute the critical interpretation and the clinical conclusions by a physician.  
 
BRAIN QUICK SOFTWARE is not intended to continuously monitor central nervous system functionality, in 
conditions where a warning on the change of patient condition is essential (e.g. OR and ICU automatic 
monitoring without the presence of the physician), since the system is not equipped with proper alarms that 
substitute continuous medical surveillance. The use of BRAIN QUICK SOFTWARE must always be overseen by 
a physician or a qualified technician. 

INTENDED USERS 

The use of the software is reserved to physicians, technicians, or other medical professionals that are trained 
in bio-potential recording. Also when it is used at home, the intended users are the medical professionals that 
are the only people that have the skills to start and stop the signals’ recording and review the traces. 

ADDITIONAL INFORMATION 

BRAIN QUICK Software is not intended to continuously monitor Central Nervous System functionality in 
conditions where a warning on the change of patient condition is essential (e.g. OR and ICU automatic 
monitoring without the presence of the physician), since it is not equipped with the proper alarms that 
substitute continuous medical surveillance. The use of BRAIN QUICK Software must always be carried out 
under the supervision of a physician or a qualified technician. 
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GENERAL PRECAUTIONS AND WARNINGS 
Read this section carefully. 

RESPONSIBILITY 

Micromed can only be held responsible for the accuracy of signals recorded under the circumstances described 
in this user manual. The collected data is not a substitute for the interpretation and clinical conclusions by a 
physician. 

Micromed cannot be held responsible for data generated by misuse of the equipment from its operators. 

BRAIN QUICK SOFTWARE CONFIGURATION 

• BRAIN QUICK Software installation must always be carried out by authorized technicians. Deep 
knowledge of the inside software structure and of the hardware system is needed. 

• To solve any problems that can arise during the use of software, contact your Micromed representative 
and the Micromed Service department. 

• DO NOT ATTEMPT TO MODIFY THE SYSTEM CONFIGURATION BY YOURSELF (including the parts of 
software that manages hardware setup and that are highlighted and described in the user manual as 
reserved to the technicians). For any needs, contact Micromed Service Department or a Micromed 
authorized technician. 

• The configuration of the resource list must only be performed by authorized personnel, since a wrong 
or incomplete configuration of resources can lead to data loss. Ask for Technical Assistance if you need 
to modify your system: the best software and hardware configuration according to your new exigencies 
will be suggested. 

• Moreover, it is strongly suggested not to install other software on the PC. Any additional software you 
install is at your own risk and Micromed cannot be held responsible for any problems from that 
installation. Intervention for resuming a situation where an additional installation has led to a problem 
will incur a charge by Micromed according to the standard Service Price List. 

DATA SAFETY 

• Micromed BRAIN QUICK SOFTWARE advanced storage and data management features work properly 
ONLY if the user does not copy or move data without using the proper archive function, which are better 
explained in the Archive section of the user manual. This allows the software archive references to 
always be synchronized with the current situation. OPERATIONS PERFORMED ON DATA FILE NOT USING 
THE BRAIN QUICK SOFTWARE ARCHIVE COMMANDS CAN LEAD TO TEMPORARY OR DEFINITIVE PATIENT 
DATA, EXAM OR FILE LOSS.  

• It is highly recommended to never access to BRAIN QUICK SOFTWARE work directories (defined in the 
path selection box of the installation setup, the database and resources setup screens) using the 
operating system functions (Windows Explorer or the desktop My Computer or Network 
Neighbourhood icons) to avoid any possible damage to the files.  

• Using BRAIN QUICK SOFTWARE, trace data and database backup can be stored on external supports.  

• Periodic backup of the database on external supports is available setting the “Database Backup 
Scheduler” properties. If these are already set, you should modify only the time interval between two 



BRAIN QUICK Software User Manual  

Rev. H                                                                          Page 13 of 267 

backups while the other configurations (e.g. the path) should be changed only under Micromed 
technician instructions. Refer to the related chapter of the user manual for detailed instructions.  

• IT IS RECOMMENDED TO PERFORM BOTH DATA AND DATABASE BACKUPS REGULARLY to prevent data 
loss due to physical support damage (e.g. scratches on CD-ROM surfaces) or to a problem with wrong 
linkage in the database management or to interference with some other running software.  

• Trace data and database backup can be performed on a similar or different type of support than the 
original one. Considering the particularly critical operation, BACKUP MUST BE PERFORMED ON DEVICES 
NOT CONNECTED TO THE NETWORK (or temporarily disconnected) in order to avoid accidental access 
to the data during the copy operation. 

DATA ACQUISITION AND ANALYSIS 

• Since BRAIN QUICK software uses a large amount of PC resources (memory and CPU), it is recommended 
to close other running applications, especially when performing operations that require the 
management of a great amount of data (e.g. video acquisition, 32 channel acquisition at high sampling 
rate and so on) otherwise, a message “SPEED ERROR” could appear and the acquisition could be 
stopped.  

• During data acquisition, it is recommended that the user checks the quality of the resulting traces, 
keeping them displayed on the monitor. No other operation should be performed during acquisition, in 
order to minimize the error probability. During the review of the traces for interpretation, it is 
recommended to check the correspondence of the traces displayed to those desired (patient data, trace 
parameters, montage).  

• The measures automatically performed (e.g. nervous conduction velocity calculation) by EMG and EP 
software, according to the settings chosen by the user, display the numerical results on the side of the 
related trace. The flags on the trace indicate the calculation points. The physician that performs the exam 
should always check if the points selected by the software are the most significant ones from a clinical 
point of view, and should eventually correct them manually. In all the software features, any automatic 
analysis tool always has to be considered help in interpreting traces, and not the interpretation itself. 

CYBERSECURITY 

Micromed systems should comply with the following recommended cybersecurity controls: 

- The PC should have an antivirus installed, Micromed usually uses Paloalto Cortex XDR antivirus 

- User passwords have to be private and follow the recommended password policy listed below: 

o They have to be renewed every six months 

o They have to be at least 8 characters long 

o They have to contain both upper-case and lower-case letters (case sensitivity) 

o They have to include special characters, such as @, #, $ 

o Passwords that match the format of calendar dates, license plate numbers, telephone 
numbers, or other common numbers are not allowed should be avoided 

- If the system is connected to a computer network (intranet and/or internet), the firewall must 
be active and properly configured by technical personnel to allow Micromed software network 
services 

- Usage of USB media devices should be limited 

- Only a limited set of users should access shared folders and disk resources – sharing of 

https://en.wikipedia.org/wiki/Case_sensitivity
https://en.wikipedia.org/wiki/License_plate


BRAIN QUICK Software User Manual  

Rev. H                                                                          Page 14 of 267 

resources by several people should be avoided 

- It is also recommended to install the most important Windows updates and patches as soon 
as they are available on Microsoft update centre. 

HIPAA AND GDPR COMPLIANCE 

In the implementation of software, Micromed implemented all the necessary measures to ensure the 
compliance with HIPAA and GDPR regulations, including controls to guarantee the protection of e-PHI (Patient 
Health Information). 

The design solutions adopted by Micromed consider the following aspects: 

1. Ensure the confidentiality, integrity and targeted availability of all patient information 

2. Identify and protect the software against external threats, which could compromise the security or 
integrity of the information 

3. Protect the software from improper use 

Furthermore, the software must always be installed in environments that are compliant with the current 
network regulations. 
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ARCHIVE – FILE MANAGER SOFTWARE 

ABOUT FILE MANAGER 

FILE MANAGER is the gateway to review patient data, execute analysis, create reports, or start and stop a 
study. 
 
The software is comprised of an application conforming to Windows standard and of an archive adhering to 
ODBC standards; any query can be performed following SQL standards.  
Micromed has optimized the FILE MANAGER layout for efficiency: users can manage any part of archived 
information and the transfer processes from one screen. 
 
All FILE MANAGER features are enabled by a dedicated software license. 
 

ACCESS TO THE SOFTWARE 

User can access to FILE MANAGER with or without authentication.  

User authentication can be activated from Micromed Suite after installation, in server machine in case of 
distributed environment. Logon preferences are then centralized and modifiable only from Micromed Suite. 

When user authentication is enabled the Logon system is active and the user must enter valid credentials to 
access FILE MANAGER; otherwise, if user authentication is disabled, it is possible to directly access FILE 
MANAGER as “Windows User” logged in the machine. 

For further details about access mode configuration, see the Logon System Configuration section of this 
manual.  

WINDOWS USER ACCESS 

When authentication is disabled, login is not required and access to software is direct. When accessing without 
authentication, whole set of functions is available, depending on user permission, and Windows user is set as 
logged-in user. 

 
For a detailed description of each functionality, see the dedicated sections of this manual. 

AUTHENTICATED ACCESS 

If the Logon system is active, user authentication is required before accessing the application. 

A valid username and password must be entered to access FILE MANAGER (see figure below). Once entered, 
click the “Sign In” button to proceed. 

Only two failed authentication attempts are allowed; the application will close on the third failed attempt. 

 
Note. Only users registered in the centralized Users database can access FILE MANAGER. The application 
allows to authenticate using both Windows user (Active Directory domain user) and non-AD user 
credentials; see the dedicated section of this manual for a complete description of the Users database 
Configuration and Users management. 
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When accessing through authentication, the functions to Switch User and Lockdown are enabled and become 
visible to the user. 

The “Reassign Patient” and “Merge Patients” features are NOT available if the HL7 Interface is enabled, the 
latter allows to manage order entries received from the Hospital Information System (HIS); these operations 
are performed automatically only when a specific request is received from HIS in order to guarantee a 
constant alignment between patients database and the anagraphic data managed centrally by the HIS. HL7 
is a widely adopted set of standards and protocols designed to facilitate the exchange, integration, sharing, 
and retrieval of electronic health information among healthcare systems. It ensures interoperability and 
communication between diverse healthcare applications, devices, and information systems. By providing a 
common framework for the exchange of clinical and administrative data, HL7 contributes to the 
improvement of healthcare delivery, patient care coordination, and overall efficiency within the healthcare 
ecosystem. For more information about HL7 interface, see HL7 section of this manual. 

FILE MANAGER functionalities depend on the user permissions when authenticated access is enabled. 

Each user accessing the FILE MANAGER has a specific role, i.e. a collection of permissions which define which 
operations are or are not allowed for that user. See section below for a complete list of available user 
permissions. 

 

EMERGENCY LOGON 

Emergency logon is an important feature that allows to authenticate in File Manager application in case of 
users database not reachable or server LDAP offline. 
In those cases, user is not able to authenticate, and after the third login attempt failed, File Manager detects 
the anomaly and prompts the user whether he wants to log using emergency logon to record an exam 
(EEG/EMG/EP). 
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If the user clicks on No, it is possible to quit the application, instead if the user clicks on Yes, File Manager 
starts in Emergency Logon mode. By default no patient is selected, patients list looks blurred and user cannot 
interact with it. Other features not available in case of emergency logon are: 

• New/Search, Switch User, Lockdown 

• Patients’ information 

• Filters 

• Exam contextual menu 

• Quick search 
From emergency logon, it is possible to create a new patient and, in case it is already recorded in the database, 
File Manager will directly point to it to start a new recording. 
 

 
 
The user can acquire and record new exams for the newly created patient, using EEG and EMG/EP acquisition 
software. 
 

USER PERMISSIONS 

One of the greatest advantages offered by authenticated access is represented by role-based restrictions. 
Each FILE MANAGER user is assigned a specific Role which determines user capabilities and restrictions.  
Each Role consists of a collection of permissions covering key features and operations available within 
Micromed system.  
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FILE MANAGER offers up to six levels of granularity, i.e. six pre-defined roles: the Administrator one and other 
five customizable roles allowing to handle up to five different combinations of permissions (Senior Doctor, 
Junior Doctor, Senior Technician, Junior Technician, Guest). 

All user permissions available are the following: 

1. Report creation/modification 

2. Report deletion 

3. Ability to mark patients and exams as “read” 

4. File deletion 

5. EEG and Video EEG reduction 

6. Patient creation and deletion 

7. Patient demographic data modification 

8. Ability to acquire  

9. Modification of doctor and technician information related to exam  

10. Resources creation/modification/deletion 

11. Manual reassignment of exam to another patient (*) 

12. Manual merge of two patients (*) 

13. Machine Settings change 

14. Central Settings change 

15. Manual archiving 

16. Management of HIS requests (HL7 interface) 

17. Report export to HIS 

18. Add/Modify/Delete database values of lookup lists 

 
(*) Features disabled if the HL7 Interface is enabled. 

 
Note. Not all permissions are available for all roles. Permissions are however customizable 
 

WORKING CONFIGURATION AND OPERATING MODE 

FILE MANAGER supports two possible working configurations: 

• Distributed System: system of workstations connected in a network domain with a centralized users 
administration and a centralized settings management. In such configuration there is typically a server 
machine hosting: the central SQL database (ensuring that any file or exam can be retrieved by any 
user at any time), the centralized Users Database and the Audit Log database. In such networked 
environment there can also be local SQL databases separate from the central one, generally on LTM 
acquisition stations.  

• Stand-Alone: single workstation, never connected to other stations, with its own local configuration 
and no need to share settings or have a centralized audit trailing; typically user authentication is 
disabled. 
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Note. Configuration type must be defined at installation time. 

Both configurations require File Manager Core service to be installed together with FILE MANAGER software 
in the workstation. Distributed System configuration requires a File Manager Core Client instance installed 
locally in communication with central File Manager Core Server instance installed on server; instead, Stand-
alone configuration requires only a File Manager Core instance installed locally. 

File Manager Core service is responsible of centralized user administration, centralized settings management 
and centralized audit trailing. 

 

OPERATING MODE 

In a Distributed System configuration, the operating mode is very important. It determines if and how your 
computer communicates with the central database and other computers in the network. 

Working machine can be either Online or Offline. 

Working Online 
In a distributed environment, communication with central server and between stations is based on network 
connection.  
If the system is online, central settings are kept synchronized with central configuration and audit trailing, if 
enabled, is centralized. 
In addition, all running EEG recordings in other online stations can be monitored through the Acquisition List 
and the other review stations of the system can monitor the EEG recording running on your workstation, if 
any. 

Working Offline 
When the network connection is not available, your workstation is in offline mode.  
If the system is online, user authentication is guaranteed and audit trailing, if enabled, is stored locally. 
Changes made to central settings are not uploaded to server until online mode is recovered and no 
centralization or sharing is possible. 
During the offline period, you cannot monitor EEG studies running on other stations, and any recording made 
on your workstation is not available for monitoring either.  
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MAIN WINDOW 

BASIC OVERVIEW 

 

FILE MANAGER is the working environment for other Micromed acquisition and review software. It is the user 

gateway to review patient data, record new information or run new studies. 

FILE MANAGER application manages files, exams, and patients, that are stored in a resource, linked to a 

database. 

 

FILE MANAGER main window consists of three main components: 

1. View pane, which displays patient and exam information accessible by the current resource.  
Displayed data are grouped in a patient-based view, with the Patients List on the left and the Exams 
List on the right, showing the exams associated to the currently selected patient. From View pane, 
user can change resource selecting one available from dropdown menu. 

 

 

Standard Layout Split View 

2. Resource List, which contains all defined resources or folders where patient and exam information is 
located 

3. Information panels, which displays patient relative information 

 
In the upper part of the main window there is a General Information Area composed by the Title Bar, the 
Ribbon Bar, the Application Button and the Quick Access Toolbar; at the bottom of the screen there is the 
Status Bar. 
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Main Window Overview 

In the following paragraphs the function and content of each component is explained. 
 

View Pane and Layouts 
The View Pane is a picture of patient and studies information stored inside Micromed database; depending on 
the type of layout selected it shows information in different ways. 
 
Available layouts are patient-based; the View pane is always split into two components: the Patients List on 
the left, above which the name of the selected resource is shown, and the Exams List on the right, which 
groups all the exams for the patient selected in the Patients List; see paragraphs below for more details about 
Patients List and Exams List. 
The total number of items (patients or exams) and the number of selected items is shown below each list. 
 
There are three possible patient-based layouts: 

• Standard layout 

• Standard Split layout 

• LTM layout 
 

They represent three different ways to display patient and studies information.  
 
In addition to the three patient-based layouts there is a further layout, the Workflow overview, which is an 
exam-based multiple steps layout. It splits the View pane in four columns, one for each workflow step: each 
step corresponds to a specific status of the workflow and groups all studies in such status for all patients in 
one single list where each line represents a single visit; see section below for details. 
 
Default layout is the Standard layout and it is possible to change current layout clicking the related button 
available in the View Tab of the Ribbon Bar, as shown in the figure below. 
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Available Layouts 

 
Pagination in patient-based layout 

In patient-based layouts patients data visualization is organized in different pages to guarantee better 
performance and easier information display; this is very useful tool managing databases with a significant 
number of patients. 

It is possible to choose the number of patients to be displayed in each page; according to the set-up number, 
patients are split in a suitable number of pages and it possible to easily navigate through different pages by 
the navigation bar available at the bottom of the Patients List. The navigation bar displays the current page 
number, the total number of patients and it offers navigation arrows to go through patient pages and a “Go 
to page” button to directly jump to a specific page. 

 

Patients List - Pagination 

 

Standard Layout 

The Standard layout is suitable for displaying EEG routine studies in a collapsed way. 

It consists of Patients List on the left and Exams List on the right, as shown in the figure below. 
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Standard Layout – Routine EEG 

Exams List consists of a tree with two levels: 

• Exam, representing the recorded study 

• File, the inner level collecting all secondary files related to the study, such as videos, report and 

analysis 

 

Each column at each level of the Exams list shows specific information (according to the level) and it is possible 

to easily customize visible data by Column Chooser tool available in the contextual menu. 

To quickly expand/collapse the inner level for each study it is possible to click the “Plus”/ “Minus” icon next to 
patient name at the top left corner above the Exams List. 
 
Standard Split Layout 

Standard Split layout is the most suitable for displaying EMG-EP studies; it is also useful to display EEG routine 
studies and related details in an alternative way. 
It consists of Patient List on the left and Exam List on the right.  
It simply splits information displayed in the Exam List in two separate panes: the Exam pane above and the 
File pane below. 
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Standard Split Layout – Routine EEG 

In the case of an EMG-EP study, the EMG-EP recording session is represented by a single line, in the upper 
pane, and there is a line for each single examination performed within the same session, in the lower pane; 
any report related to the EMG-EP study can be found in the lower pane. 
 
In the case of an EEG routine study, the EEG recording session is represented by a line, in the upper pane, and 
there is line for each related secondary file, such as videos, report and analysis, in the lower pane. 
 
LTM Layout 

LTM layout is dedicated to LTM studies, and it is automatically activated when the option “Group LTM Exams 
into Visits” (display settings) is enabled. 
 
It is patient-based so it consists of Patients List on the left and Exams List on the right; it split each study 
information in two panes: the Visit pane above and the Exams List below. 
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LTM Layout 

The single LTM study grouping one or more EEG recording is represented by a line in the upper pane; the 
Exams List in the lower pane represents by a tree with two levels of detail all the recording related to the LTM 
study; the number of EEG recordings belonging to the LTM study are reported at the bottom of the exams list. 
Note. EEG recordings are grouped in LTM visit according to the grouping criteria set in the display settings. 
 
Workflow Overview 

Workflow overview layout is an exam-based layout, i.e., it collects in a single list all studies for all patients, 
but according to the respective workflow status; as shown in figure below. 
 

 

Workflow overview Layout 



BRAIN QUICK Software User Manual  

Rev. H                                                                          Page 26 of 267 

It consists of four steps, one for each workflow status, and for each step the view displays in a single list all 
studies which are marked as belonging to that specific workflow status. 
 
Default workflow steps are: 

• New 

• Pre-evaluated 

• Evaluated 

• Read 
 
The first columns of the studies list show essential information, such as the recording date, patient name and 
patient’s ID1; for each step it is possible to customize visible information by selecting the “Show Column 
Chooser” option available when right-clicking on each column header. 
 
Available columns are: 
a. Code 
b. Doctor 
c. Requesting Doctor 
d. Technician 
e. Hospital department 

Workflow overview allows to quickly move studies forward and backward through available step by selecting 
a study and simply dragging and dropping it to the desired workflow step. 
Workflow status associated to each study is stored in the “Marker” field and it can be used as filtering 
criterium. 
 

PATIENTS LIST 

Patients List displays all patients stored in the selected resource. Each patient is associated with a record, i.e. 
a line in the list of patients.  

Each column in the Patients List shows a customizable selection of patient information.  

It is possible to move a column to the desired position by dragging the column and dropping it before or after 
other columns. 

Left clicking on the header of one of the available columns allows to sort patients in ascending or descending 
order based on the selected field. In addition, right clicking on one of the available column headers opens a 
contextual menu with the following options: 

• Sort Ascending, to sort the Patients List in ascending order (according to the selected column) 

• Sort Descending, to sort the Patients List in descending order (according to the selected column) 

• Show Column Chooser, to choose the columns to display 
Available columns are: 

a. Gender 
b. Maiden 
c. Birth Date 
d. Age 
e. Height 
f. Weight 
g. Address 
h. City 
i. State 
j. Zip Code 

k. Country 
l. Home (home number) 
m. Mobile (mobile number) 
n. Insurance Number 
o. Insurance Company 
p. ID 1 
q. ID 2  
r. Hospital Department 
s. Comment 
t. Marker 
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u. Doctor 
v. Gestation Days 

w. Last Exam date 

 
Note. By default, the following columns are visible: Gender, Patient, Birthdate, Age, ID 1, and Doctor. 

• Best Fit, to adjust the width of the selected column to the best fit 

• Best Fit (all columns), to adjust the width of all visible columns to the best fit 

 

 

Column Chooser – Patients List 

EXAMS LIST 

The Exams List contains all examinations related to the patient selected in the Patients List. 

Information related to studies are organized and displayed in different way according to the selected layout, 
but there are always two levels of detail available, exam and file; a further level, the visit, is available in LTM 
layout in order to group more recordings related to a specific patient under the same study.  

Each column at each level of the Exams List shows a customizable selection information related to a specific 
study or file, according to the level. 

As for Patient Lists, left clicking on the header of one of the available columns allows to sort exam (file) in 
ascending or descending order based on the selected field.  

In addition, right clicking on one of the available column headers opens a contextual menu with the following 
options: 

• Sort Ascending, to sort exams (files) in ascending order (according to the selected column) 

• Sort Descending, to sort exams (files) in descending order (according to the selected column) 

• Best Fit, to adjust the width of the selected column to the best fit 

• Best Fit (all columns), to adjust the width of all visible columns to the best fit 
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Exam 
Exam level represents a specific recording session and corresponds to a line of the Exam List (upper level) or 
the Exam pane.  

Essential information related to a study are shown in the first columns. 

• The first column refers to the type of exam, which could be an EEG, an EMG-EP, or an anamnesis; a 
symbolic icon allows to easily recognize the examination type (see the figure below) 

• The second column summarizes which type of files are included in the study by showing a collection 
of representative symbols.  

 

Icon Description 

 

Study contains one or more video files 

 

Study contains analysis file 

 

Study contains one or more report file 

 

Study contains Persyst file 

“Study contains” Column -  Icons 

By clicking on the report icon it is possible to open the anamnesis and report files directly from this 
first level. If more than one file is present, when clicking on the report icon a tooltip list appears 
allowing to choose which file to open. 

• The third column is the Recording Date which shows the date and time in which the exam was 
created. 

 

Exams list – Exam Level Detail 
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Columns visible after the second can be chosen by users by clicking on the “Show Column Chooser” option in 
the right-click contextual menu available on each column header. 

Available columns are:  

a. Recording Date 

b. Code 

c. Comment 

d. Doctor 

e. Requesting Doctor 

f. Technician 

g. Hospital department 

h. Marker 

i. Quick Search Flag 0 through 5 

j. Corrupted Video 

k. Location 

l. Locked by Background Copy 

 

Default visible columns are Recording Date, Comment, Marker, and Locked by Background Copy. 

 

 

Column Chooser (Exam) – Exams List 

File 
File level is comprised of all the files associated to a selected exam, i.e. all the traces, reports, videos and files 
created during the analysis. 
As for the exam, the first column represents the file type through a symbolic icon. 
 
Visible columns after the first can be customized by clicking on the “Show Column Chooser” option in the right-
click contextual menu available on each column header. 
 
Available columns are: 

a. Recording Date 

b. Comment (file comment) 

c. Location (resource name) 

d. Storage (archive resource name) 

e. Doctor  

f. Requesting Doctor 

g. Technician 

h. Hospital Department 
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Default visible columns are Recording Date, Comment, and Location. 
 

 

Column Chooser (File) – Exams List 

Visit 
A Visit represents a collection of exams performed under the same recording session; it is typically used to 
represent LTM studies. 
 
Information available at visit level are only the essential ones. 

• The first column refers to the type of visit. 

Note. When the display option “Group LTM exams into Visits” is enabled, it is possible to choose the criteria 
according to which multiple exams are grouped under the same LTM session; options available are from 1 up 
to 7 days. For example, if the 1 day option is selected, all EEG recordings performed in the same day, i.e. within 
24h, are grouped together. 

• The second column summarizes which type of files are included in the visit by showing a collection of 
representative symbols (see the “Study contains Icons” table above for details). 

• The third column represents the Recording start, i.e. the date and time in which the LTM session was 
started. 
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Exams List - Visit 

RESOURCES LIST 

The Resources List is a dockable panel which lists all resources available to the user; the name of the resource 
is on the left and the available space is on the right. 
 
If path associated to a resource is not accessible or reachable the red message “File system not available” is 
shown next to the resource name (instead of the space available) to notify the user no operation can be 
successfully performed on such resource. Check the network connection, for resources associated to a 
network shared folder, and the correctness of the path entered in the resource definition. 
 

 

Resource - File System Not Available 

Clicking on a specific resource on the Resource list, patients and exams list display all patients stored in the 
database and for each one all studies stored on the selected resource path. 
View pane displays error messages if the patient and exam data loading fail for some reason. 
 
If patient database is not reachable the message shown in figure below will appear: 
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Main reasons behind such error are network disconnection or wrong resource definition, caused by incorrect 
database details filled. 
 
If resource name is not correctly defined0 the message below will appear: 
 

 
 
It is possible to create, modify, and delete a resource directly from the Resources List panel.  
Right-clicking on a resource a contextual menu will appear, allowing the user to modify or delete the selected 
resource.  
Right-clicking on the Resources List Panel, another contextual menu appears allowing the user to create a new 
resource; for further information, see the paragraph Data Access: Resources Configuration below. 
 
From the context menu it is also possible to hide resources by selecting the Show/Hide option, or to import 
or export one or more resources by selecting the Import and Export item, respectively. 
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Resource List – Context Menu 

 

RIBBON BAR 

On top of the FILE MANAGER main window, above the View Pane, there is the main toolbar, called Ribbon 
Bar, which helps the user to navigate through the software and shows all the functions that the application 
offers to the user. Buttons are grouped in different menus (or Tabs) according to their functionality.  

Ribbon Bar can be minimized keeping only tabs titles displayed.  

The user has the possibility to use this bar in normal mode, in minimized mode and on auto-hide mode, that 
is a function that automatically hides entire Ribbon Bar to work on the window in full screen. 
 
The Ribbon Bar of the FILE MANAGER is comprised of the following Tabs: 

• Home 

• View 

• Setup 

• Brain Quick (if installed) 

• Neurowerk (if installed) 

• SleepRT (if installed and configured) 

• Neurowerk EEG (if installed) 

• Neurowerk EMG (if installed) 

• Help 

 
A Refresh button is present in every tab and it allows to update patients list and the associated exams. 
 

Home Tab 
The Home Tab groups the FILE MANAGER main functions related to the management of patients and exams; 
buttons are organized in functional Groups. 
 
It contains the following Groups: 

• Patients 

• Exams 

• Anamnesis 

• Tools 

• HIS 
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• Auto Archive 

• Users 

 

 

 
Patients Group 

The Patients group offers four buttons for the creation, search, modification, or removal of a single patient. 
While the “New” and “New/Search” buttons are always available, the “Modify” and “Remove” buttons are 
enabled only when a patient has been selected. 
 
Clicking the New button opens the dialog for the creation of a new patient. As shown in the figure below, the 
dialog offers several fields that can be populated with the patient personal data. The only DEFAULT required 
fields are “Last name”, “First name” and “Birth Date”; mandatory fields are marked with a red X when empty.  
The “ID1” and/or “ID2” fields may also be set as mandatory. For more information, see the section related to 
Labels Customization.  
 

 

Once all the mandatory fields are filled, the “OK” button will become enabled. 
 
Note. “First name”, “Last name”, “Birth Date” and “ID1” fields are used by the FILE MANAGER application 
for the unique patient identification check performed every time a new patient is created or an existing 
patient demographic data is edited. 
 

When creating a new patient record, FILE MANAGER checks if another patient with the same demographic 
data already exists, to avoid any unwanted duplicates. If a matching patient record exists, the user is asked for 
confirmation before proceeding. 

file:///C:/Users/ca_andr/Downloads/wetransfer_brain-quick-software-user-manual-docx_2023-07-12_1551/BQS-UM-001%20BRAIN%20QUICK%20Software%20User%20Manual%20-%20GA.docx%23_LABELS_CUSTOMIZATION
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Once created, the patient will appear in the Patient List. 
 
The New/Search button can be used to search for a patient. The search can be filtered based on patient “Last 
name”, “First Name”, “Birth Date”, “ID1”, and “ID2” fields, as shown in the picture. Once the correct patient 
record is selected, the “Open” button is enabled to open that patient on patients list. Selected patient can be 
opened even double-clicking on the selected row. 
 

 

 

If no patient matching the search criteria is found, pressing the “New” button it is possible to open the patient 
creation dialog where fields are pre-populated with the information used in the search.  
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The Modify button opens a dialog that allows users to modify the content of the fields for a selected patient. 
Press “OK” to save the changes or press “Cancel” to discard them. 
 
Note. Patient demographic data, such as “Last name”, “First Name”, “Birth Date”, “ID1”, and “ID2, can be changed by 
authorized user only, i.e. user with the “Can Modify Patient Demographics” permission. Moreover, demographic 
information are locked and not modifiable in case of HL7 environment enabled. If request extra fields management is 
also enabled from Micromed Suite at central level, other fields are locked and non-modifiable (Address, City, Doctor, 
etc.) 

 
The Remove button allows users to remove the selected patient record and all the associated exams. When 
clicking this button, a popup will appear asking the user for confirmation before proceeding with the deletion. 
If the user confirms, a final fail-safe popup appears and asks if the user would like to cancel the removal. By 
clicking “No”, the patient record and all its exams will be deleted permanently. It is possible to remove multiple 
patients from Remove button, in case of multiple patients’ selection (Ctrl + click or Shift + click). 
 

Note. Only authorized user with the “Can Create/Delete Patient” permission can add a new patient to or remove an 
existing patient from Micromed database. 

 
Exams Group 

The Exams group offers two buttons to modify and remove an exam belonging to a selected patient, 
respectively; such buttons are enabled only when an exam has been selected. 
 
To modify an exam, first, select the desired patient from the Patient List. Once the patient is selected, the 
associated exams will be automatically displayed in expanded mode in the Exam List. When clicking on exam 
or on any of exam-related files, the “Modify” and “Remove” buttons will be enabled. 
 

 

 

Clicking the Modify button opens a dialog (shown above) that allows users to modify any editable field of the 
selected exam. The dialog also shows the patient-related data in read-only mode. Click “OK” to save the 
changes or click “Cancel” to discard them.  
By default, no exam related field is mandatory. For information about setting exam fields as mandatory, see 
the Labels Customization section of this manual. 
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At the bottom of the “Modify exam” dialog there is the Change Patient button which allows users to re-assign 
the exam to a different patient, for example if the acquisition was performed under the wrong patient; see 
the Reassign Patient section below for further details. 
 
To remove a WHOLE exam, select the exam to be removed from the list of exams and then click the Remove 
button. It is even possible to remove multiple exams, in case of multiple exams selection (Ctrl + click or Shift + 
click). 
Note. Exam removal will remove the WHOLE selected exam, including all files within it. To remove a single 
file, instead, see the section related to the basic operations available on Exam Files. 

 

Depending on whether exam or file is selected, the Exams List allows users to perform a series of operations 
by selecting the dedicated option in the right-click context menu; see the Basic Operations section below for 
a detailed description of all available functionalities. 
 
Anamnesis Group 

The Anamnesis group allows users to create a new anamnesis and manage models for anamneses. 
 
To create a new anamnesis, select a patient and click on the New Anamnesis button.  
A dialog will open allowing to choose a predefined model. Once the model is saved, the new anamnesis will 
appear in the list of exams for the selected patient. 
 
The Models button allows the creation of new models for anamneses; see the Anamnesis Models section for 
further details. 

 

Anamnesis models 

 
Tools Group 

The Tools group offers buttons to perform importing operation and to search on the Audit Log trail. 
 
Clicking the Exam Import button allows the user to import EEG exam with related videos or EMG-EP exam. 
It is also possible to import a video file for anamnesis purpose and associated it to a new anamnesis. 
 
Clicking the File Import button allow the user to import single secondary file related to the selected exam, 
such as event file or analysis file. 
Note. The import of Persyst analysis files is not supported. 
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See the Importing Studies and Files section below for further details about importing functionality. 
 

If the Audit trailing is enabled and network connection is available, it is possible to search on the Audit Log 
database by clicking the Log Search button. The Audit Log Search window will appear allowing to define 
searching criteria and to visualize search results; see the Audit Trailing and Log Search section below for 
further details about this functionality. 
 
Clicking the Persyst Clean button it is possible to manually clean up database associated to current local 
resource by grouping all Persyst files related to each EEG exam, if any, into one only main zip (PST) file; such 
operation improves the archive module performance in accessing and managing Persyst files. 

Important Note. After the clean up it will be NO more possible to review any Persyst analysis file with previous versions 

of Brain Quick software (1.xx.yy). 

 
HIS Group 

If HL7 Interface is active, the His group is available: it consists of one only button to access the Working List 
panel where all requests received from the Hospital Information System are collected; requests are split in 
new requests to import, and requests already imported to be executed. 

 

Working List 

Working List, as most of the Archive panels, is dockable; information displayed are customizable and it is 
possible to filter on the requests list. 

The Working List can be manually refresh and clicking the Import button on the toolbar it is possible to import 
a specific HIS request with related patient information within Patients database; for further details on HL7 
requests management see the HL7 Integration section of this manual. 

 
Users Group 

If the Logon system is active, the Users group is available on the Home Tab; it contains the Switch User and 
the Lockdown buttons. 

User Switching 
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Clicking Switch User button it is possible to switch to a different user by entering the appropriate user 
credentials.  

 

Switch User 

It is also possible to switch user clicking the “switch user” icon on the top right corner of FILE MANAGER title 
bar next to current logged in user username. 
When switching users, user capabilities are automatically upgraded according to user role, i.e., according to 
the collection of permissions assigned to the user. It is possible to switch user only towards one with higher 
privileges. For instance, it is not possible to switch user from an administrator role to a technician role. 
 
Note. Any on-going process will be completed in the background and the new user will be able to see all the 
on-going tasks launched by the previous user in the Background tasks panel. The Background tasks panel 
can be enabled by clicking the Show background tasks button on the Ribbon Bar (View Tab). 

 
Manual Lockdown 

Clicking the Lockdown button, it is possible to enter in lockdown mode, that is to manually force the FILE 
MANAGER application lockdown. 
 
When FILE MANAGER is locked down the main window is blurred, no PHI data is visible, and any button is 
disabled. Even all additional windows (Brain Quick, Neurowerk, etc.) will appear blurred and all functionalities 
will be locked. Logon dialog window automatically appears over the application window to allow user to unlock 
the system by entering valid credentials when a user interaction with the application main window is detected. 
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Lockdown mode 

 
Automatic Lockdown 

Lockdown mode can also be enabled in an automatic way; FILE MANAGER offers a dedicated option stored at 
machine level allowing to activate the automatic lockdown of the application after a certain period of inactivity 
of the Archive module; for details about the automatic lockdown activation see the Lockdown Preferences 
section of this manual. 
 
EEG Sessions in Lockdown Mode 

The lockdown mode automatically propagates to any on-going EEG recording and/or review session. 

When an EEG review session is locked down, in the Brain Quick review window any PHI data is anonymized, 
all panels showing PHI data are blurred and no action is possible: ribbon bar buttons are disabled, and no event 
insertion is possible. 

 

EEG Review session – Lockdown mode 
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Instead, when an EEG recording session is on-going and the system enters in lockdown mode, the EEG trace 
and video, if any, continue to be visible on the screen allowing the live monitoring, also patient name remains 
visible but no operation can be performed by the user without logging in again.   
 

 

EEG Recording session – Lockdown mode 

Again, the LogOn dialog window automatically appears over the Brain Quick window to allow user to unlock 
the system when any interaction with the application main window is detected. 
 

Auto Archive Group 

The Auto Archive group offers a button to manually run the automatic archiving procedure. 
 
Note. The auto-archive feature is available only if the FMS AUTOARCH license is active. 
 
Clicking the Auto Archive button it is possible to manually run the auto archive for exams marked as “read” of 
current local resource; such procedure scans patients marked as “read” and archive related exams in the 
defined storage resource. It is possible to archive reports in a dedicated storage resource, i.e. in a different 
path respect to the exam data. 
Note. Persyst and analysis files (.fft), if any, are considered by the auto archive procedure ONLY if the related 
option is enabled, otherwise they are discarded and permanently deleted. 
 
The auto archive procedure allows to automatically delete exams marked as “to delete”, if any; such exams 
are discarded from the archiving and are permanently deleted. 
If the auto archive is successful, the archived files are moved to the designated storage resource; the 
destination storage resource name is shown the “Storage” column of the Exams list at file level. 
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Archived files – Storage 

Finally, the auto archive can be combined with the EEG/VEEG exams cut: if such option is enabled, EEG and 
Video EEG exam marked as “read” are automatically cut according to the chosen reduction protocol and then 
archived, i.e. moved to the designated storage resource. It is even possible to automatically delete the original 
trace file, keeping only the reduced exam. The automatic cut is highly recommended in order to avoid saving 
unnecessary files. 
 
An additional auto archive setting is Patients list cleaning from archived patients, allowing the archived 
patients to be no longer visible on source resource after the procedure. 
 

View Tab 
The View Tab groups the main functionalities related to the window layout management; buttons are 
organized in functional Groups. 
 
It contains the following Groups: 

• Layout 

• Layout editing 

• Filtering 

• Info panels 

• Resources 

 

 

  
Layout Group 

The Layout group collects all layout options. Available patient-based layouts are: Standard, Standard Split and 
LTM; they show the exams grouped by patients. 
Note. The Standard layout is the default one. 

 
To turn on one of these layouts on, click on the Standard, Standard Split or LTM button. The View pane will 
be divided in two components: Patient List, on the left, and Exam List with all studies related to the selected 
patient, on the right.  
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A further layout available is the Workflow overview layout which is exam-based and groups all studies 
according to the associated workflow status; user can activate it by clicking on the Workflow overview button: 
it splits the View pane in four columns, one for each workflow step and it is useful to move studies forward 
and backward supporting the user in the workflow management. 
 
See the View Pane and Layouts section above for further details about available layouts. 
 
Layout Editing Group 

This group contains only one button, which can be used only when a patient-based layout is selected. The 
Space Equally button automatically adjusts the Patient List and Exam List so that they have the same width. 
 
Filtering Group 

The Filtering group contains the Filter button which allows to enable or disable the Filtering pane which is 
dockable. 
 
The Filtering pane allows the user to set multiple searching criteria to filter current view; it also allows to apply 
a custom filter or to define a new one and save it; see the Filtering View paragraph for further details about 
how filtering patients and studies. 
 
This group contains also the Clear all button which allows the user to quickly reset current view clearing all 
applied filtering criteria at a time. 

Info Panels Group 

This group contains the buttons enabling or disabling information panels; such panels are dockable. 
 
Clicking the Show patient info button will open a pane that shows any information related to the selected 
patient, as seen in the figure below. The patient information is in read-only mode and therefore no changes 
can be made directly from the Patient Info pane.  

   

 Info Panels 
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The Show acquisition list button opens a pane that shows the status of all the acquisition systems connected.  
Each acquisition system is represented by a “card” with a status bar reporting system name and related status 
and a reduced details panel. 

To be visible in the Acquisition List, an acquisition system has to first be configured in the dedicated pane of 
the “Options” window, as described later in this manual. The acquisition machines to be managed from 
acquisition list must be defined as resources in File Manager, to allow remote reviewing tools. 

For details about Acquisition List configuration see the Acquisition List Tab paragraph below. 
 
Clicking on the caret icon close to the acquisition system name will reveal the name and ID of the patient under 
acquisition, as well as the location (resource name) of the exam, as seen in the side figure.  
 
Note. Fields shown as part of the information displayed for the acquisition systems are user configurable and can set 
in the “Options” window (Acquisition List tab). 

The Acquisition List panel also shows the (color coded) state of each acquisition system: 

• Online (grey), if FILE MANAGER is connected with the acquisition system 

• Idle (grey), if Brain Quick Software (or SystemPlus EVOLUTION) is open on the acquisition system but 
it is not acquiring data 

• Acquiring (yellow), if the acquisition system is actively receiving data from the amplifier 

• Recording EEG (green), if the acquisition system is recording EEG, i.e. saving data 

• VEEG Recording (green), if the acquisition system is recording VEEG (EEG + video) 

• Paused (red), if the acquisition system is paused 

• Impedance Check (purple), if the acquisition system is checking the impedance values  
 
Right-clicking on the Acquisition List panel a contextual menu with the following options will appear: 

• Ascending, to sort the systems in alphabetical order 

• Decreasing, to sort the systems in reverse alphabetical order 

• View as, to see the acquisition systems by system or by patient 

• Filter by, to see only the systems that meet the selected criteria (state) 

• Refresh, to refresh the panel 
 
Right-clicking on each system status bar a contextual menu with the following options will appear:  

• Remote Control, which allows the user to remotely control the acquisition system (via UltraVNC or 
Brain Quick software) and live monitor eventual on-going EEG recording 
Note. Remote control is based on UltraVNC for acquisition systems running SystemPLUS Evolution, otherwise 
it calls Brain Quick software for acquisition stations where Brain Quick software is installed 

• Remote Review, which opens Brain Quick software for the remote review of the on-going EEG 
recording on the selected acquisition machine 

• See in Database, which allows to point directly to the patient and the exam under recording 
 
The Show background tasks button opens the Background Tasks pane, which displays all the on-going 
background processes as “cards”.  
The information shown by each card depends on the process type, but all cards report at least the task name 
and the progress status. It is possible to display further details by “expanding” the card clicking the caret icon 
on the top right corner of the card. Finally, it is possible to cancel the process at any time clicking the Trash 
icon. 
The processes that are displayed in the Background Tasks Pane are the following: 

• Data transfer performed with the ‘copy to’ and ‘move to’ operations. The information displayed in these 
types of cards is: 

file:///C:/Users/ca_andr/Downloads/wetransfer_brain-quick-software-user-manual-docx_2023-07-12_1551/BQS-UM-001%20BRAIN%20QUICK%20Software%20User%20Manual%20-%20GA.docx%23_Acquisition_List_Tab
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- The source and the target resources 
- The name of the patient currently being transferred 
- The visit, exam and file currently being transferred 
- How much data has been processed so far 

• Video EEG reduction tasks. In addition to the task name and the progress status, this type of card displays 
also: 
- The patient name 
- The file under reduction and the date and time of the related exam 
- The user who has launched the reduction task 
- The machine where the reduction task has been launched 

• Auto archiving tasks. The card shows the progress status, the patient and the exam ID in which the 
procedure is running. 

• Persyst cleaning tasks. Even in this case, the card shows the progress status, the patient and the exam ID 
in which the procedure is running. 

 
 

The progress bar is labelled differently according to the reduction task status: 
o Queued: the reduction task is in queue and waiting for to be processed 
o Running: the reduction task has already started but has not been completed yet 
o Cancelling: the reduction task is being cancelled 
o Cancelled: the reduction task was aborted and has been completely removed from the queue 
o Completed: the reduction task has been completed. The card will disappear from the Background 

Tasks panel. 
o Failed: the reduction task failed or was rejected by Reduction service due to some error; a tooltip 

report a brief description of the occurred error. Failed tasks have to be cancelled manually. 
 
Reduction tasks only can be promoted by clicking the Promote icon available for each card next to the Trash 
one; promoting a task means assign to it high priority in the processing, tasks with the same priorities are 
executed according to the insertion order. 

 

View Customization 

FILE MANAGER allows the user to define size and position of all its information panels; each panel can be 
moved by clicking on its title bar and then dragging it to the desired position. 

In order to modify height and width of a panel, point the mouse cursor on the panel's edge and, when the 
cursor turns into a two-sided arrow, click and drag the panel's edge until the desired dimension is reached. 

 
All File Manager panels, except for the Patients List and the Exams List, are dockable. A dockable panel is a 
layout panel that provides an easy docking in preset positions.  
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When dragging one of the panels File Manager displays all the preset positions in which the panel can be 
docked. Just release the panel over a docking position and the panel will be docked in that location.  Panels 
can be docked on the left, right, top, bottom, or center of the window. If docked, they can be moved and 
pinned to the top, bottom, left, or right of the application window. 

 

View Customization 

 
Resources Group 

This group contains the Show/Hide button which allows the user to decide which resources to hide or show 
among the defined ones; enabled resources are visible in the Resource List.  

 
The Show/Hide resource window that opens when clicking this button is shown in the picture below. 

 

 

Show/Hide Resources 

Users can show (hide) a resource by toggling the “eye” icon next to each resource in the list of the available 
ones. 

Hiding a resource makes it invisible in the Resource List and it will not be possible to transfer any type of data 
from and to the hidden resource. Conversely, showing a hidden resource makes it visible and enables data 
transfer from and to it again. 
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From Show/Hide Resources, it is possible to reorganize resources list, by dragging-and-dropping a resource to 
the selected position. 

The Resource group contains also the Show resource list button which allows to show/hide the Resource list 
panel as it is possible for all other information panels. 

 

Setup Tab 
The Setup Tab contains all the functionalities that are related to resources, doctors, and technicians. 

It is divided in two Groups:  

• Resources  

• Doctor Technician 

• Tools 

 

 
 

Resources Group 

The Resources group allows users to create, modify, or delete a resource from the FILE MANAGER.  

Micromed resource allows users to access patient information and exam data, and to perform operation on 
recorded studies. 
Note. Resource setup is an advanced feature which can be performed by authorized personnel only, i.e. user with the 
“Can Create/Modify/Delete Resource” permission. Depending on the environment where workstations have to be 
installed, many variants are possible; it is highly recommended resource setup is performed with the support of 
Micromed technicians at installation time according to system configuration. 

 
Clicking on the New button will open a dialog for the creation of a new resource; see the Data Access: 
Resources Configuration paragraph below for more details. 
Note.  A password is needed to define a new resource.  

 
Clicking the Modify button allows users to modify the current resource. This will open a dialog, similar to the 
dialog for the creation of a new resource, where it is possible to modify any field of the current resource. 
 
Clicking on the Delete button will trigger an alert message asking to confirm the resource deletion; clicking 
“OK” will delete the selected resource. Deleting a resource DOES NOT delete the patients and their exams and 
DOES NOT delete the database associated with the resource, but it simply removes the resource from the list 
of resources. 
Note. A password is needed to delete a resource.  
 

The Resources group allows also to import and export resources. 

It is possible to import one or more resources by clicking the Import button and selecting the configuration 
file (systemResources.xml) storing the definition of the resources to import. This will open the “Import” dialog 
window where all detected resources are listed. 
 
For each resource the following information are displayed: 
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- resource name (same displayed in the Resource List) 
- resource path 
- name of the patient database associated to the resource 
- resource type (Local, Database, Storage etc.) 

 
In addition, on the right side it is shown whether the resource is duplicated, i.e. if it already exists a resource 
with the same name, whether its path is not UNC (*), and whether it is reachable.  
 

 

Import Resources 

(*) UNC paths are used to access network resources; they have a conventional format starting with the host name 
(machine name) or the server name preceded by “\\” and  followed by a shared directory name. 

 
As default all new resources with a UNC path are selected for the import and it is possible to change the 
selection; clicking the “Ok” button selected resources are added to the list of system resources but they are 
not enabled, in order to make them visible the user have to click the Show/Hide button (View tab) and enable 
the ones of interest. Importing a duplicated resource, changes will be ignored. 
 
Finally, it is also possible export one or more resources by clicking the Export button; this will open the 
“Export” dialog window where all system resources are listed, and the user can select the ones to export. 
 
For each resource the following information are displayed: 

- resource name (same displayed in the Resource List) 
- resource path 
- name of the patient database associated to the resource 
- resource type (Local, Database, Storage etc.) 
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Export Resources 

In addition, on the right side it is shown whether the resource path is not UNC (see note above).  
As default all resources with a UNC path are selected for the export and it is possible to change the selection; 
clicking the “Ok” button resources are saved in a configuration file (.xml) which can be shared with other 
stations of the system and imported. 
 
The Import/Export options are also available in right-click contextual menu of the Resource List. 
 

Doctor Technician Group 

From the Doctor Technician group it is possible to add new doctors/technicians to the database.  
 
Clicking on the New doctor (New technician) button will open a dialog where doctor (technician) information 
can be entered. 
 

 

 
Once the required fields are filled in, the doctor (or technician) will be saved to the database and it will be 
available in the list of doctors (or technicians). 
 

Tools Group 

From Tools Group it is possible to Modify or Delete database data for already existing fields, related for 
instance to City, Doctor, Department, etc. 
Note: only if the permission Can Add/Modify/Delete DB Values of Lookup Lists is enabled for the logged-in account 
the button will be active 
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Clicking on the Delete/Modify DB Data button will open a dialog where the user can catalogue doctor and 
technicians as valid or obsolete and to select database fields to be updated or deleted. When a new doctor or 
technician is created, by default it is marked as Valid, and hence available from dropdown menu to be assigned 
to a record. From the interface, for each doctor/technician available, the user can uncheck Valid/Not obsolete 
field. If a doctor or a technician is obsolete, the choice will not appear when the user selects from the available 
doctors or technicians list. When a technician or a doctor becomes obsolete, all patients, exams, or files 
associated with that entity on database will remain unchanged and will not alter after rendering a doctor or 
technician obsolete. 
Clicking on Update obsolescence button, all changes will be saved. 
 

 
 

As shown in the following image, it is possible to select data from the available Database fields (City in the 
example), select an Actual value, type the Desired value, and click on update to change it with the desired 
one.  
 

 
 
The user can then decide whether to overwrite the Actual value or to keep it in the database.  
 

 
 

• Clicking on Yes, the Desired value will be added to the database keeping even the actual value (N.B. if 
the field is doctor or technician, actual value will be marked as Not valid) 
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• If the user selects No, another confirmation popup will appear and, if confirmed, desired value will 
replace the actual value in the list 

• If the desired value is empty, the actual value will be deleted from the database. 
 

All records in the selected database will be updated consequently. If the user decides to overwrite values, all 
entities on database associated to the actual value will be updated with the desired value. The field will be 
deleted for existing entities in case the desired value is empty.  
 

Help Tab 
The Help Tab contains all the functionalities that offer help to the user, as shown in the figure. 
 

 

 

The Help button allows users to open the user manual for the FILE MANAGER. 
The Contact Support button will open a window with the customer support number and email address.  
The Company Homepage button opens the www.micromedgroup.com webpage in a browser and the About 
button opens a window with information about the manufacturer, the name of the product, the software 
version, and the copyright (shown below).  
 

 

 

Brain Quick Tab 
 
Brain Quick Tab will be available if the Brain Quick and Brain Quick Acquisition applications are installed and 
the system has licenses for acquisition and review. 
 
The Brain Quick Tab groups all functionalities that allow the user to start a new EEG or Video EEG recording, 
create a new acquisition protocol or define an EEG report model. 
 

http://www.micromedgroup.com/
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Clicking the New EEG button will open the Brain Quick Software acquisition window which allows to start a 
new EEG or Video EEG recording with the last used acquisition protocol. The name of the last used acquisition 
protocol will be available under New EEG button during the File Manager session. 
 
It is also possible to start a new recording by selecting the desired protocol; clicking the Select Protocol button 
will open a dedicated window of the Brain Quick Software where all defined acquisition protocols are listed, 
and it is possible to start a new recording with the selected protocol or create a new protocol. 
 
Finally, it is possible to start a new recording with the default acquisition protocol by clicking the New EEG 
(Default Protocol) button; the Brain Quick Software acquisition window will appear allowing to start a new 
recording.  
 

 

New EEG Acquisition 

Selecting an exam and clicking on New Report button, will allow the user to choose from the existing available 
templates and to create and save a new report under the selected exam. 
 
It is also possible to define a new EEG report model; clicking the Report Models button the “Models 
management” window will open allowing to define a new report template and save it. 
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 EEG Report Models 

Note. EEG Report creation and related models management are handled by Brain Quick Software; if Brain Quick 
Software is not installed, it will not be possible to create any EEG reports or EEG report models. 

 

The Brain Quick tab collects also other useful tools allowing ambulatory data download, EDF file import and 
firmware update. 

Clicking the Data Download button, it is possible to download ambulatory EEG data directly from amplifier 
(connected via cable) or from memory card by a card reader; see the Ambulatory Data Download section of 
this manual for details. 

Clicking the Firmware updater button, it is possible to check the actual firmware version of a specific amplifier 
and upgrade/downgrade the firmware. 

Finally, the Import EDF button allows to import an EEG exam in EDF or EDF+ format by calling Brain Quick 
software conversion tool from EDF/EDF+ file into Micromed EEG file format; the imported trace will appear as 
a new EEG exam in the Exams list associated to currently selected patient in the Patients list. 

Neurowerk Tab 
 

The Neurowerk Tab groups all the main commands that allow the user to start a new EMG recording, define 
a new acquisition protocol, manage settings for electromyography, or define an EMG report template. 

 

Neurowerk Tab in File Manager 

• New Session button starts a new sequence of EMG examinations allowing the user to select or create 
a new acquisition protocol and start the recording of a new session. 

• Continue with Session button allows to select an existing EMG session and to record new exams, 
appending them directly in the selected session.  

• New Report button allows the user to choose from an existing report template, to create and save a 
report for the selected session. 

• Report Models button, allows the user to select and edit an existing template, or to create a new one 
from an empty form. 

• Finally, there are three buttons for session appearance and general settings (Settings, General 
Settings, Default Settings), and one for editing the protocols already defined from the user (Edit 
Protocol). 

 

SleepRT Tab 
 

SleepRT Tab groups the functionalities available from the integration with SleepRT software. 
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SleepRT Tab in File Manager 

 

If SleepRT is installed in the machine and the .exe path has been correctly configured from settings, SleepRT 
tab is available to process and open analysis executed with the external software. 

Analyze button allows to start a new analysis for the selected EEG exam. The exam is directly opened from 
SleepRT software, and the user can define a new protocol to be used for the analysis of the desired exam. 
Analysis can be either launched from contextual menu at exam level.  

 

 

Analyze with SleepRT from contextual menu 

 

Once an analysis is launched and saved, a new file of type OSG and dedicated icon is added under the analysed 
exam. 

Open button allows to open an existing analysis belonging to the selected EEG exam, that will be the first one 
in case of multiple analysis. 

Config Console button opens SleepRT specific configuration console, useful for changing and defining new 
settings on the external application. 

File Manager can manage and save reports created during analysis with SleepRT software to be opened and 
modified from its editor. 

Note: only the first version of the report will be saved and visible in File Manager, additional modification 
after the analysis or newly created reports will not be updated and saved in File Manager 

From File Manager settings, specifying the analysis destination folder, it is possible to open and review an 
analysis executed with SystemPLUS Evolution. 

 

Neurowerk EEG Tab 
 

Neurowerk EEG Tab groups the functionalities available from the integration with Sigma Neurowerk EEG 
software. 
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Neurowerk EEG Tab 

If Neurowerk is installed and configured in the machine, Neurowerk EEG tab is available to start new 
acquisitions using the external software and to create new reports. 

New EEG button allows to start Neurowerk EEG software to start a new EEG acquisition. 

Standard Video EEG button starts Neurowerk EEG to run a standard video EEG acquisition. 

Standard EEG reduced button allows to run a standard EEG reduced. 

User 1, User 2, User 3 buttons refer to acquisition protocols configured by the logged user to start a default 
protocol. 

When a new acquisition is started, a new exam will be created in the archive with a dedicated Neurowerk EEG 
icon. 

New Report button allows the user to select from the available report templates and to create a new one for 
the selected exam. 

Montage Setup button starts Neurowerk EEG and directly opens Montage Setup window to allow the user 
changing the acquisition montage 

Report Models button opens the existing report templates, with the possibility for the user to create a new 
one or to modify the defaults 

EEG exams recorded with Neurowerk EEG can be opened directly from double clicking on them. 

 

 

Neurowerk EMG Tab 
 

Neurowerk EEG Tab groups the functionalities available from the integration with Sigma Neurowerk EEG 
software. 

 

 

 

If Neurowerk is installed and configured in the machine, Neurowerk EMG tab is available to start new 
acquisitions using the external software. 

New EMG button allows to start Neurowerk EMG software to start a new EMG acquisition. 
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When a new acquisition is started, a new exam will be created in the archive with a dedicated Neurowerk EMG 
icon. 

EMG exams recorded with Neurowerk EMG can be opened directly from double clicking on them. 

Ribbon Bar Customization 
FILE MANAGER allows the user to customize all Ribbon Bar tabs and groups and define which functions shall 
be present in the different tabs and groups.  
 
To access ribbon bar customization tool right-click anywhere on it and select the “Customize Ribbon” option 
in the contextual menu.  
The “Ribbon Customization” dialog window is split into two panels: on the left, all the available commands, 
i.e. features (buttons) available, grouped according to the default configuration; on the right, currently applied 
ribbon bar configuration. 
 
It is possible to create a new custom tab by selecting New Page from the “New” menu at the bottom of the 
right panel; to populate the tab with a new functional group the user has to select New Group from the “New” 
menu and enter the new group name. 
After that, it is possible to add to each group all buttons corresponding to the desired functionalities: the user 
has to simply search for a specific function in the commands list available in the left panel, then click on the 
right-arrow button placed between the two panels to move the selected command under the selected group 
on the right panel, and so on.  
Click the “Ok” button to save and apply the customized configuration. 

In the right panel, customized tabs and groups are recognizable since marked by the “(Custom)” label next to 
the tab or group name (as shown in figure below). 

 

Ribbon Bar Customization 
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Each tab and group name can be changed by clicking the Rename button (at the bottom of the right panel) 
and the order of tabs, groups within the same tab or commands within the same group, can be changed by 
simply selecting the item to move and using the up-arrow and down-arrow buttons available in the middle of 
the customization window.  

It also possible to hide useless tabs, groups or buttons by unchecking related item in the right panel or moving 
a specific command back to the left panel by clicking the left-arrow button. 

Ribbon customizations can be exported or imported from file clicking the Import/Export menu and choosing 
the desired option. 

It is also possible to reset the entire ribbon bar to the default configuration or restoring only a specific tab 
(page) by selecting one of the available options from the Reset menu in the bottom left corner. 

 

APPLICATION BUTTON 

FILE MANAGER main window contains an Application button at the top left corner.  
 
 

 
 

 

 
 
 
Clicking on the application button opens a menu allowing to access: 

• Settings area  

• Settings Centralization area (*) 
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(*) Administrator user only can access this area, only if the working configuration is Distributed 
 
Clicking Settings in the left side menu it is possible to access the “Settings” window where the user can 
configure FILE MANAGER options; see the Settings chapter of this manual for all details about setting types 
and how to change settings. 
 

 

Settings window 

Selecting the other options available in the left side menu it is possible to perform advanced operations. 
 
Clicking on Settings Centralization, the user can access a dedicated area where he can centralize local settings 
defined at machine level, to be available on all the machines of the distributed system; see the Settings 
Centralization section of this manual for further details. 
Note. Only authorized user, i.e. user with the “Can Modify Central Settings” permission, can access Settings 
Centralization area. 

 

TITLE BAR 

When user authentication is enabled, Title bar at the top of the main window shows the username of the user 
currently logged in. 
On the top right corner, it also contains two controls (icon), the Switch User and the Lockdown, as seen in 
figure below. 
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Clicking on these buttons it is possible to quickly switch to another user and lockdown FILE MANAGER 
application, respectively. 
See dedicated sections of this manual for further details about both functionalities. 
 
 
 
 
 

QUICK ACCESS TOOLBAR 

The Quick Access Toolbar is a small customizable toolbar which collects commands most frequently used. It is 
possible to add any control placed in the ribbon bar by selecting the “Add to Quick Access Toolbar” option in 
the right-click contextual menu available for each button. 
 

 

Quick Access Toolbar 

The Quick Access Toolbar default position is above the ribbon bar next to the application button placed in the 
top left corner of the main window. By right clicking any ribbon button it is also possible to move the Quick 
Access Toolbar below the ribbon bar (“Show Quick Access Toolbar Below the Ribbon” option) and to minimize 
the Ribbon.  
 

STATUS BAR 

At the bottom of the main window there is a Status bar which provides useful information.  

On the left, it shows whether the database is online or not and the operating mode (distributed or stand-
alone); only in case of distributed system configuration, the server connection status is displayed. 
In addition, the name of current resource is shown with indication about the file system availability. 
 

 

Status Bar 

 

DATA ACCESS: RESOURCES CONFIGURATION 

A typical networked installation is composed by: 

• some Acquisition stations, 

• several Review stations to be used by the consultants to read and analyse the recorded data, 

• a Server containing the SQL Central Database 

• a Storage containing the Working Area, the Virtual Disks and the Multistorage  
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Depending on the installation environment many variants are possible; sometimes acquisition, review and/or 
server operations can be performed on the same unit.  

Micromed resource is the key component to access patient and exam data; it consists of two parts: 

• a link to the SQL database where patient information are stored 

• a path, i.e. a local or shared network folder, where studies are stored 
 

Into every workstation, a series of resources is defined, every folder having different purposes and having the 
need to be accessed from the other units.  

A resource can be define from the Setup Tab of the ribbon bar by clicking the New resource button; the “New 
resource” dialog will open allowing to enter resource details. 
 

 

“New resource” dialog window 

 
The fields required to define a new resource are: 

• the “Root path”, which defines where the study files are physically stored 

• SQL database details, i.e.  “Server name” and “Database” the resource points to  

 

Note. No resource creation is possible without the above information; mandatory fields are highlighted by a red 
cross if not filled in and the OK button is disabled. 

 
Every resource has a specific name configured by the technician during the installation; this information can 
change across users.  

 
A “Resource type” needs to be specified for every resource. The following types are available: 

• Local: a “powerful” resource in which the user has full control, i.e. he can create, modify, remove 
patients and exams, and mark exams as “read” or “to delete”. This resource points to a local or a 
network repository and it is always linked to a SQL database. 

• Local Lite: a Local resource but portable, i.e. linked to a SQLite database; user can create, modify, 
delete patients and exams, but not mark exams as “read” or “to delete”. 

• Auxiliary: a portable, temporary archive resource, typically used for data exchange. This resource is 
always linked to a SQLite database. 

• Remote: a resource on which the user has only a partial control, i.e. he can only remove patients and 
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exams, and mark exams as “read” or “to delete”. It points to a local or network repository ant it is 
always linked to a SQL database. It is possible to set this resource as read-only to limit operations the 
user can perform on data. 

• Database: a resource typically used to read database information with limited access: “new” and 
“modify” functions are not allowed. Users can only delete patients and exams, and mark exams as 
“read” or “to delete”. This resource must be linked only to SQL databases. 

• Storage: it represents a virtual disk partition or an optical media (DVD or BluRay disk) where data and 
reports are stored for archiving purpose. This resource must be linked only to SQL database and it can 
be set as read-only. 

Note. This resource cannot be selected by the user to obtain a patients list since this function is managed 
directly by the Database. 

• MultiStorage: it represents a collection of archive resources. This resource must be linked only to SQL 
database and it is read-only to guarantee archived data protection. 

Note. This resource cannot be selected by the user to obtain a patient lists since this function is managed 
directly by the Database. 

• Moberg Live Data: this resource is used to access Moberg CNS data during the acquisition for the live 
monitoring; it is generally linked to a network repository used by the Integrator to handle Moberg CNS 
data.  

Note. Local type resources must be used to review Moberg CNS data after the acquisition. 

 

IMPORTANT NOTE. Operations the user can perform on data depends on user’s permission; that is the 
resource gives access to data with some limitation according to the resource type but features allowed and 
not allowed are determined by user’s rights. 

Once all required fields are populated, it is possible to test the connection to the database by clicking the “Test 
connection” button: this allows users to test whether the configuration fields have been filled correctly. The 
“Select database” button allows users to select one of the previously used databases. 

 
Clicking the OK button resource is created and it automatically appears in the Resources List. Patients List 
automatically shows all patients with at least a study stored on current resource. 
 

ROUTINE ACQUISITION STATION 

Here is an example of the resources typically defined in a routine acquisition station: 

• Acquisition: Local type, pointing to a local folder of the recording PC, linked to the Central SQL 
Database. Data will be recorded here. 

• Working Area: Local type, pointing to a folder shared on the network, linked to the Central SQL 
Database. Data will be moved here at the end of the recording. 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 62 of 267 

 

        

          Acquisition Resource                                                           Working Area Resource 

 

 

 

REVIEW STATION 

Here is an example of the resources typically defined in a review station, which, in general, is intended to 
review data and create reports: 

• Acquisition: Local type, pointing to a folder shared on the network by the recording PC, linked to the 
Central SQL Database. Data will be recorded here. 
 

• Acquisition LTM: Local type, pointing to a folder shared on the network by the recording PC, linked to 
the SQL Database of the recording unit. Data will be recorded here and no network is necessary to 
run. 
 

• Working Area: Local type, pointing to a folder shared on the network, linked to the Central SQL 
Database. Data will be moved here at the end of the recording. 
 

• Multistorage: Multi-storage type, pointing to a local folder of the Server or shared on the network, 
linked to the Central SQL Database. Data will be archived here. 
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Acquisition Resource                                       Acquisition LTM Resource 

 

 

Working Area Resource                       Multistorage Resource 

 

 

FILTERING VIEW 

The number of patients stored inside Micromed database can be significant resulting in a huge amount of 
studies to manage. In order to easily find a specific patient or study, or to perform operation on a group of 
studies it is possible to filter current view.  

FILE MANAGER offers a Filter tool which allows to filter patients and studies displayed according to a collection 
of searching criteria. 

Note. It is possible to set up to six different criteria which can be applied at a time. 
 
Clicking the Filter button on the ribbon bar (View Tab) the Filtering panel will open allowing the user to set 
filtering criteria. 

 

Filtering Panel 

Filtering panel consists of three main parts: 

- the upper section, where it is possible to select a custom filter among the saved ones or create a new 
filter by saving a collection of searching criteria 

- the Patient filters pane, where it is possible to choose patient related fields as filtering criteria 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 64 of 267 

- the Exam filters pane, where it is possible to select information related to exam as filtering criteria 
- the File filters pane, where it is possible to select information related to statistic items at file level as 

filtering criteria 
 

FILTERING ON PATIENTS 

The Patient filters pane allows user to choose filtering criteria among all available patient related fields. 
Most of filters available are editable text fields, such as patient first name and last name, patient ID number 
or patient’s notes.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 
 

Filtering on Patients 
 

It is possible to easily filter on patients on the base of their “Birthdate” or focusing on the most recent study 
filtering on the “Last Exam Date” field; for the both fields it is possible to easily set a specific time interval 
making use of the calendar or choosing among standard date ranges, as shown in the previous pictures.  
 
For some fields Filter tool allows to choose among a pre-compiled list of values: 

• The Gender filter contains a check box for each of the three available options (Male, Female, 
Unspecified). 

• The Doctor filter contains a scrollable list of all doctors saved in the database of the current 
resource. 

• The Hospital Department filter contains a scrollable list of all hospital departments saved in the 
database of the current resource. 
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Filtering on Patients – Hospital department 

• The Marker filter contains a scrollable list of all markers saved in the database of the current 
resource. 
 

Finally, there is a Patient advanced filters section where it is possible to filter for further details, such as 
insurance details, physical data etc. 
 

FILTERING ON STUDIES 

The Exam filters pane allows user to choose filtering criteria among all available information related to studies 
and related files. 
 
Filters available on exam allow for example to display: 

• Only specific type of studies, such as EEG or EMG 

• All EEG studies recorded last week or in a specific date range 

• All EEG studies to be reviewed by a specific doctor 
 

It is possible to easily filter on studies on the base of their type or focus on examinations performed in a specific 
date range filtering on the “Recording Date” field; for the latter field it is possible to easily set a specific time 
interval making use of the calendar or choosing a standard date range, as shown in the picture below.  
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Filtering on Studies – Recording Date 

For field such as exam Code and Comment it is possible to search by typing free text, like keywords, in an 
editable textbox. 
 
As for patients, for some exam related fields Filter tool allows to choose among a pre-compiled list of values: 

• The Doctor, Technician and Requesting Doctor filters contain the list of all doctors and technicians 
saved in the database. 

• The Hospital Department field contains a scrollable list of all hospital departments saved in the 
database of the current resource. 

• The Marker filter contains the list of all available markers. 

Finally, the Flags filter groups all the flags which can be assigned to a study in a box containing a check box for 
each “Quick Search” flag and one for the “Corrupted Video” flag.  

Note. “Quick Search” flags description can be customized to mark a study as desired; see the Labels Customization 
section of this manual for further details. 

 
Filtering criteria on studies can be combined with filtering criteria related to patient, for example to visualize 
all EEG studies related to patients belonging to a specific hospital department or assigned to a specific doctor. 
 

FILTERING ON FILES 

The File filters pane allows user to choose filtering criteria among all available statistic fields present in 
database statistic tree and comment at file level. 
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Filters available on a file allow for example to display: 

• Only a set of files with a specific comment 

• All files related to a single or multiple statistic classes 
 
This filtering tool is powerful if a statistic tree is defined in the selected database, and allows to display 
multiple files with the same classification. 
 

 
 
 

ACTIVE FILTERS 

It is possible to enable more than one filter at a time, i.e. to apply a collection of filtering criteria. All applied 
filters are shown in a dedicated panel which appears on top of the View pane above the patients and exams 
list when there is some filter active (see figure below). 
 

 

Applied Filter Summary 
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From the “Applied filters” panel it is possible to clear active filters one by one, i.e. to reset only the selected 
filter, by clicking the “X” button. Alternatively, the user can reset ALL the filters by clicking the Clear all button 
on the ribbon bar (or in the Quick Access toolbar, if added), as highlighted in the image below. 
 

 

Clear All Filters 

Note. Active filter applies to all views, that is if the user changes current layout, patients and studies displayed are only 
those satisfying the applied filtering criteria. 

 
 

SAVING FILTERS 

Filter tool allows to create custom filters, assign a friendly name and save them for quick access. 
 
In the upper part of the Filtering panel there is a dropdown list with all available saved filters, as shown in the 
figure below. The user can select one of the pre-defined filter to quickly load and apply it searching for patients 
and/or studies of interest according to the customized criteria. 
 

 

Saved Filters 

Next to the filters list there are a “Save” and a “Delete” button which allow to save a collection of filtering 
criteria as custom filter and to remove a saved filter, respectively. 
 
To save a filter: 

1. Fill in one or more search criteria in the Filtering pane and apply the filter. 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 69 of 267 

2. Click on the “Save” filter button. 

3. Enter the name of the filter to be saved and press the “Save” button. 

 

From now on, the saved filter will be available among custom filters and the user can apply it by selecting it 
from the dropdown list on the top right corner of the Filtering pane.  

To remove a custom filter, first apply the filter to be removed, then click on the “Delete” filter button to the 
left side of the custom filters list.  

 

PATIENT QUICK SEARCH 

In the Archive module it is also possible to quickly search for a specific patient or group of patients thanks to 
the Patient quick search box available on top of the View panel above the Patients List itself. 
 
Entering patient name, last name or identification the patients list will be filtered in real time showing only 
patients who match current searching criterium; more criteria can be combined using “;” as separator. 
The order for patient search is First Name ; Last Name ; ID1. 
 

 

Patient Quick Search 

To reset patient list visualization and show all the patients click the “x” button on the right corner of the quick 
search box. 
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BASIC OPERATIONS 

BASIC OPERATIONS ON PATIENTS 

All basic operations the user can perform on patient are quickly accessible from the Patients List. 

Right-clicking on a patient record will present a contextual menu showing all the actions available: 

• Move to: this action allows moving the selected patient from one resource to another that is linked 
to the same database. The patient will be no longer available in the source resource, as it has been 
moved to the target resource. 

• Copy to: this action allows copying the selected patient from a resource linked to a database to a 
resource linked to a different database. After the copy, the patient in the source resource will be still 
present, and any changes made on it will not affect the patient copied in the target resource. 

 

 

Patient – Basic Operations 

• Modify: this action allows editing patient information by accessing the “Modify patient” window.  

• Remove: this action allows removing the selected patient from the Patients List and delete all of its 
related exams.  

Note. Patient removal requires confirmation by the user. If the user confirms patient removal but at 
least one exam related to the selected patient has not been archived yet, a further popup appears 
warning about the possibility to lose unsaved data and suggesting to cancel the operation. The user 
can decide if continue or not. If patient removal is confirmed, the patient and all associated exams will 
be permanently deleted.  

Figure below shows the warning message displayed: answer “Yes” if any unsaved data to avoid data 
loss, answer “No” to confirm patient removal. 

 

 

• Set marker to “Read”: this action allows marking the selected patient as “read” in order to trigger the 
automatic archiving procedure; typically used after the exams of the selected patient are reviewed by 
the doctor/technician. 

Note. A patient can be marked as “read” only if all the related exams are already marked as “read” or 

v 
v 
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“to delete”. 

If a patient has no associated VEEG exams and one or more exams are not marked yet, the following 
popup will appear:  

 

The popup will notify the user that the patient cannot be set to “read” since one or more EEG exams 
do not contain any GREEN flag (used to select parts of the EEG exam to keep) and the operation will 
be aborted. 

If a patient has associated VEEG exam and one or more exams are not yet marked, the following popup 
will appear: 

 

The popup will notify the user that one or more VEEG exams do not contain any RED flags (used to 
select parts of the VEEG exam to keep). The user will be asked if they would like to add the RED flags 
manually: 

1. Choosing “Yes”, the user will be prompted to work on each single exams (at a later time) and the 
patient will not be marked as “read”. 

 

2. Choosing “No”, the user will be asked whether to maintain all videos (“Keep ALL”) or to delete 
them all (“Delete ALL”). After selecting one of these options and pressing the “OK” button, the 
patient will be marked as “read”, as well as all its associated exams. The user will still be able to 
abort the operation by clicking the “Cancel” button. 
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Operations on Multiple patients’ selection 
File Manager allows to select multiple patients from patients list (Ctrl + click or Shift + click). Right clicking on 
the multiple patient’s selection, it is possible to perform the following operations, that follow the rules of 
single patient selection: 

- Copy To: all patients and related exams will be copied to the destination resource 

- Move To: all patients and related exams will be moved to the destination resource 

- Remove: all patients and related exams will be removed from the selected resource 

Direct Patient Info Editing 
In the Archive module it is also possible to directly edit Patient information acting on Patients list columns. 

For example, the user can quickly enter patient Comment by directly typing into the related column or he can 
easily assign exam Doctor, Marker, or Hospital Department by selecting the desired value among the available 
options in the drop-down menu which opens by clicking the “pencil” icon in related column. 

 

 

Comment editing 

 

 

Patient Fields editing 
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Concurrency 
FILE MANAGER does not allow some operations on patient in case of concurrency, i.e. if some exam related 
to the patient is open or under elaboration, such as editing, removal or transfer, OR if the patient itself is 
“locked” for modification, removal or transfer by another workstation of the system. 

A popup message will appear warning the user the operation cannot be performed when such action is 
temporarily blocked for concurrency matter; the message displays the name of the machine “locking” the 
patient and the cause of the block in brackets. 

 

 

BASIC OPERATIONS ON EXAMS 

All basic operations the user can perform on a selected exam are quickly accessible from the Exam List or the 
Exam pane, according to current layout. 
 
Double clicking on a single exam opens the exam primary file with its associated application, such as Brain 
Quick software for EEG studies; this allows the user to review the recorded study with the suitable application. 

 

Exam – Basic Operations 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 74 of 267 

Right-clicking on an exam presents a contextual menu that allows the user to perform the following 
operations: 

1. Open the exam file with the associated application, if it is installed; otherwise, a warning message will 
appear notifying the user that the expected application is not installed. 

IMPORTANT NOTE: If the selected exam is CNS Moberg, a further option Open With is available, which 
allows the user to choose the specific application to use for the exam review. 

Options available are: CNS Envision, Brain Quick and Persyst. If the selected application is not installed 
the CNS exam is not open. 

2. Copy the selected exam and related patient to the chosen resource. This option copies ONLY the 
selected exam; to copy all the exams for the patient, see the “Copy to” in the Patients list. 

3. Modify the exam through the “Modify exam” dialog (see Home Tab section for further details) 

4. Remove the selected exam. In order to remove the selected exam, it is required for the exam to be 
accessible through current resource, i.e. it is required for the exam files to belong to the current 
resource path.  

5. Set the marker to “Read”, i.e. mark the selected exam as “read” (ready to be archived). 

Note. An exam can be marked as “read” only if it contains GREEN/RED flags (used to select which part 
of EEG/Video EEG to keep).  

If the exam has no associated Video EEG files and no flags are present, the following message will 
appear:  

 

By clicking “Yes”, File Manager will alert the user to work at exam level to insert the desired flags. If 
instead the user chooses “No”, the exam will be marked as read. 

If the exam has associated Video EEG files and no RED flags are present, the following message will 
appear: 

 

By clicking “Yes”, File Manager will alert the user to work at exam level to insert the desired flags.  

By clicking “No”, the user will be asked whether to maintain all the videos (“Keep ALL”) or to delete 
them all (“Delete ALL”). After selecting one of these options and pressing the “OK” button, the selected 
exam will be marked as “read”. The user will be able to abort the operation by clicking the “Cancel” 
button. 
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Note. If no GREEN/RED flags are inserted and the “Keep ALL” option is chosen, the entire EEG trace with 
related videos is kept when the exam clipping is performed; it is highly recommended to save storage space 
avoiding to archive not interesting data. 

6. Reduce, which allows the user to create a reduction task for the selected exam according to the 
selected reduction protocol. 

Note. This option is available ONLY for EEG and Video EEG exam, not yet archived, recorded with Micromed 
Acquisition Software. 
 

After clicking on this item, a dialog will open to allow the user to select a suitable reduction protocol 
among the available ones from a refreshable drop-down list. Once the reduction protocol is chosen, 
the user can send a reduction request to the Brain Quick Background Reduction Service by clicking the 
“Start reduction” button. 
 

 

Note. Background Reduction Service in embedded inside Brain Quick Software, FILE MANAGER sends a 
reduction request to Brain Quick Software when the “Start reduction” buttons is clicked. If Brain Quick 
Software is not installed, it will not be possible to perform EEG reduction 

 
A new reduction task will automatically appear in the Background Tasks panel reporting related 
progress status and further details, as illustrated in the dedicated section before. 
If the reduction request fails for some reason, the related task is marked as failed and a brief 
description of the occurred error is available clicking on the info icon which appears next to the task 
status. 
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7. Export to Viewer, which allows to export the selected trace to a “.vwr” format that can be opened 
using external viewer programs.  

Clicking this item will open the “Export to Viewer” dialog, where it is possible to choose whether to 
also include the video, events, and analyser files related to the selected trace. It is even possible to 
export Viewer program to easily open exported data. Program export will be successful just in case 
Brain Quick Viewer is installed in the machine. 

Another option is to keep the exported exam anonymous, by checking the related option. 

Note. This option is available ONLY for EEG exams recorded with Micromed Acquisition Software. 

 

 

8. Join with, which allows to join EEG or Video EEG traces associated to the same patient into a unique 
one.  
Clicking this item will open the “Join with” dialog where it is possible to choose EEG recordings to be 
joined with the selected one in the Exams list. 
 

 

Note. This option is available ONLY for EEG exams recorded with Micromed Acquisition Software. The 
functionality does not handle the joining process when the traces exhibit different connections. Moreover, it 
only combines EEG data, even when video files are present, as the merging of video files is not supported. 

9. Set marker to “To Delete”, i.e. mark the exam as ready to be deleted. Exam marked as “to delete” 
will be discarded by the auto-archive procedure and automatically deleted.  

A double confirmation is required for marking an exam as “to delete”, since it will be permanently 
removed during the auto-archive procedure and not archived at all. 
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Note. Exams marked as “to delete” are considered by the auto-delete procedure ONLY if related 
patient is marked as “read”. 
 

10. Reset Marker, allows to remove a marker that has been set for the selected exam 
 

11. Close Job allows to close working cycle in case of patient imported with HL7 environment. The option 
will be visible among the basic operations only if it has been enabled from options. See section related 
to HL7 integration for further information. 

 

Direct Exam Info Editing – Exam level 
In the Archive module it is also possible to directly edit Exam information acting on Exams list columns. 

For example, the user can quickly enter exam Comment by directly typing into the related column or he can 
easily assign exam Doctor, Technician or Hospital Department by selecting the desired value among the 
available options in the drop-down menu which opens by clicking the “pencil” icon in related column. 

 

 

Comment editing 

 

Exam Fields editing 
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Note. Modifications related to “Doctor”, “Technician”, “Requesting Doctor” and “Hospital Department” fields 
will automatically apply to all the files associated to the edited exam. 

 

Concurrency 
FILE MANAGER does not allow some operations on exam in case of concurrency, i.e. if some file related to the 
exam is open or under elaboration, such as editing or removal, OR if the exam itself is “locked” for 
modification, removal or transfer by another workstation of the system. 

A popup message will appear warning the user the operation cannot be performed when such action is 
temporarily blocked for concurrency matter; the message displays the name of the machine “locking” the 
exam and the cause of the block in brackets. 

 

In addition, if there is any on-going review session or report file is open or any “locking” operation is in 
progress, the Exam is highlighted in a different color in the Exams list and all the Files interested by the 
“locking” operation, such as trace file, video, events file, analysis file and/or report, are visually marked as 
“locked” by a “lock” icon which appears at file level (as shown in the image). 

Note. Exam or single file editing and removal are “blocking” operations, i.e. no action is temporarily allowed 
on Exam and File; instead, if an exam or a file is open it is possible to open it again in another workstation 
(collaboration): the user will be notified about it and asked to confirm the file opening. 

 

 

Basic Operations on Multiple Exams 
Exams list allows to select multiple exams and apply the same action at the same time. 

  

Keep the “Ctrl” or “Shift” button pressed and select multiple exams, then right-click on the selection: a 

contextual menu will appear allowing the user to perform the following operations: 
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1. Copy to, to copy all selected examinations (and related files) to a target resource at the same time. 

2. Modify, to modify the same information in all the selected exams at the same time.  

The “Modify all” dialog will display all common editable fields, such as Doctor, Technician, Hospital 

Department etc.; modification(s) will apply to all files related to each selected exam.  

 

Note. If any exam has some value already assigned for the edited field(s) the user is warned and 

asked to confirm the overriding of the existing value(s) with the new one(s). 

 

3. Remove, to remove all the selected exams at a time. Exams must belong to current resource path to 

be effectively removed. 

4. Set marker to “Read”, i.e. mark all the selected exams as “read” (ready to be archived). 

5. Set marker to “To Delete”, i.e. mark all the selected exams as ready to be deleted; such exams will 

be discarded by the automatic archive procedure and definitively removed. 

6. Reset marker, to remove all “read” or “to delete” markers assigned to any of the selected exams. 

 

Multiple Exams – Basic operations 
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BASIC OPERATIONS ON EXAMS FILES 

All basic operations the user can perform on a selected file are quickly accessible from the inner level of the 
Exam List or the File pane, according to current layout. 
 
Double clicking on a single file opens it with its associated application. 
Note. Only EEG (EMG-EP) trace files, report file, and anamnesis file can be opened by double click. 
 

 

File – Basic Operations 

Right clicking on a file shows a contextual menu with the following options: 

1. Modify, which opens a dedicated dialog for editing file information, as shown in the figure below. 

Like the “Modify exam” dialog, the “Modify file” dialog shows the patient information in read-only 

mode. The drop-down menus for the “Doctor” and “Technician” are filled in with the doctors and 

technicians added using the “New Doctor” / “New Technician” buttons in the Setup Tab. 

 

 

“Modify file” dialog window 

2. Remove, which allows the user to remove the selected file. As is required for the removal of the 

entire exam, a file can be removed only if it belongs to the current resource. 

Note. It is not possible to remove trace file, act at exam level for such purpose. 

3. Additional info, which allows the user to assign additional information (custom fields) to current 

recording. It is possible to assign different fields to each trace file and for each additional information 

it is possible to select multiple values from a pre-compiled list. 
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Additional Info  

Note. Additional information available must have been defined as statistic items in SystemPLUS 

Evolution. FILE MANAGER only read statistic items defined in Micromed database and allows the 

assignment to EEG recordings. 

Additional info assigned to a specific recording can be visualized in the Exams list at file level by 

selecting the information to show through the Column Chooser, as shown in figure below. 

 

 

Note. Only the first six additional information classes can be selected as column to display on the Exams list; if less 

than six classes have been defined Undefined Statistic Column option will appear in the Column Chooser list. 

 

Direct File Info Editing - File level 
In the Archive module it is also possible to directly edit File information acting on Exams list columns at file 
level. 

As for Exam, the user can quickly enter file Comment by directly typing into the related column and he can 
easily assign Doctor, Technician, Requesting Doctor and Hospital Department by selecting the desired value 
among the available options in the drop-down menu which open by clicking the “pencil” icon in related 
column. 
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Comment editing 

 

File Fields editing 

Concurrency 
FILE MANAGER does not allow some operations on single file in case of concurrency, i.e. if the file is 
temporarily “locked” since it is open or under elaboration, such as editing, removal or transfer. 

A popup message will appear warning the user the operation cannot be performed when such action is 
temporarily blocked for concurrency matter; the message displays the name of the machine “locking” the 
exam and the cause of the block in brackets. 

 

In addition, the Exam to which the “locked” file is associated is highlighted in a different color in the Exams list 
and the File itself is visually marked as “locked” by a “lock” icon (as shown in the image). 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 83 of 267 

Note. File editing and removal are “blocking” operations, i.e. no action is temporarily allowed on such file; 
instead, if the file is open it is possible to open it again in another workstation (collaboration): the user will be 
notified about it and asked to confirm the file opening. 

 

 

BASIC OPERATIONS ON VISIT 

As described before a visit is a collection of exams; in particular, LTM visit groups EEG (Video EEG) recordings 
performed under the same LTM recording session.  
 
All basic operations the user can perform on a selected visit are quickly accessible from the right-click 
contextual menu; options available are: 

• Open, which allows to directly open the entire visit, i.e. all trace and video files, with the application 
associated; if the latter is not installed, a warning message will appear notifying the user of the 
inability to open the selected visit. 

• Show Overview, which allows to open the Events Overview Panel 
 

It is also possible to open a visit by a double click, like for exams and files. 
 

Show Overview 
File Manager allows to visualize all events contained in a single visit. From LTM Layout view, right clicking on 
a visit, click on Show Overview. 

 

This function open the events overview panel, which allows to visualize all events contained in all grouped 
traces. From the panel, it is possible to refresh the view in case of new events insertion, or to filter and look 
for specific events in the visit. It is a dockable panel so it can be moved and pinned within FILE MANAGER main 
window or be kept separate in a second monitor. 
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Double clicking on a single event, makes Brain Quick Software open the related exam and move to the 
temporal position related to the selected event. 

 

ADVANCED FUNCTIONALITIES 

Feature described in following sections are advanced functionality and may not be available for standard user. 

 

MERGE PATIENTS 

FILE MANAGER allows to manually merge two patients when a patient has been erroneously duplicated with 
different demographic data in order to collect all patient’s studies under the correct patient. 

Important Note. Manually patients merge is enabled ONLY if HL7 Interface is NOT active; with HL7 
integration enabled, MERGE operations are automatically handled according to ADT messages received 
from the Hospital Information System. 
 
From the Patients List, it is possible to merge two patients, that is to associate all exams (and related files) of 
a patient to another patient. After the merge operation, the obsolete patient (erroneously defined) will be 
deleted from database. 
Note. The “Merge Patients” functionality is available for authorized user only, i.e. user with the “Can Manually Merge 
Patient” permission. 
 

Merging two patients is a critical operation and can be performed only if the obsolete patient is not locked 
by background copy nor is under archiving. 
To merge two patients, select the obsolete patient in the Patients List, right-click and choose the “Modify” 
option in the contextual menu. The Merge with button is at the bottom of the “Modify patient” window. By 
clicking on it, a password will be required and then the “Merge Patients” window will appear with a list of all 
available patients in the database, as shown in the figure below: 
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The patients list can be filtered by “Last name”, “First name”, “Birth Date”, “ID1” and “ID2” to quickly search 
for the patient to merge with. Once the correct patient is selected, click on the Merge button; the following 
message will appear: 
 

 
 

The message warns the user that the MERGE operation will permanently reassign all exams and files to the 
selected patient and that the obsolete patient will be permanently deleted. By clicking “Yes” patients will be 
merged and the obsolete patient will be removed from Patients list; by clicking “No” the operation will be 
cancelled. 

Note. The target patient selected for the merge operation cannot be locked by background copy nor be under archiving. 

IMPORTANT NOTE.  Archived exams, if any, are included in the MERGE operation, i.e. they are associated 
to the new patient. 

 

REASSIGN PATIENT 

FILE MANAGER allows users to re-assign an exam to a different patient, for example if the acquisition was 
performed under the wrong patient.  
 
Important Note. Manually re-assignment of patient is enabled ONLY if HL7 Interface is NOT active; with HL7 
integration enabled, such operations are handled according to requests received from the Hospital 
Information System. 
 
It is possible to manually re-assign a study to a different patient directly from the Exams List.  
To re-assign an exam select it, right-click and choose the “Modify” option in the contextual menu, the Change 
Patient button is at the bottom of the “Modify exam” dialog. 
After clicking this button, the user will be required first to enter a password and then to confirm the action. 
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The message shown in the figure above warns the user that the CHANGE PATIENT operation permanently 
reassigns the selected exam and all associated files to another patient. 
After giving confirmation, the “Change Patient” window shown in the figure below will appear, allowing the 
user to select the new patient. 
 

 

Clicking “OK” will reassign the exam to the selected patient. 
 
Note. The Change Patient functionality is available only for authorized user, i.e. user with the “Can Manually Reassign 
Patient” permission. 

 

AUDIT TRAILING AND LOG SEARCH 

FILE MANAGER offers the possibility to track user interaction with each workstation and record the execution 
of key functions to an audit log; in a networked environment such functionality is manage centrally, that is all 
significant activities performed by users within Micromed system are written to the central Audit Log 
database (on server). 

To enable the audit trailing click the application button, enter the Settings area (Logging) and select the 
“Enable Audit Log” option: 

 

Audit Log Setup 
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Note. Only authorized user with the “Can Modify Central Settings” permission can enable audit trail. 

In the centralized Audit Log database are trailed all FILE MANAGER and Brain Quick software significant 
activities performed by the logged-in user. 

Note. If users authentication is disabled (not recommended), there is an option in the logon preferences (“Use 
Environment Username”) which allows to consider the domain user logged into the machine in the audit trail.  

 

Audit Log Search 
FILE MANAGER offers an embedded searching tool, the Log Search, which allows to search on the Audit Log 
trail focusing on a specific activity or a specific user.  
 
Clicking the Log Search button on the ribbon bar (Home Tab) the “Audit Log Search” window will open; it 
consists of an upper pane where the user can insert search criteria and a lower panel where research results 
are displayed in tabular way. 
Log Search tool allows to monitor all activities performed by a certain user on a specific machine or generally 
on the system; it also allows to focus on a specific activity. 
It is possible to filter search results in a certain date range or for a specific machine. 
 
Set desired criteria and click the “Search” icon to visualize search results. A navigation bar, above the results 
table, allows to easily scroll through different pages. 
 

 

Audit Log Search window 
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HL7 INTEGRATION 

In FILE MANAGER it is possible to see, handle and process HL7 requests received from the Hospital 
Information System (HIS). 

Micromed Suite offers a dedicated HIS Settings configurator where it is possible to set up HL7 Interface and 
enable HL7 requests management on authorized workstations; HL7 interface is based on both Central and 
Machine (local) settings which are stored in dedicated configuration files.  

Central settings configuration is typically performed on server and it is inherited by all client stations involved 
in the HL7 requests management. 

Machine settings configuration is performed on single workstation in order to set up local HL7 preferences; 
FILE MANAGER Settings area has a dedicated HIS settings panel for this purpose. 

Note. HL7 Interface functionalities, both server and client side, are protected by specific license keys. 

HIS REQUESTS WORKFLOW 

Once HL7 interface is properly configured, FILE MANAGER offers a dedicated panel, the Working List, where 
all HL7 requests received from the Hospital Information System are displayed and can be imported to be 
executed. 

It is possible to easily filter on received HIS requests and import patient-specific request within Micromed 
database as request associated to a new patient whose demographic data are automatically aligned with 
information received from the HIS.  
Since then, patient data will be kept automatically synchronized (updated) with the central anagraphics 
handled by the Hospital Information System. 

Finally, report document related to an imported HL7 request can be exported in Pdf format, i.e. sent back to 
the HIS, and there is also the possibility to handle subsequent versions of the same document before closing 
the loop. 

 

IMPORT OF HIS REQUESTS INTO THE ARCHIVE 

In the Archive module (FILE MANAGER) it is possible to import HIS request, such as order entry or appointment 
request, received from the Hospital Information System as a new patient with a pending exam to be executed; 
if the patient already exists in Patients database, the Archive will directly point to this patient. 
 
Important Note. To activate the Working List panel and manage HIS requests on single workstation you 
need the FMS HIS CLIENT license enabled and the logged user must have the “Can Access to External HIS 
Interface” permission.  
In addition, to export report and send it back to HIS the logged user must have the “Can Export Report to 
HIS” permission. 
 

Working List panel 

When HL7 Interface is properly configured and enabled, the Working List button appears in the Home tab of 
the archive window ribbon bar under the HIS functional group. 
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Clicking on the Working List button, the Working List appears; it is a dockable panel so it can be moved and 
pinned within FILE MANAGER main window or be kept separate in a second monitor.  

 

Working List 

The Working List collects all HL7 requests received from the HIS listed in a table where each line represents a 
specific-patient request; requests are split into two main tabs: To Import and Already imported.  
The former displays all received requests to be processed; the latter shows all the already imported requests. 
 
It is possible to manually refresh the list of the received requests by clicking the Refresh button on the toolbar. 
 
For each request essential information related to the patient and the request itself are displayed, such as 
patient name, patient ID, patient date of birth, the request scheduled date and time, eventual 
comments/notes and whether it is urgent.  
Information displayed are customizable, i.e. by the Column Chooser tool available in the context menu it is 
possible to select what show/hide. 

Note. The management of patient extra fields and exam extra fields is a Central settings option; if enabled, 
extra information available in the received HL7 requests will be automatically imported and kept updated. 

 

Working List - Column Chooser 

Requests can be sorted in ascending or descending order based on the selected field by simply clicking the 
column header. 
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It is possible to filter on displayed requests by setting on or more filtering criteria at the same time; currently 
applied filters are shown at the bottom of the list. 
 

 

Filtering Working List 

Note. Filters applied to the Working List will be maintained after closure and restart of FILE MANAGER. 

 

Importing HL7 Request 

To import a patient-specific request inside the Archive module you have to select the request from the 
Working List (To Import tab) and click the Import button on the toolbar.  
 

 

Working List - Import HL7 request 

Patient related to the imported request is automatically added to Patients database, if not yet registered, and 
patient information received from the HIS are inherited; you can see all patient information in the “Modify 
patient” dialog which opens by selecting the “Modify” option in the right-click contextual menu. 
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Patient Info 

The new patient appears in the Patients List or, if already existing, is highlighted.  

For the newly imported patient, no exam is available, and you can proceed with the exam execution according 
to the received order entry, for example performing a new EEG recording. 
 

 

Imported HL7 request (patient) 

In the Working List panel imported requests automatically pass from the To Import list to the Already imported 
one. 
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Working List – Already imported requests 

It is also possible to perform import undo, i.e. to cancel an import operation, by simply selecting the imported 
request in the “Already imported” list and clicking the Undo import button on the toolbar: the request will 
return to the “To Import” list and eventual examination already executed will be “invalidated”, that means it 
will not be possible to close the loop by exporting the report associated, if any, i.e. sending it back to HIS. 

 

REPORT EXPORT TO HIS 

Once the exam is done, it can be reviewed and related report document is created; to close the imported 
request loop it is possible to send it to the Hospital Information System in Pdf format within an HL7 message. 
The PDF export option needs to be activated from File Manager settings. 
 

 

 
 

The saved report will appear in the archive window Exams List as a document associated to the Exam; in 
addition, a “report” icon will appear in the “Study contains” column (second column) related to the exam. 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 93 of 267 

  

EEG Report – Exams list 

By clicking on the “report” icon it is possible to open the saved report within the Report Editor, check the 
content of the document and send it to the HIS in Pdf format by clicking the Export Pdf button available in the 
HIS tab of Report Editor toolbar. 
 

Note. According to the set central preference, the name of the doctor assigned to the examination or the name of the 
logged user can be included in the report export message. 

 

 

Report Editor – HIS tab 

Clicking the Export Pdf button, the report is converted in PDF and sent to the HIS.  

In case the option Convert and Replace is not enabled, a new PDF report will be added to the exam and can 
be open in read-only mode within the Report Editor. It can be used to handle different versions of the report. 
Instead, if the option is enabled, the exported report will be replaced from the new PDF report. It is even 
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possible to enable the PDF compression, which allows to reduce the PDF memory size in case of images, or 
any other media saved in the report. 

 

Exported Pdf Report in case of Convert and Replace – Exams list 

 

 

Report - Pdf Viewer 

PATIENT UPDATE AND PATIENTS MERGE REQUESTS 

HL7 Interface also supports the automatic handling of patient info update and patients merge requests 
received from the Hospital Information System (HIS). 
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Patient Info Update 
HL7 requests with the purpose of updating a specific patient information are automatically processed with 
the result of keeping the imported patient information always synchronized with the Hospital Information 
System. 

For example, if demographic data related to a specific patient, such as the birthdate or the address, are 
wrongly entered by HIS, when the HIS itself detects and corrects the error it can send an ADT message notifying 
Micromed system about the patient information update. 

 

 

 

 

 

 

Working List – Updated Patient Info 

 

Patients List - Updated Patient Info 

Patient information inside Patients database are automatically aligned with the central HIS anagraphics and in 
the Archive module updated data are shown both in the Working List panel than in Patients list (and so in the 
“Modify patient” dialog). 

Patients Merge 
Hospital Information System can send HL7 messages with the purpose of merging two patients, for example 
in case a patient has been wrongly doubled in the central HIS anagraphics and there is the need to unify all 
examinations under the correct anagraphic data (patient); such messages are automatically processed and 
patients are properly merged.  
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Patients Merge 

The merge operation implies that one only patient is maintained in Patients database and any exam associated 
to the removed patient (obsolete) is moved to the correct patient folder. 

In the Working List panel, any existing request related to the obsolete patient is unified, i.e. properly assigned 
to the correct patient ID.  

CLOSE JOB 

HL7 Interface also supports the manual closure of the working cycle in case of request already imported in 
which the PDF export is no longer useful. The option Close Job needs to be enabled from File Manager settings. 

 

When the option is enabled, the choice gets available from the contextual menu at exam level, and from HIS 
tab in the created report. 
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When clicking on Close Job, the working cycle will be closed and it will no more be possible to export the PDF 
report, nor to Undo the request import. 

EXAM DONE 

HL7 Interface also supports the manual setting of exams as Done. This feature can be enabled at from server 
and allows to mark an exam before exporting to PDF or closing the job. 

When the option is enabled, the choice gets available from the contextual menu at exam level. 

 

Clicking on Set Exam to Done will open a dialog window, in which it is possible to mark the exam as “Done” or 
“Not Done” and to confirm the operation sending the notification to HIS. 

JOIN OFFLINE PROCEDURE 

HL7 Interface supports the Join Offline feature, which allows to join an exam which was previously done with 
a newly received request. This may be useful in case of network faults, in which the request may not be 
available to be imported. In those cases, the patient can be created manually with just basics information, the 
exam can be executed and, once the request import will available again, it will be possible to select the exam, 
the request and to join them. Join Offline may be also useful in case the request is imported from another 
resource. 

In this case, all patient and exam information will be updated with the ones received from the joined request. 
This closes the HL7 working cycle, and the request will no more be available in “Already Imported” tab. To 
execute the procedure, it is necessary to select an exam, then a request and click on Join Offline button. 
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MULTIPLE REQUESTS MANAGEMENT 

HL7 Interface also supports the management of Multiple Requests. The option can be activated at Central 
level from Micromed Suite and is propagated to all the clients of the system. When multiple requests 
environment is enabled, requests for a single patient are no more managed singularly but as a group of 
requests for the single patient. 

This causes that all the operations previously seen work with a group of requests. The workflow from File 
Manager (requests import, PDF export, Exam Done, Join Offline) is the same. During import procedure, it is no 
more possible to import a single request but only the requests group. 
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EEG RECORDING FROM ARCHIVE 

FILE MANAGER is the entry point for EEG recording and all reviewing activities clinicians and physicians can 
perform on EEG studies. 

The Brain Quick Tab of the ribbon bar collects all commands to start a new EEG recording. 

 
 
Clicking the New EEG button will open the Brain Quick software Acquisition window which allows to start 
either a new EEG or Video EEG recording with the last used acquisition protocol. An acquisition protocol is the 
collection of configuration parameters needed to perform an EEG recording, such as the headbox, one or more 
cameras, the connect configuration, i.e. the settings of the input channels of the acquisition device, and the 
photic stimulation protocol. 
 
The Home Tab of the ribbon bar of Acquisition window collects all commands to start, save, pause and stop 
the acquisition, and to set up photic stimulation, chronometer, notes and cortical stimulator; see the 
dedicated chapter of Brain Quick software User Manual for all the details. 

 
If there are on-going EEG recordings the Acquisition List panel allows to monitor the progress status of the on-
going recordings; in the detail section related to the specific acquisition machine the patient name and the 
name of the acquisition resource are shown.  
 
From the Acquisition List of other review stations of the system, it is possible to remotely review the on-going 
EEG study during the recording by selecting the acquisition system from the list and choosing the “Remote 
Review” option in the right click contextual menu. 
 
In addition, it is possible to take the remote control of an acquisition station and live monitoring the on-going 
recording by choosing the “Remote Control” option in the right click contextual menu. 
 

 

Acquisition List – Options 

It is also possible to start a new recording by selecting the desired acquisition protocol; clicking the Select 
Protocol button will open a dedicated window of the Brain Quick software where all defined acquisition 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 100 of 267 

protocols are listed and it is possible to start a new recording by selecting a protocol from the list, create a 
new protocol or edit an existing one. 
 
Finally, clicking the New EEG (Default Protocol) button it is possible to start a new recording with the default 
acquisition protocol. 
 

EEG REVIEW FROM ARCHIVE 

From FILE MANAGER main window it is possible to access the EEG review window of BRAIN QUICK software 
which allows to read and review EEG and Video EEG data recorded with BRAIN QUICK software itself, with 
SystemPlus EVOLUTION and with the CNS Monitor.  

To access the EEG review window, the user must select a patient from the Patients list and choose the study 
to review from the Exam list, then follow the procedures below:  

• Click twice directly on the EEG exam icon in the first column of the exam list 

• Or click twice on the trace file on the inner level (or the lower panel) of the exam list (depending on 
the active layout) 

• Or select the Open function from the right click contextual menu available both for exam and file 
 

This way, the EEG review screen will appear: it is the part of Brain Quick software that is used to review and 
analyze EEG exams. In the review section, it is possible to review more than one trace at the same time and 
this allows the user to compare different exams of the same patient or of different patients. For further details 
about the EEG studies Review see the dedicated chapter of Brain Quick software User Manual. 

 

EEG REPORT CREATION FROM ARCHIVE 

From FILE MANAGER main window it is possible to create a new report for the selected exam. After selecting 
an exam, In Brain Quick Tab there is a New Report button, which opens the window for the template selection. 
After selecting a template from the available ones, editing the report, and saving it, makes the report to be 
added to the desired exam. 
 

FIRMWARE UPDATE 

From the Archive main window it is possible to perform the firmware update of the amplifier when it is 
connected to the PC.  

In Brain Quick Tab there is a Firmware Updater button to open the window in order to perform the headbox 
update. 
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Clicking on the button opens the following window: 
 

 

From the drop-down menu, it is possible to choose which of the available headboxes to perform the firmware 
upgrade. Once selected, information regarding the current version and the version available for upgrade is 
shown. Finally, the two buttons next to the drop-down menu are used to update the list of available devices 
and to upgrade the firmware, respectively. 

 

AMBULATORY DATA DOWNLOAD 

From the Archive main window it is possible to download ambulatory data directly from the amplifier, which 
can be connected via cable, or from a memory card reader; the data download is performed by Brain Quick 
Software. 

In Brain Quick Tab there is a Data Download button to access the “Data downloader” dialog window. 

 

Note. Supported Micromed ambulatory recorders are: 

• SD LTM PLUS family 

• SD LTM EXPRESS family 

• Morpheus 

 

DATA DOWNLOAD FORM DEVICE 

In the “Data downloader” dialog window, select the Download from device option in order to get ambulatory 
data from the desired amplifier. 

Select the amplifier from the list of the available devices and wait for the data reading. 
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Data Download from Device 

Note. If the amplifier is not in the list, it is possible to force the headbox discovery by clicking the Refresh 
button. 

As soon as data reading completed, in the “File info details” panel below essential information related to the 
recorded data are displayed, such as patient name, the headbox serial number, the number of recorded 
channels, the sampling frequency, the recording start and stop etc. 
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Click the Import button in order to start the ambulatory data download; a progress bar will report the data 
download progress status.  

 

Note. If patient currently selected does not correspond to the patient associated with the recorded data you 
are going to download, a warning message will ask you for confirmation before starting the data download. 

 

 

When download completed, click “Ok” to exit.  

In the Exams list a new EEG exam related to the selected patient will appear with an ambulatory trace file 
associated at file level. 
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Ambulatory Data – Exams list 

DATA DOWNLOAD FROM FILE 

In the “Data downloader” dialog window, select the Download from file option in order to get ambulatory 
data directly from file when a memory card reader is connected to the PC. 

Click the “folder” icon to browse the source trace file with data to download: Windows File Explorer dialog will 
open allowing you to navigate to the .trc file location (file name will be in the format FILEPAZn.TRC, where n 
is a progressive number). 

 

Data Download from File 
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Select the trace file to import, click “Open” button to confirm and wait for the data reading to complete; at 
the end, in the “File info details” panel below essential information related to the recorded data are 
displayed, such as patient name, the headbox serial number, the number of recorded channels, the sampling 
frequency, the recording start and stop etc. 

 

As for the download from device, click the Import button in order to start the ambulatory data download; a 
progress bar will report the data download progress status.  

 

When download completed, click “Ok” to exit.  

As before, in the Exams list a new EEG exam related to the selected patient will appear with an ambulatory 
trace file associated at file level. 
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Ambulatory Data – Exams list 

 

IMPORTING STUDIES AND FILES 

FILE MANAGER provides two import functions: 

• Exam Import  

• File Import 
 
Importing functionality can be related to a specific patient or to an existing study. 
 

HOW TO IMPORT A STUDY 

From the Home tab (Tools group) of ribbon bar it is possible to import an entire examination clicking the Exam 
Import button.  
 
Windows File Explorer will open and the user can select the EEG (EMG-EP) trace file related to the study to 
import. When click “Open” the “Patient Info” window will appear with patient data pre-compiled, click “OK” 
to confirm the import. 
 
If imported study is related to a patient not yet registered, a new patient will appear in the patients list with 
the imported exam associated in the Exams list. 
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VEEG Exam Import 

Note. If a Video EEG study is selected both trace file and all related video files are imported.  
 

HOW TO IMPORT A FILE 

From the Home tab (Tools group) of ribbon bar it is possible to import a single file related to existing or already 
imported examination clicking the File Import button.  
 
Windows File Explorer will open and the user can select the file to import. It is possible to import only event 
or analysis files; such file will be associated to the EEG study currently selected. 
When click “Open” the import is confirmed and the selected file will appear in the inner level of the Exams list 
under the selected study or in the File pane, according to current layout. 
 

 

Event File Import 
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Note. It is supposed the user knows the EEG study to which the imported file is associated; no check is performed by 
FILE MANAGER importing procedure. 

 

HOW TO IMPORT A REPORT 

From the Home tab (Tools group) of ribbon bar it is possible to import a report related to existing or already 
imported examination clicking the File Import button. 
 
Windows File Explorer will open and the user can select the report file to import. It is possible to import report 
in Word, Odt or Pdf format only; such file will be associated to the study currently selected. 
 

 

When click “Open” the import is confirmed and the selected report will appear in the inner level of the Exams 
list under the selected study or in the File pane, according to current layout. In addition a report icon will 
appear in the “Study contains” column of the exam list related to the study. 
 

 

Report Import 
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Note. Report file does not store information which allows univocal identification of related patient and 
associated exam. It is supposed the user knows the EEG study to which the imported report is referred; no 
check is performed by FILE MANAGER importing procedure. 
 

HOW TO IMPORT A VIDEO 

FILE MANAGER also allows to import video file for anamnesis purpose and to associate it to a specific patient. 
Select the patient in Patients list and click the Exam Import button in the Home Tab (Tool group) of the ribbon 
bar. 
 
Windows File Explorer will open, change the file type choosing the “video file (*.MP4)” option and select the 
video to import. 
When click “Open” the import is confirmed a dialog window will appear allowing the user to select the 
template to create a new anamnesis for the selected patient. The new anamnesis will appear in the Exams list 
with the imported video associated. In addition, a video icon will appear in the “Study contains” column of the 
exam list related to the anamnesis. 

 

Video Import (Anamnesis) 

It is possible to play the imported video directly within FILE MANAGER main window by double clicking on 
video icon or on the video file itself; the Video panel (dockable) will appear with buttons to play, pause and 
stop the video. 
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Video Panel 

HOW TO IMPORT EDF FILE 

FILE MANGER allows to import also file in EDF or EDF+ format and associate it to a specific patient. 

Select the patient in Patients list and click the Import EDF button in the Brain Quick Tab (Tools group) of the 
ribbon bar. 
 
Windows File Explorer will open with file type set to “edf files (*.edf)”: navigate to the folder where file to 
import is located and select the EDF to import; click “Open” to confirm the operation. 

 

EDF File Import 

 
The imported file is automatically converted by Brain Quick Software into an EEG trace file and a new EEG 
exam appears in the Exams list associated to current patient.  
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HOW TO IMPORT BDF FILE 

FILE MANGER allows to import also file in BDF format and associate it to a specific patient. 

Select the patient in Patients list and click the Import EDF button in the Brain Quick Tab (Tools group) of the 
ribbon bar. 
 
Windows File Explorer will open: change the file type choosing the “bdf files (*.bdf)”, then navigate to the 
folder where file is located and select the BDF file to import; click “Open” to confirm the operation. 
 

 

BDF File Import 

 
The imported file is automatically converted by Brain Quick Software into an EEG trace file and a new EEG 
exam appears in the Exams list associated to current patient.  

 
 

SETTINGS 

FILE MANAGER and Brain Quick software settings type are: 

• User: local settings different for each user (applied to a specific user on a specific machine) 

Note. All FILE MANAGER User settings are centrally stored; there are no local User settings. 

• Machine: local settings equal for all users on a specific machine 

Note. Machine settings are editable by authorized users only, i.e. user with the “Can Modify Unit 
Settings” permission 
 

• Central User: central settings different for each user (applied to a specific user in all the machines)  
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• Central: central settings equal for all users in all the machines of the system 

Note. Central settings are editable by authorized users only, i.e. user with the “Can Modify Central 
Settings” permission 
 

In a networked environment the centralized settings configuration is stored on server; local type settings are 
maintained on single workstation with possibility to be manually centralized, while central type settings are 
automatically downloaded to single workstation at installation time and kept synchronized with the central 
configuration. 

 
It is possible to access the Settings area by clicking the FILE MANAGER application button on the top left corner 
of the main window and selecting Settings from the menu; the “Settings” window will open organized into 
different tabs. 

This dedicated area allows the user to modify many application settings, some of which are key to the correct 
functioning of the FILE MANAGER application itself. 

Note. It is highly recommended that Administrator users only perform Central settings setup and that Unit 
settings are changed only by qualified technical personnel. 

 

The complete list of options is comprised of eight tabs, each one grouping different settings.  

The Tabs are: 

• Display 

• Language 

• Archive 

• Acquisition List 

• Licensing 

• Logging 

• Lockdown 

• Labels Customization 

• HIS 

 

Settings type for each configuration tab will be specified in the following sections. 

 
Note. Following paragraphs describe all options available for Administrator user which is allowed to setup 
and change also Unit and Central settings. The majority of settings illustrated below is not available for 
standard user who typically can access only User settings. 

 

DISPLAY SETTINGS 

The Display Tab allows users to configure display settings of the application; the tab pane is divided into the 
following three sections: User, Machine and Central. 

 

User Settings 
Each user can setup the following display settings: 
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• Theme of FILE MANAGER application, the user can select the desired theme among many Microsoft 
Office themes. Once the theme is changed, restarting the FILE MANAGER is NOT required to apply the 
changes. 

• Grid, preferences related to the Patients list and Exams list. In this section it is possible to: 

a. Enable the option to auto-expand files when selecting a visit in the exams list. 

b. Change the font size for patients and exams.  

c. Select the naming convention, patient’s last name before the first name or vice versa. 

Note. Chosen naming convention will be applied to any physical person whose data is shown in FILE 
MANAGER, such as patients, doctors, and technicians. 

 

 

• Visit View, in this section it is possible to: 

a. Enable the automatic grouping of LTM EEG exams in a single visit. If this option is enabled, the 
user can also decide the grouping criteria (in days) from one up to seven days; for example, if 
“1 day” option is selected all EEG recording performed within the same day are grouped under 
the same LTM visit.  

Note. The LTM aggregator algorithm considers two parameters: the grouping criteria and the anchor 
time, a central settings, which represents the starting time of the day from which the grouping begin. 

 

Machine Settings 
Authorized user can setup the following display settings which are saved at machine level, i.e. applied to all 
users working on the machine: 

• CNS Exam Options, to manage the integration between Moberg CNS Envision software and FILE 
MANAGER. 
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As seen in the figure above, in this section is possible to: 

a. Choose the default application to open a CNS exam when double clicking.  

Available options are Brain Quick, CNS Envision, and Persyst.  

b. Configure the right-clicking “Open With” menu options for CNS exams opening; if any of the 
listed options is selected, the ability to open files with applications different from the default 
one will be enabled. 

Note. The “Open with” option will be available in the right-click contextual menu of Exams list when 
a CNS exam is selected.  

c. Set the program file path for  

a. CNS Envision executable file (.exe) 

b. Persyst executable file (.exe) 

c. Analysis destination folder, in case of hybrid system with SleepRT analysis executed 
from SystemPLUS Evolution 

d. SleepRT executable file (.exe) 

Note. To open CNS exam files with applications other than the default one, it is required that the CNS 
Envision and Persyst path fields point to their respective “.exe” files. 

Central Settings 
Authorized user can set up the following centralized display options which apply to all users and all machines: 

• Anchor time, which is the starting time of the day used as reference to split EEG exams into different 
LTM visits according to the grouping criteria chosen by each user. 
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LANGUAGE AND INTERNATIONALIZATION 

The Language Tab allows authorized user to choose the application language.  

Note. Available languages are English (default), Italian, German, French, Spanish, Portuguese, Danish, Dutch, 
Finnish, Russian, Swedish and Turkish. 

In the same tab it is also possible to set up internationalization preferences, i.e. to choose the date time format 
and related separator. 

 

 

 

Once the selections are saved, THE APPLICATION NEEDS TO BE RESTARTED to apply the changes. 

Note. Language and Internationalization preferences are Central settings, i.e. they must be set up by 
Administrator user and they apply to all users and all machines of the system. 

 

ARCHIVE SETTINGS  

The Archive Tab is divided into two sections: User and Central.  

User Settings 
User can set up the following options: 

a. Enable the “Set patient to “Read” when all patient exams are marked as “Read”” option, which 
allows to automatically set a patient to “read” if all the patient’s exams have been marked as “read”. 
The “read” option allows the user to trigger the automatic archiving procedure. 
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If this option is disabled, the patient is not set to “read” even when all the patient’s exams have been 
marked as “read”; such operation have to be performed manually. 

Note. The option takes into consideration also the “to delete” marker, i.e. if enabled, patient is 
automatically set to “read” if all related exams are either marked as “read” OR as “to delete”. 

b. Enable the “Ask to mark exam as “Read” on EEG review window exit” option to automatically  prompt 
the user to set an exam to “read” when exiting from an EEG review session. 

 

Central Settings 
Authorized user can set up the following centralized options which apply to all users and all machines: 

a. Enable the “Archive analysis file to Storage (Persyst, .fft)” option, which triggers the automatic 
archiving of analysis files, if any, when an EEG exam is archived. 

 

ACQUISITION LIST SETTINGS 

The Acquisition List Tab allows to configure the settings of the Acquisition System List; it is divided into two 
sections: Machine and Central. 

Machine Settings 
Authorized user can enable/disable the Acquisition list on each single machine.  

Then it is possible to configure the following settings of the Acquisition System List: 

a. Enable option for the remote control of the listed acquisition systems. 

b. Browse the UltraVNC Viewer installation path for the remote control of acquisition system running 
System PLUS Evolution. 

c. Add/Remove an acquisition system; each workstation can monitor and/or take the control only of 
acquisition system listed in the Acquisition systems table. 

All controllable acquisition systems are listed, together with their host (i.e. their IP address) and their 
(hidden) password for the remote control by UltraVNC. Buttons “Add” and “Remove” at the bottom 
of the list can be used to add a new system or to remove the selected one. 

Note. Machine name, IP address and password are mandatory to interact with the acquisition system. 
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IMPORTANT NOTE. In order to use the Control functionality on acquisition stations running SystemPLUS 
Evolution, the software UltraVNC must be installed both on the server computer and the client computer.  

Central Settings 
Authorized user can set up the following centralized options for the Acquisition list configuration: 

a. Choose the format for the patient name. 

b. Configure the four visible fields (A through D) displayed in the details pane of each acquisition machine 
shown in the Acquisition List panel; default values are Name, Location, ID1 and None, respectively. 

 

 

LICENSING  

Note. All Licensing settings are Machine settings, i.e. they apply to all users working on a specific station. 

 
The Licensing Tab allows authorized user to configure and view the active licenses for the application. 

All active licenses are listed in a table and grouped by category.  



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 118 of 267 

 

LOGGING PREFERENCES 

Note. All Logging preferences are Central settings, i.e. they apply to all users and all machines. 

The Logging Tab allows authorized user to configure the level of detail of the log activity and to enable the 
auditing functions for the application.  

 

Log settings 
In the Log Settings section it is possible to define the log file path, i.e. where comments and/or errors are 
logged while FILE MANAGER application is running.  

Authorized user can select the destination folder to save the log files and choose the level of details of the log 
file; such options are the same for all machine of the system. 

Three levels of accuracy are available: 

• Detailed, which keeps track of each action performed in the FILE MANAGER 

• Debug, which tracks less actions than the “Detailed” level 

• Basic, which keeps track only of the most important information (typically errors and exceptions) 
related to actions performed in FILE MANAGER 
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Note. The default path for the log file is “C:\Users\Public\Documents\Micromed\FileManager\Log”. 

Audit Log Settings 
The Audit Log trail keeps track of the actions performed and which user performed them. 

In the Audit Log Settings section it is possible to activate or deactivate the audit trailing; activities are centrally 
stored in the Audit Log database (on server). 

 

LOCKDOWN PREFERENCES 

If Logon system is enabled, the Lockdown Tab allows authorized users to enable the application automatic 
lockdown and to set up the idle timeout, i.e. the period of inactivity of the Archive module after which the 
application automatically enters in lockdown mode. 

 

 
Note. Lockdown preferences are Machine settings, i.e. they apply to all users working on a specific station. 
 

LABELS CUSTOMIZATION 

For authorized users it is possible to assign a custom description to application labels. 
Note. Customized application labels are shared among all users and machines in the networked system. 
 
Clicking on the FILE MANAGER application button in the top left corner of the main window and selecting 
“Labels customization” tab in the Settings area it is possible to access a dedicated pane. 
Note. Authorized user only, i.e. user with the “Can Modify Central Settings” permission, can perform labels 
customization. 

 
The “Label customization” pane allows users to assign a custom description to application labels. It is 
comprised of four tabs: 

• Patient 

• Exam 

• File 

• Visit 
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Note. The configuration of custom labels is saved at Central level, i.e. it is unique to all users in all machines 
of the networked system where FILE MANAGER is installed. 
 
FILE MANAGER will refresh with customized descriptions as soon as changes are confirmed. 
The figure below shows an example of customization for the “Comment” column label in the Exams list. 
 

 

Patient 
The Patient tab allows users to assign a custom description to patient related fields shown in FILE MANAGER 
application.  
The Patient pane is comprised of the following sections:  

• Personal details  

• Address  

• Clinical references  

• Contact  

• Insurance  

• Physical data 

• Other  
 
In each section it is possible to customize specific labels related to patient data, such as demographic details, 
insurance information, etc.  
 

 

 

Additionally, in the “Personal details” section it is possible to set the “ID1” and “ID2” fields as mandatory. 
Note. The default mandatory patient fields are “Last name”, “First name” and “Birth Date”.  
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Exam 
The Exam tab allows users to assign a custom description to exam related fields shown in the FILE MANAGER 
application, such as “Code”, “Marker”, etc. 
 

 

 

As in the Patient tab, it is possible to set certain exam related fields editable by users as mandatory; this option 
is available only for “Code”, “Marker”, and “Comment”. 
 

File 
The File tab allows users to assign a custom description to file related fields shown in the FILE MANAGER 
application, such as “Comment”, “Doctor”, etc. 
 

 

Again, it is possible to set certain fields as mandatory; this option is available only for user-editable fields, i.e. 
Comment”, “Doctor”, “Technician”, “Hospital Department”, and “Requesting Doctor”. 
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Visit 
Finally, the Visit tab allows users to assign a custom description to columns associated to visit. 
 

HIS SETTINGS (HL7 INTERFACE) 

Note. All HIS preferences settable in FILE MANAGER Settings area are Machine settings, i.e. they apply to 
all users of the workstation. 

The HIS Tab allows authorized user to configure the HL7 Interface local preferences linked to report 
management. 

 

For single workstation (machine) it is possible to: 

• Enable the “Convert and replace” option, i.e. decide to override the original report document keeping 

only the exported pdf document. Otherwise, it is possible to keep a copy of the exported report (useful 

to handle different versions of the same document) if leaving the option unchecked. 

• Enable the report export in Pdf format and decide if send it in a compressed format or not. 

• Enable the “Close Job” option, i.e. the possibility of closing a job (imported HL7 request) even if the 

related report is not yet been exported. 

 

SETTINGS CENTRALIZATION 

In a networked environment it is possible to share local settings, i.e. Unit settings, with other users and 
machines of the system. 
FILE MANAGER offers a dedicated area where it is possible to select configuration files to share and centralize 
them.  
Note. Only authorized user, i.e. user with the “Can Modify Central Settings” permission, can perform 
settings centralization. 
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To centralize settings click the FILE MANAGER application button on the top left corner of the main window 
and select the Settings Centralization option from the left menu; a dedicated pane will appear where it will 
be possible to select the software for which configuration parameters have to be shared (FILE MANAGER, 
Brain Quick software). All configuration files available to be centralized are listed and a checkbox indicates 
which settings have already been shared. 

Select items corresponding to settings to centralize and click the Centralize button. The setting is marked as 
centralized and will be spread to all other machines of the distributed system. 

In all other workstations, at software restart, the user will be prompted with a notification as soon as he 
accesses FILE MANAGER and can decide whether to accept or reject the settings just centralized, i.e. to be 
synchronized or not with central configuration. 

When a setting file is centralized, all machines of the network have a local copy of it and can still go on 
modifying it locally. 

In case an already centralized setting is updated from a client machine and the changes need to be updated 
in all clients on the network, the user can select the desired setting and click on Update. The modifications will 
be propagated to server which will spread the modified setting to all clients through the distributed network. 
In all other workstations, at software restart, the user will be prompted with a notification as soon as he 
accesses FILE MANAGER and can decide whether to accept or reject the settings just centralized, i.e. to be 
synchronized or not with central configuration. 

When a setting file is updated, all machines of the network have a local copy of the modified settings and can 
still go on modifying it locally. 
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After a file has been centralized, it is still possible to decentralize it, hence from server there will be no more 
mechanisms to distribute that file to all available client machines. To trigger that, it is necessary to select the 
setting to be decentralized and click on Decentralize button. The setting file will be still available locally in all 
machines of the distributed environment and can still be used and modified. 
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EEG MODULE – BRAIN QUICK SOFTWARE 
BRAIN QUICK SOFTWARE is the software that handles all of Micromed acquisition and Review systems for 
EEG, EMG and EP, which means that according to the enabled key options, BRAIN QUICK SOFTWARE integrates 
all types of exams in a single application. 

MAIN WINDOW BASIC ELEMENTS 

The EEG window makes up the main part of BRAIN QUICK SOFTWARE window. The figure below shows the 
basic elements of this window: 

 

In particular, the General Information Area is divided into four parts: 

- Title Bar; 

- Ribbon Bar; 

- Application Button; 

- Quick Access Toolbar. 

TITLE BAR 

Title bar displays the type of the window open ("EEG" or "REPORT"), first and last name of the patient with 
recording date and time. 

 

During the review, if the user needs to hide patient's personal information the function Anonymize is available 
in the Home tab of the Ribbon bar:  
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This function hides patient's name and surname from the title bar and from the Video review window: 

 

 
 

RIBBON BAR 

The upper part of BRAIN QUICK SOFTWARE window is devoted to the Ribbon menu containing the toolbars 
commands that allow access to all the functions. It is designed to help the user to quickly find the commands 
that he needs to complete a task. 

The Ribbon bar contains all the toolbars placed on several tabs, grouped by functionality to expose different 
sets of controls when needed.  

This menu uses tabs to expose different sets of controls, eliminating the need for many parallel toolbars. 

Contextual tabs are tabs that appear only when the user needs them. 

It could be minimized keeping only tabs titles displayed. 

The user has the possibility to use this bar in normal mode, in minimized mode and on auto-hide mode, that 
is a function that automatically hides entire Ribbon in order to work on the window in full screen. 

Commands are organized in logical groups, which are called together under the tabs. 

BRAIN QUICK Software allows the user to customize all tabs, groups and define which functions could be 
present in the different tabs and groups. This software could also allow the user to change tab and group 
name, to reset the selected tab or the entire Ribbon Bar to the default configuration. 
 
It contains by default the following tabs: 

• Home 
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• Montage 

• Navigation 

• Events 

• HFO 

• Sleep 

• Analyze 

• Reduction 

• Window 

• Help 
 

Home Tab 
 

 

  
Home tab contains command buttons and provides quick access to the functions needed most often during 
Video EEG. 

"Home" tab in Review window contains the following Groups and Functions: 

• "Montage Parameters" group: Montage selection, As recorded, Gain selection, Base time 
selection, Speed selection, Notch, Hp filter selection, Lp selection 

• "Reference" group: reference selection (G2, AVG, A1A2, SRC), AVG Setup, SRC Setup 

• "Tools" group: View Impedances, Zoom 

• "Groups" group shall: Collapse all, Expand all 

• "Cursor" group: Ruler, Standard, Advanced 

• "Video" group: Open/Close 

• "Events" group: Open panel, Lock/Unlock 

• "Standard" group: Open report, Copy EEG page to report, Take a screenshot, Screen video 
recording, Print Setup, Print, Anonymize 

 
"Home" tab in Acquisition window contains the following Groups and Functions: 

• "Montage Parameters" group: Montage selection, Gain selection, Base time selection, Notch, Hp 
filter selection, Lp selection 

• "Reference" group: reference selection (G2, AVG, A1A2, SRC), AVG Setup, SRC Setup 

• "Tools" group: Connect Setup, Start/Stop Acquisition, Pause, Save, Check Impedances, Enable 
Video, Setup Acquisition Tools, Control Panel, Photic Setup, Chrono Setup, Cortical Stimulation, 
Cortical Stimulation Setup; 

• "Groups" group: Collapse all, Expand all 

• "Video" group: Open/Close 

• "Events" group: Open panel, Lock/Unlock 

• "Standard" group: Open report, Anonymize 
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Montage Tab 
 

 

The Montage tab allows the Montage visualization and the Montage editing directly in the EEG review 
window or in Setup menu. 
From this tab it possible to change Eletrode Position and enable Duplicate & Lock View. 
 

Navigation Tab 
 

 

Navigation tab groups the navigation commands present also in timebar for the movements through the trace 
and in Video window for video play. 

The software allows several users to review the same EEG trace at the same time and all the users are listed 
in the Session list and presented as {machine name}/{user name} including the position of the given user. 

 

Events Tab 
 

 

Events tab contains commands to enable insertion of General events, like Notes, Digital Triggers, Annotations, 
Flags, and Selections, to enable insertion of Custom events defined from users and to enable Tools such as 
the External Event Calculation. 
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HFO Tab 
 

 

HFO tab allows insertion of HFO events, to change view settings enabling Duplicate&Lock function, to change 
HFO Events Visibility and gives the possibility to perform HFO Statistics and call External Calculation. 

 

Analyze tab 
 

 

In Analyze tab there are all the features to perform online and offline analysis on the recorded EEG: EEG 
Analyzer, Maps, Reaction Monitoring, and Persyst. All these features will be described in the following 
sections. 

Reduction Tab 
 

 

In Reduction tab it is possible to define a new Reduction Protocol, select one of the saved protocols to visualize 
on the open trace a Preview of the reduction that can be performed and to Run it to start the reduction.  

Window Tab 
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Window tab contains information about the Available Windows related to the open files (EEG exams) and 
clicking on the title of these windows the user can focus the selected window that will be visualized. The aim 
of this component is to select the window of interest to easily change visualization between different windows. 

This tab also allows the user to change multiple Windows layout with the dedicated icon. 
 

Help Tab 
 

 

Help tab provides information about the company and supports the user providing the possibility to quickly 
access to this online Help manual that includes a search functionality that the user can use to search for help 
in the BRAIN QUICK SOFTWARE documentation. 

APPLICATION BUTTON 

The BRAIN QUICK software window contains an application button at the top left. Clicking on that button 
opens a menu containing commands related to operations on the file (such as Open, Print, Export to ASCII or 
EDF+), information related to File Properties, and useful commands for changing the display of the exams. 
 

 
 
From Application Button it’s possible to open the properties window, where the user can personalize: 

• The Monitor Calibration; 

• The visualization preferences (derivation labels color and font, time and video cursor color, 
background color) 

• Screen Capture folder (the path where it’s possible to save screenshots and screen records) 

• System Preferences, in order to set the Notch Filter Frequency. 

QUICK ACCESS TOOLBAR 

It is a small, customizable toolbar that displays frequently used commands. Commands can be added to the 
Quick Access Toolbar from Ribbon bar by right-clicking on the command and choosing "Add to Quick Access 
Toolbar" 
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The Quick Access Toolbar default position is on top of BRAIN QUICK Software window next to the application 
button placed in the top left corner. By right-clicking each ribbon button the user is also able to minimize the 
ribbon bar and to move Quick Access Toolbar below or above the ribbon. 

RIBBON CUSTOMIZATION WINDOW 

It is possible to customize the Ribbon Bar for all associated tabs and groups through the Ribbon Customization 
window. To access it, it is necessary to right-click on the Ribbon Bar, so that the following menu appears: 

 

Choosing "Customize Ribbon," the following window opens: 

 

In this window it is possible to choose which tabs to activate or deactivate during acquisition or review, as well 
as add functionality for individual tab groups. Finally, by right-clicking on one of the tabs, it is possible to create 
a new group, rename the tab, remove it, or change its order. 
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In the end, it’s possible to export the customization performed or import an existing one, using 
“Import/Export” button in the window. 

 

TIME BAR 

Time Bar is an area placed under the EEG trace panel that represents information about the position of EEG 
page displayed in the trace and about the entire duration of the exam giving an overview on the presence of 
video files, notes, selections and other events. The time bar allows the user to quickly locate interesting parts 
of the recording. By taking advantage of this information, the user can more easily navigate the trace and can 
quickly locate the parts of greatest interest. 

The time bar of the BRAIN QUICK acquisition software indicates the length of the associated trace with 
indication for events added during acquisition. 
 
Brain Quick Review Software Time bar includes the following elements: 

• Date and Time of the beginning of EEG signal page in visualization. Each time the user moves 
along the trace these values are refreshed at once. 

• Timer from the beginning of the recording 

• Completed Visualization Interval area with vertical lines of division (parameters for time 
reference) 

• Complete EEG tracks area with vertical lines of division (parameters for time reference) 

• Page Cursor 

• Interval Cursor visualized as a horizontal line under the interval of visualization 

• Vertical lines for the representation of NOTE Events (default colour blue) 

• Vertical lines for the representation of TRIGGER Events (default colour green) 

• First horizontal line as indicator for the presence of VIDEO (default cinematograph film) 

• Second horizontal line for SELECTION event as indicator for VIDEO to archive (default  colour 
red) 

• Third horizontal line for SELECTION event as indicator for EEG to archive (default colour green) 

• Fourth horizontal line for SELECTION event as indicator for TIMER, like hyperpnea (default 
light blue) 

• Fifth horizontal line for SELECTION event as indicator for MAP to analyse (default colour 
orange) 

• Sixth horizontal lines for customizable EVENTS (defined by user) 

• Horizontal lines for HFO SELECTION (e.g. colour red) 
 
During the review, the Time Bar includes two slider: 

• Page Slider: allows the user to scroll the trace and represents the position of the EEG page 
displayed in the entire duration of EEG exam. 

• Interval Slider: represents the position of the Interval displayed in Time bar in the entire 
duration of EEG exam and allows the user to scroll through the recording 

 

 

In review, the Time Bar can manage a temporal interval including one or more traces, consecutive or not, 
previously selected and related to the same patient. In addition, it can work as a calendar with interval 
included between the start of the first EEG trace and the end of the “last” EEG trace.  
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In the end, it can include time period with no EEG trace appropriately highlighted with maximum duration 
of 23 hours and 59 minutes (less than 1 day with no EEG) between other traces in Multiple EEG visualization. 

The navigation bar, placed near the time bar, allows the user to manage all the temporal movements in the 
trace during the review. 

EEG SIGNAL WINDOW 

EEG trace panel contains: 
  

• Labels view of the selected channels according with the chosen montage. From EEG window it is 
possible to modify the view of all the channels displayed using the specific functions proposed in 
Montage tab of the Ribbon bar. Selecting one or more line labels and right-clicking on them, a line 
editor will be open in order to allow the user to quickly change parameters only of the selected lines 
like the color of the displayed trace or filter parameters 

 

 

It is possible to perform a multiple selection of labels with Shift+Click or Ctrl+Click. 

The presence of lines with different gains or filter settings will be indicated using a warning symbol near the 
label, in this way: 
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• Traces visualization of one EEG page. Traces are displayed according to their montage options and the 
number of EEG seconds that will be visualized can be changed from base time option in Ribbon bar. In 
EEG page also the events are displayed related to the position in which they were inserted with a 
vertical bar if the event is on all lines or using a selection on a line.  

VIEW CUSTOMIZATION 

BRAIN QUICK SOFTWARE allows the user to define size and position of all its windows and panels. BRAIN QUICK 
SOFTWARE's panels and windows can be moved by clicking on their title bar and then dragging them to the 
desired position. 

In order to modify height and width of panels and windows, point the mouse cursor on the panel's/window's 
edge and, when the cursor turns into a two-sided arrow, click and drag the panel's/window's edge until the 
desired dimension is reached. 

All BRAIN QUICK SOFTWARE's panels are dockable panels. A dockable panel is a layout panel that provides an 
easy docking in preset positions. When dragging one of the panels BRAIN QUICK SOFTWARE displays all the 
preset positions in which the panel can be docked. Just release the panel over a docking position and the panel 
will be docked in that location.  Panels can be docked on the left, right, top, bottom, or center of the window.  

 
BRAIN QUICK Software's panels can be also dragged to locations different from docking positions. In this case, 
the panel will remain floating. 

The windows placement defined by the user before the EEG window closure will be restored when the window 
is reopened keeping the last size and position set.  

Windows placement memorization depends on the number of windows opened and on the window's type 
(EEG or Report), so the system saves and restores the last size and position used with 1 EEG window, with 1 
Report window, with 2 EEG windows, with 1 EEG window + 1 report window, and so on. 

BRAIN QUICK Software makes sure the windows are placed exactly where the user wants them every time he 
opens them; moreover, windows and panels disposition can be associated to the user logged in the machine. 

DUPLICATE AND LOCK 

"Duplicate and Lock" function can be enabled from Montage Tab with a dedicated button. 
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Duplicate and Lock function automatically opens additional panels for EEG visualization. The panels are 
synchronized and allow the user to scroll the trace, play video, modify montage and visualization 
parameters, analyze the EEG and insert notes and events. The user can have different EEG visualizations in 
different panels: 
 

 
 
By default, montage is the same of primary window and can be modified. To change montage and modify 
lines parameters on a single panel, the user can either click on the panel or select it from Montage 
Parameters group in Home Tab. Once one panel is selected, the parameters border color changes according 
to the selected panel. Parameters will be highlighted in different colors depending on how many panels are 
open. 
 

 

Montage parameters in case of third panel selected (red) 
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Montage parameters in case of first panel selected (light blue) 

 
User can change montage parameters (Montage, Gain, Base Time, HP and LP filters) modifying them after 
panel selection. Show Montage function, available from Montage Tab, always displays montage related to 
first panel. 
The function allows to open up to 4 synchronized EEG panels at the same time. Panels are dockable, so the 
user is able to drag and drop them to the desired position, even using multiple monitors. 
To scroll through the EEG recording when Duplicate and Lock is enabled the user can use the buttons from 
Navigation tab of the Ribbon Bar, the buttons of the Navigation Bar or keys from the keyboard (see section 
Shortcuts). In case of Video EEG recording, video player buttons can also be used. 
 

 
  
If the user starts Autoscroll feature when Duplicate and Lock is enabled, all EEG panels will scroll the trace 
according to the selected speed, and the user can stop Autoscroll from one of all open panels. 
 
Duplicate and Lock function is available even during acquisition to visualize synchronized EEG acquisition in 
different panels, in case of high number of channels recorded, or in the case user needs to view the recording 
trace with different montages.  
The workflow to enable and use duplicate and lock function is identical. 

SIGNAL REFERENCE 

The following referencing algorithms can be applied to the signal: 
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• Average Reference (AVG): visualize data with the reference referring to the average of the signals 
recorded with all electrodes; 

• Bi-Auricular Reference (A1-A2): visualize data with the reference referring to the average of the two 
signals A1 and A2 recorded on the earlobes; 

• Source Reference (SRC): visualize data according to the parameters of the derived reference source 
(called Laplacian or Hjort derivations). 

In particular, the AVG and SRC references have settings, which can be selected from the Home Tab. 

 
AVG settings allows the user to choose which electrodes to include in the AVG calculation: 
 

 
 

SRC settings, on the other hand, sets the parameters of the derivation's reference source. Through the 
present matrix, the user can set the parameters of the reference, creating a new matrix, duplicate it, delete 
it or reset it. 
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EEG REVIEW 

BRAIN QUICK software can read EEG data recorded with SystemPLUS Evolution, with BRAIN QUICK software 
and with CNS Monitor. The software allows to review also the Video recorded during the exam. To do that, 
the user shall enable the Video window from the Ribbon bar and move through the recording using the Video 
window buttons or by dragging the video cursor. 
 
To access the EEG review window, the user must select a patient from the patient list in the Archive section 
and choose the exam from the exam list and follow the procedures below:  

• Click twice directly on the exam icon in the exam list column  

• Or click twice on the file icon (trace) in the file list column  

• Or click the right mouse button on the exam icon or file icon (respectively on the exam or file columns) 
and select the View function from the menu bar  

 
This way, the user enters the EEG review screen, which is very similar to the acquisition screen. The EEG review 
screen is the part of the program that is used to review and analyze EEG exams. In the review section, it is 
possible to review more than one trace at the same time and this allows the user to compare different exams 
of the same patient or of different patients.  
The EEG review screen is sub-divided into four main sections. On the top, there are the menu bar and the 
toolbars; in the center of the window, there is the display of traces; on the bottom, there is the status bar. 

 

NAVIGATION 

The navigation bar is placed under the EEG trace panel and allows all the temporal movements in the trace. 
From left to right: 

  
• BEGIN BUTTON: moves to the beginning of the trace 
• INTERVAL BACKWARD BUTTON: moves to the previous interval 
• EVENT BACKWARD BUTTON: moves to the previous event 
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• AUTO BACKWARD BUTTON: automatic scrolls backward 
• PAGE BACKWARD BUTTON: moves to the previous page 
• PLAY BUTTON: starts/stops video play 
• PAGE FORWARD BUTTON: moves to the next page 
• AUTO FORWARD BUTTON: automatic scrolls forward 
• EVENT FORWARD BUTTON: moves to the next event 
• INTERVAL FORWARD BUTTON: moves to the next interval 
• END BUTTON: moves to the end of the trace 

  

 
  
There are other movement functions that could be called from hotkeys (see Shortcuts topic) and not 
associated with buttons in the Navigation bar, like: 
  
• HALF PAGE BACKWARD: Shift + Left Arrow 
• HALF PAGE FORWARD: Shift + Right Arrow 
• ONE SECOND BACKWARD: Ctrl + Left Arrow 
• ONE SECOND FORWARD: Ctrl + Right Arrow 
• INCREASE SPEED AUTO SCROLL: * 
• DECREASE SPEED AUTO SCROLL: / 

VIDEO REVIEW 

Video window allows video review and enables video cursor at the same time. Video window can be 
opened/closed from Ribbon bar > Home tab: 
  

 
  
Video window provides an intuitive, easy-to-use interface to play Video files recorded during EEG 
acquisition: 
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The presence of Video files on a particular part of the EEG recording is underlined in the Time bar by a 
horizontal line with "cinematographic film" style: 
  

 
If the video line is present in the current EEG page it means that a video file can be opened and played. 
If the video line is not present the video window can be opened anyway, but no image will be displayed 
because in that part of the EEG the Video was not recorded. In this case a NO VIDEO warning will appear on 
the video window. 
  
Video window can be floating in the position of interest in the EEG window or can be docked to one of the 
preset positions in the EEG window (see sections “Dock Panel Layout” and “Windows Placement”). Video 
window can also be placed on a second screen. To move Video window, just click on its header and drag it 
to the desired position.  
The height and width of Video window can also be modified. To resize Video window just hover the mouse 
on one of its edges. When the cursor turns into a two-sided arrow, click and drag the window edge until the 
desired dimension is reached. 
  

Video Play 
 
After clicking on Open/Close Video button, the Video window opens and a Video cursor appears on the 
trace. Video Cursor is a red vertical bar having width 1 frame and indicates the exact point on the EEG page, 
which corresponds with the image displayed by the Video window.  
The user can manually move video cursor dragging it with the mouse for an accurate visualization of patient 
movements during particular EEG activities. 
Video window displays patient and recording date information on its header and contains also information 
about the date/time of the video in visualization, which are displayed in yellow on the bottom right of the 
Video window. 
  
Video window provide a set of buttons, placed under the video image, to: 

- PLAY/STOP the video 
- Move to PREVIOUS/NEXT FRAME 
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- Move to PREVIOUS/NEXT SECOND 
- Enable/disable VOLUME 
- Adjust the VOLUME 
- Restore DEFAULT VIDEO SPEED  
- Increase/decrease VIDEO SPEED 
- Toggle FULL SCREEN VIDEO  

NOTE: TOGGLE FULL SCREEN button is present only if Video window is floating. 
 

              
The user can also start/stop video play by using spacebar.  
The video image can be zoomed using left mouse click selection on the image area to be zoomed. Selecting 
another area with left mouse click, the zoom will increase. To de-zoom the video image, just double click on 
it with left mouse button. 
  

PRINT 

This function is placed in Home tab from EEG review window and allows the user to print one or more pages 
of the EEG trace during Exam review. The user can use indifferently the thermal printer (continuous module) 
or a standard printer single sheet (laser or ink-jet).  
The Print function uses printer settings from windows that can be set from Print Setup function. 

 
 

How to Print an EEG on Paper  
Print and Print setup functions allow the user to print the trace during the review of an EEG exam.  
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Print Setup: allows the user to set the parameters for the print and the printer: 
  
• Device: 

o Printer: a combo menu allows the user to select the printer to use. 
o Properties: allows to set up some print settings, such as Portrait/Landscape orientation. 
o Show Print Dialog?: enabling this option a dialog window will appear after clicking Print 

button (before the print process starts). If this option is disabled the print starts immediately 
after clicking on Print button. 

  
• Page:  

o Truncate Page if less than 50% full: if this option is enabled only pages more than 50% full 
will be printed. Pages less than 50% full will not be printed even if included in the paged to 
be printed. 

o Margins: the user can select a value for the page's Top, Bottom, Left, and Right margins. 
Margins values must be specified in cm. 

o Heading: 
➢  Size: None, Small, or Large 
➢ First Sheet Only: if this option is enabled an heading with the above specified size 

will be added only to the first page. If this option is disabled an heading with the 
above specified size will be added to all pages. 

o Reference Gain: From Montage. This means that reference gain is imported from the 
current montage applied. 

o Page Speed: it can be imported From Montage or it can be specified by the user. Page Speed 
value must be specified in cm/s. 

o Grid Style: No Grid, Main Only, Main With SubGrid 
  
• Selections: 

o Entire Trace: all the EEG recording will be printed 
o Current Page: only the currently visualized EEG page will be printed  
o From Annotations: the user can select an event from the list of available Selection events. 

The EEG included within the Selection will be printed. The user can specify EEG seconds to 
be printed before/after the event selected. 

o Seconds (from beginning): the user can specify EEG seconds to be printed. Seconds are 
calculated from the beginning of the EEG recording. 
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Once the printer setup is configured, the user can press the button Print in order to send the job to the 
selected printer. A prompt dialogue window will appear if this option has been set in the Printer setup, 
otherwise the print process will immediately start. 

EXPORT 

BRAIN QUICK SOFTWARE provides different kinds of export functions: 
• Export to Ascii 
• Export to Edf+ 
• Export Events 
• Export Analyzer Data 

All these functions are available in the menu, which opens by clicking on BRAIN QUICK Application button: 
  

 
  

Export to Ascii 
This function exports the acquired EEG signal data in a ASCII format file. To export data, follow this 
procedure: 
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1. From BRAIN QUICK Application button, select the function Export Ascii 
2. Select the EEG trace interval to export: Whole trace, Current page, or part of the trace defined by 

the user's selections 
3. Select which montage lines to export: All montage lines or some Selected lines 
4. Save As  
 

 
  

Export to Edf+ 
EDF formatted files make it easier to use Micromed EEG data for research purposes with external analysis 
applications. The EDF+ file format support can handle multiple segments using the same Amplifier inputs. 
The software can support events and sleep scores in multiple segmented EDF+ files. If the exam contains 
multiple montages (as in As Recorded), multiple EDF+ files are created. 
 
Multiple sleep scores cannot be exported, just the current sleep score. An extra channel is added to the EDF+ 
file, which is used to store the scores from 0 to 9. 
  

1. From BRAIN QUICK Application button, select the function Export Edf+ 
2. Select the EEG trace interval to export: Whole trace, Current page, or part of the trace defined by 

the user's selections 
3. Select which montage lines to export: All montage lines or some Selected lines 
4. Select resolution (16 or 24 bit) 
5. Select EEG Output Physical Range 
6. Save As 
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The same procedure can be applied to export the EEG trace in Edf+ starting from raw EEG data. To export 
raw data, the user has to select the function Export Edf+ from raw from the menu on the left. 
 
Note: 24-bit export is available only for trace acquired at 24 bits 

Export events 
This function exports the list of the events of the exam, according to the settings specified by the user: 
  

1. From BRAIN QUICK Application button select the function Export Events 
2. Select the EEG trace interval to export: Whole trace or Current page 
3. Select which types of events to export 
4. Select how to sort the events to export: Sort by begin time o Sort by type 
5. Select the document format: Text document or Excel document 
6. Save As 
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Export Analyzer data 
This function exports the numerical values obtained by analyzer calculations, according to the settings 
specified by the user: 
  

1. From BRAIN QUICK Application button select the function Export Analyser Data 
2. Select the EEG trace interval to export: Whole trace or Current page 
3. Select the document format: Text document or Excel document 
4. Save As 
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EEG ACQUISITION 

The acquisition window allows the user to record either an EEG or Video EEG exams. Acquisition is performed 
by technicians using an acquisition headbox that requires the configuration of certain parameters. The signal 
is displayed according to the criteria grouped in the Montage tab. 
The fundamental concept that must be kept in mind is the way in which the acquisition takes place. The 
headbox always works with a fixed sampling rate and has only minimal hardware filtering, this means that the 
signal is always saved referenced to G2 and with maximum bandwidth, being then displayed with desired 
leads, references and values of filters and amplification. 
Connect contains all parameters related to the hardware part, such as sampling rate, Maximum signal 
amplitude, number and type of channels acquired, and more. All parameters related to the display (leads, 
filters, Notch Filter, amplification, reference) are contained in the Montage section. These parameters can be 
changed or modified at any time.  
The EEG acquisition screen is divided into four main sections. At the top are the menu bar and toolbars; in the 
center of the window is the Trace Display; to the left side is the Channel Label; and finally at the bottom is the 
Status Bar. 
 

 

From the archive the user can open a new acquisition window, select or create a new protocol, start a New 
EEG using the default protocol, create a new report, data download from a device, Update the firmware of a 
device connected, Import an EDF or create a new report model, via the BrainQuick tab. 
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ACQUISITION PROTOCOL WINDOW 

By clicking on "Select Protocol" button from the Brain Quick tab, a window appears divided into three parts: 
the list of protocols created on the left, general protocol properties in the middle and connection properties 
on the right. 

 

The tab is divided by 14 buttons: 

 

• "Close": if the user is editing a protocol or creating one, this button allows to return to the initial protocol 
selection screen; 

• "New": allows the creation of a new protocol. 

• "Duplicate": allows duplication of an existing protocol. 

• "Save": allows saving changes to an existing or newly created protocol. 

• "Delete": allows deletion of the selected protocol. 

•  "Set as Favorite Protocol": allows to select a protocol as default, in order to start an acquisition from the 
BrainQuick Tab. 

• “Headbox Scan”: allows starting a new headbox discovery 

• “Camera Discovery”: allows starting a new camera research on the network 

• "Default labels": inserts the default labels corresponding to the associated headbox. 

• “Auto name”: allows to insert the labels and prefixes to a grid or a strip electrodes, depending on the rows 
and columns chosen.  
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• “Electrode position”: allows to open electrode position window (more information in its section). 

More details regarding the section of the acquisition protocol window are in the next paragraphs.  

• "Open EEG": once a protocol is selected, it allows to open a new acquisition window with the decided 
parameters. 

• "Apply and Run": allows to apply the changes made to the selected protocol and to run the acquisition. 

• "Save and Run": allows to save the changes made to the selected protocol and to run the acquisition. 

Headbox properties 
In this section it’s possible to choose the headbox from the available ones found by Brain Quick Software. 
There is a drop-down menu with all the available devices. On the side, there is the possibility to select the 
desired Jackbox and to enter the headbox IP if you are using an SD LTM 32/64 PLUS. 

 

Video properties 
In the video settings, one or two cameras can be associated with the protocol, so the user has the possibility 
to record Video EEG during acquisition. In order to view the available cameras, click on the "Camera List" and 
select the one desired. It’s possible finally to associate the chosen camera with Camera 1 or 2 by pressing the 
small arrow next to one at the corresponding box. If a camera is not available, it will be notified to the user 
through a warning. The cameras listed in the camera list are identified within the subnet specified in the 
Micromed Suite's “Camera Settings” section. For additional details, refer to the installation manual of Brain 
Quick Software 3.05. 
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BRAIN QUICK software also recognizes if the selected camera is a VISCA type, also ensuring association with 
the COM port from where PTZ movement of the camera can be controlled. 

User can remove cameras from protocol by choosing “No Camera” option from dropdown menu and by 
pressing the small arrow next to one at the corresponding box. 

Default programs 
In this section it’s possible to select default Photic Stimulation Programs and Analyzer Protocols that will be 
automatically loaded for acquisition. In the case displayed below the user will find “IPS Reduced Range” Photic 
Program enabled by default and analyzer not enabled by default. The user will be able to modify these 
programs in every moment during the acquisition. 

 

Quick channels selection 
In this section it’s possible to enable and disable special channels management, such as OXY, THOR, ABDO, DC 
It is even possible to enable and disable the Amplifier button management. 

 

Connect 
'Connect' means the setting of the input channels of the acquisition device (the 'headbox'). 

The 'connection' indicates which channels are active for acquisition and their settings, including: the sampling 
rate, the resolution (in bits) of the analog-to-digital conversion, and the quantization ADC window (in µV) for 
the EEG channels. 

 

In addition, it is possible to choose the channels to be enabled and personalize their label typing the desired 
name on “Label” section of the desired channel.  

The channels in the list are divided by type: EEG (Monopolar or Bipolar), marker, oxymeter, DC, Body_position, 
Thor, and Abdo. 
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In this list it is possible to select the channels to be included in the AVG reference. By flagging the checkbox of 
channel in the AVG column, the channel will be used to calculate the AVG reference. Only monopolar channels 
can be used for the calculation of the AVG reference. 

If an electrode in the acquisition protocol is currently mapped to a spatial position of the brain, the relative 
flag in the MAP column is checked. In order to remove the mapping for one or more electrodes, the user must 
open the Electrode Position window using the toolbar icon (more details in the Electrode Position section). 

Right clicking on a single channel or on a channel selection (created with Shift + Click or Ctrl + Click), it is 
possible to select among four options:  

 

• Auto Name opens Auto Name window and allows to rename labels starting from the selected 
electrode 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 152 of 267 

• Activate Selected activates the selected electrode or group of electrodes 

• Deactivate Selected deactivates the selected electrode or group of electrodes 

• Default Labels assigns the default labels from the first default standard configuration 

 

ACQUISITION WINDOW 

Once the protocol to be used has been created or chosen, the window for acquisition can be opened.  

In addition to the montages to use - functions present in both acquisition and review - the main buttons for 
managing acquisition are grouped in the "Tools" section of the Home Tab: 

 

Connect Setup button allows to open the protocol in order to modify it, while the Check Impedance, Run, Save 
and Pause buttons handle the checking impedance, starting, saving, pausing the acquisition, respectively. 
Finally, the Setup button opens a settings window for photic stimulation, chronometer and quick notes and 
the Control Panel button opens the Acquisition Status Panel, as we will see in the following sections. 

Note: The options present by opening the window with the setup button are also present by clicking on 
Application button > Properties. 

On the "Tools" section there are also buttons to enable photic stimulation, chronometer and cortical 
stimulation and cortical stimulation setup. Photic Stimulation allows to open photic stimulation panel to start 
a stimulation, Chronometer opens chronometer interface, while Cortical Stimulation opens cortical 
stimulation panel which allows to start a new stimulation. Cortical Stimulation Setup instead open setup for 
cortical stimulation. Detailed discussion of these features can be found in the following sections. 

 

In the end, it is possible to decide the trace length and the video recording length by clicking on Application 
Button > Preferences > Acquisition Saving Options: 
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From this window the user can enable messages exchange to Event Manager. The user can enable the use of 
a Local Event Manager or/and the communication to the File Manager Core Master. The user can decide 
whether to enable Amplifier Buttons message or analyzer threshold messages to be sent. In case of 
communication with the File Manager Core Master the required parameters are File Manager Core IP Address 
and Port. “Event Manager” section is available only in case EVENT MANAGER license is enabled in the 
acquisition machine. More details about Event Manager are described in Advanced Guide Installation Manual. 

CHECK IMPEDANCE 

From the "Check impedance” button, it is possible to view the value of the impedances of the headbox 
channels. Check Impedance can be enabled during acquisition even without pausing the recording: in this case, 
recording is automatically paused and impedances check is executed. 

This panel can be used to view impedance values during EEG acquisition and check cable connections and 
adjust impedances between electrodes and the patient's skin. The measured impedance values can be saved 
in the recorded EEG file and read back at any time during the acquisition.  

The Impedance Check panel offers two visualisation modes: 

• a table with the list of impedance values for all the active channels 

• a headbox image with channels colored in different way according to the impedance value 
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In the first visualization mode, the table shows the list of active channels with relative current impedance for 
both positive and negative inputs. For each input, then, a different color is associated according to the 
measured impedance: white if tending to 0 KΩ, green below 10 KΩ, orange between 10 and 20 KΩ, red if 
higher, as also shown in the figure. 

Note. Threshold limits considered in the impedance check can be customized; default values are 10 KΩ as 
warning threshold and 20 KΩ as overflow threshold. 

 

In the second visualization mode, the image of the headbox connected is shown and each input channel is 
colored in green, orange or red according to the related current impedance value; by hovering the mouse over 
a specific channel it is possible to see the exact impedance value measured. 

It is possible to switch among the two visualization by clicking the  button in the top right 
corner of the impedance check panel. 
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The impedance check is based on the threshold limits set in the software preferences; it is possible to set a 
warnig threshold limit and a overflow threshold limit by clicking the Brain Quick application button and 
selecting Preferences > EEG Preferences. 

 

All active input channels with a impedance value below the warning threshold will be highlighted in green, the 
ones with a impedance value between the warning and the overflow threshold will be colored in orange, the 
ones with a impedance value greater than the overflow threshold will be highlighted in red. 

STATUS CONTROL PANEL 

From the "Control Panel" button it is possible to open the status control panel, a window that allows the user 
to view the type of connection (whether wired or wireless) and the status (connected, recovering or no 
connection). Below is an example of a wired connection: 

 

The background will be green when the connection between the headbox and Brain Quick Software is present, 
yellow when data recovery is in progress showing residual delay, and red when it is absent. 

Finally, in the panel, there is the possibility to start the chronometer and photic stimulation procedures, 
described in the next paragraphs. 

CHRONOMETER 

During recording, the user has the option of measuring the duration of a specific event such as 
hyperventilation. Chronometer needs to be enabled from Ribbon Bar and started by clicking the proper button 
from the status control panel, where the chronometer controls are displayed. 
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The first button starts the chronometer, once started it also allows the pause function, which allows the user 
to stop the time count. The second button allows the user to reset the count to zero. Finally, the elapsed time 
is displayed in the center of the display in hh.mm.ss. 

From the "Setup" button on the Home Tab, the chronometer options tab can be accessed: 

 

From these settings it is possible to: 

• Enable a possible double chronometer; 

• Set a start and end note for the duration that the chronometer is running. Chronometer can be 
started and stopped using Quick Notes 

• Enable an event for the interval when the chronometer is running; 

• Enable note insertion during and post chronometer. 
 

PHOTIC STIMULATION 
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During the recording of the examination, the user can enable Photic Stimulation controls from Photic 
Stimulation button on Ribbon Bar and has the option of starting the photic stimulation by clicking the proper 
button from the status control panel, where the controls of the photic stimulator are displayed. 

 

Using a user defined program, the first button allows to start stimulation according to the selected program, 
while the second one allows to pause the ongoing program.  In case of Manual stimulation, the second button 
is a Single Photic Stimulation. The drop-down menu allows the user to select the program to be used. If 
"Manual" stimulation is chosen, stimulation is carried out with the frequency set in the box below.  

The photic stimulation setup can be opened from Setup Acquisition Tool button on Home Tab or from 
Acquisition Tools Options tab from application button preferences and contains two sections: Manual Settings 
and Program Settings. 

In the Manual Settings section, it’s possible to set a time limit for stimulation (hh:mm:ss), which allows to 
automatically stop manual stimulation after the time specified from the user. 

The Program Settings section allows to create, modify, and delete photic programs that contains an automatic 
sequence of stimulations. In each sequence of stimulation, it is possible to define the following parameters: 

• Frequency (Hz): sets the stimulation frequency. 

• Length (sec): sets the duration of the stimulation in seconds. 

• Pause (sec): sets the duration of the pause before the next stimulation. 

• Note: selects the note that will be entered at the beginning of the stimulation. 
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It is also possible to create, save changes and delete programs with the three icons at the side of the program 
drop-down menu. 

It is possible to access Photic Stimulation program even during the acquisition. 

CORTICAL STIMULATION 

During exam recording, the user has the option of starting cortical stimulation by clicking on Cortical 
Stimulation button from Home Tab. When the Cortical Stimulation button is pressed, Cortical Stimulation 
panel is displayed. This function is possible only with SD LTM 64/128/256 PLUS and SD LTM 64/128/256 
EXPRESS headboxes and only when the SD LTM STIM cortical stimulator is connected to the headbox. 
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From this interface, you can initiate, terminate stimulation, and execute an ictal disrupt using the buttons 
located at the top. The drop-down menu provides options to select the type of program.  

The Ictal Disrupt function repeats the last single stimulus, delivering a one-second stimulation at the chosen 
frequency. This means that if the stimulation was set to 1 Hz, then one stimulus is delivered, whereas if the 
sequence was at 50 Hz, one second of stimulation needs to be administered, equivalent to 50 pulses. 

Below this, there is information about the delivered intensity and messages generated by the software to 
update the user on the stimulation status. Additionally, if the Manual program is chosen, the Manual Sequence 
section allows you to select the contacts and the pulse sequence for stimulation. 

If an automatic program is set, the Automatic sequence section appears: 
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In this section the user can pause, execute manual trigger out and observe the status of the automatic 
stimulation, reading the previous, actual, next and after next stimulation type. Then, it’s possible to start from 
a particular stimulation and run selected sequence only. 

In the end, from the Setup Acquisition Tools the user can create, modify and save a new stimulation program 
from the Cortical Stimulation section, choosing to insert the automatic note. 

 

NOTE SETUP 

The "Setup" button allows the user to define some keyboard keys associated with the creation of notes 
added in the trace during acquisition. By default the following keys are present in the software, but both text 
and shortcut are editable and new quick notes can be added to the list.  
Quick Notes are case insensitive and cannot be added during pause. 
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TRIGGER SETUP 

BRAIN QUICK software allows to configure how triggers acquired during the recording are inserted; 
specifically, the user can choose between analog and digital type triggers by selecting the channel in which to 
place the markers, clicking to Application Button > Preferences > Trigger Setup: 
 

 
 

Analog Trigger: This function allows the user to choose the channel in which to place analog triggers from an 
external unit.  
In this section it’s possible to enable the Patient Button and personalize the text when the button is pressed. 
 
Digital Trigger: it allows the user to select the com port used to receive digital triggers from COM1, COM2, 
COM3, COM4.  
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MONTAGES AND EEG VISUALIZATION 

The Montage tab allows the Montage visualization and the Montage editing directly in the EEG window or 
in Setup menu. 
 

 
  

Clicking on Montage tab in Ribbon bar, the Setup icon allows the user to open the Montage Editor from 
which the user can setup all the Montages and other various parameters. 
  

 
  
Montage Editor panel is composed by: 
  

• Montage Editor Ribbon bar 

• The list of Montages on the left 

• The list of all available channels and their position on the brain on the right 

• Information about the selected montage 
  
Montages could be of different types: System (local montages), Archived (saved on EEG trace) and Shared 
(on server). The user can LOCK the montages in order to avoid that other users change them. If a montage 
is locked the padlock next to the montage name becomes red. In the EEG Review window it is also shown if 
the user selects a locked montage: 
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 How to configure a Montage? 

1. Select the montage of interest from the Montage column or create a new one using the apposite 
button Create New or duplicate an existing montage using Duplicate button 

2. Define the number of lines, the gain, the time base, the reference and the filter properties that will 
be applied to all the lines "Linked to Master" 

3. Fill in the information for each lines as follow: 
• Input + and Input -: the user can choose from the input list or type the input name or select 

the input of interest from the list of available channels. 
• Comment: the name that appears in front of the trace in EEG review window as label (the 

inputs name will appear in Line Editor). 
• Gain value: if a line is not linked to master, the user can choose a different gain. 
• Filter properties: if a line is not linked to master, the user can choose different filter 

properties. 
• Color: select a color for the trace. 
• Line Type: the user can choose to have the trace displayed numerically, as a trace, both at 

the same time or off. 
• Clipping 
• Line thickness 

4. Save changes 
5. The user can define different Groups of lines using Add Group button. Different groups will be 

displayed in EEG review window and there is the possibility to overlap the groups 
  

MONTAGE SETUP WINDOW 

The montage page setup is shown as below: 
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On the left part there is the list of the montages, which include two types: 

• Archived montages, which are stored with the EEG file 

• General montages, which are PC based (the montages can also be centralized over the network) 
 

Note. iIn the review stations the number of the montages will be UNLIMITED 
Note. Montages can be “locked,” this means write protected 
 
In the central part there is the Montage setup: the line on top is the “MASTER,” in which the user can setup 
the default Parameters. 
  

 
  
The montages can be created by clicking on the brain scheme on the right, or by clicking on the blue spots 
on the bottom right. 

NOTE: the button on the top left of the brain scheme ( ) will toggle the electrodes visualization on the 
brain scheme from big to small and vice versa. 
  

Groups 
 

 
  
Using "Add group" button it is possible to define a group of lines within the selected montage. When clicking 
on "Add group" button a window appears, in which the user can type a name for the group: 
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The user can also modify the group's name later on, by selecting the group and clicking on the button "Edit 
name.” 
The Move up and Move down buttons allow the user to change the group's position inside the montage. 
These buttons are enabled only when a group is selected. 
  
NOTE: Groups are useful in case of montages for SEEG; a group can be defined for each deep electrode used.  
  
If a montage with some groups is applied, in the EEG review window, it is possible to collapse or expand 
groups. This can be done using the + and - buttons near the EEG labels or using Collapse all and Expand all 
buttons from the Home tab of the Ribbon Bar: 
  

 
Below, there is an example with a group collapsed and a group expanded: 
  

 
  

Auto-Montage 
There is also the possibility to automatically create a montage, specifying the Starting electrode and the 
Number of lines. Clicking on the button Bipolar or Monopolar will respectively create a bipolar or a 
monopolar auto-montage, starting with the electrode specified and having the predefined number of lines. 
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MONTAGE VIEW 

The Montage View palette provides a quick view of the current montage, by clicking on Show Montage 
button in Ribbon bar > Montage tab 
  

 
   
The Montage View panel will be open with the name of the montage as title and it can be visible also in 
floating mode. The user can drag a corner of the window to increase Montage View panel size until the can 
view the positions on each channel on the brain: 
  

 
  
Hovering the mouse over an EEG line, the derivation corresponding to the trace will be highlighted in 
Montage View panel. 
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The montages can be changed during the acquisition, then, when reviewing, there will be the “as recorded” 
button, which will permit to review the traces with exactly the same parameters used during the acquisition. 
  

 
  
 On the other hand, if there are some changes during the acquisition \ review, these changes are kept also if 
the user is changing the montage and then going back to the same montage. The changes are active, but 
there is a button, which permits going back to the original. The changes are temporary only (for the patient 
reviewed), if the user what to save them, has to “save montage.” 
 

ZOOM 

Another way to visualize only some of the montage channels is to activate Zoom modality: 

 

 In Zoom modality The software gives the possibility to select how many channels visualize, then with the 

mouse wheel focus on the vertical scroll bar on the right of the EEG page, it will be possible to scroll the EEG 

up and down. While scrolling, the channels not visualized will be shown on the top and on the bottom of the 

window, superimposed. The picture below shows an example of zoom in an EEG recording: 

 
On the right part of the window, it is possible to select the number of zoomed traces to visualize (in this case 
20), while the bottom vertical bar allows to scroll the traces. Zoom is disabled in case Duplicate & Lock 
function is enabled. 
 

ELECTRODE POSITION 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 168 of 267 

The user can move one or more electrodes from their default position on the real patient's head coordinates 
deliberately:  

- from the acquisition protocol window, pressing Electrode Position button in the tab; 

 

- from Montage Tab, pressing Electrode Position button: 

 

Using this function, it is possible to update the electrode position manually memorized in the trace in order to 
reflect this change on the analysis maps and analysis tools. 

Electrode Position window allows to visualize brain image together with the list of recorded electrodes and 
their coordinates: 

 

 

The screen is divided in three sections: the Electrode Position Ribbon Bar on top, the list of electrodes on the 
left and the head on the right. 

The Electrode Position Ribbon Bar allows to activate and deactivate all or the selected electrodes, to add grid 
/ strip on brain image and to show coordinates grid, to load a brain image and to define or recall an electrode 
position configuration. Buttons available in Ribbon Bar are: 

1. Close: this button allows to close Electrode Position window 

2. Save: allows to save all changes in Electrode Position window 
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3. Activate All: allows to activate all electrodes available in the list 

4. Deactivate All: allows to deactivate all electrodes available in the list 

5. Activate Selected: allows to activate all electrodes selected by the user in the list 

6. Deactivate Selected: allows to deactivate all electrodes selected by the user in the list 

7. Reset All Inactive: allows to reset position of all electrodes to default central position (Latitude and 
Longitude equals to 0.0°) 

8. Load From File: this button allows to load a new image to be loaded instead of the default one  

9. Show Coordinates Grid: allows whether to display or not grid with coordinates in degrees 

10. Reset to Standard Brain: allows to reset the image to the standard one 

 

Grid group in Ribbon Bar allows to group electrodes into grids to be added to the existing image, depending 
on how many electrodes are deactivated from electrodes list: 

1. Rows: defines the number of rows of the grid 

2. Columns: defines the number of columns of the grid 

3. Start From: defines the starting electrode 

4. Displacement: can be either horizontal or vertical 

5. Colour: defines the electrodes colour  

6. Preview: shows a grid preview 

7. Apply: adds the defined grid to the image 

 

 

 

Configurations group in Ribbon Bar allows to define and save electrode position configurations as standard 
electrodes placement: 

1. Configuration: allows to select one from the available configurations. By default, only the IFCN 
Standard and Saved in Trace configurations are available 
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2. Save As New: allows to save the user defined electrodes position in a new configuration 

3. Save Configuration: allows to modify and save the selected configuration  

4. Delete: allows to delete the selected configuration 

 

Note: IFCN Standard is the default configuration, which cannot be modified or deleted. User can only save the 
changes made on IFCN standard in a new configuration. New configurations are stored in the machine, hence 
at Unit level. 

 

When the user works on Saved in Trace configuration, the modifications are directly saved in the EEG file. 

 

The list of electrodes is composed of four columns called: Label, Active, Latitude and Longitude.  

1. Label: indicates the electrode name. The EEG channels here visible are selected in the "Modify 
Connection" window, in acquisition, recallable only in the acquisition phase of EEG traces.  

2. Active: indicates if the electrode is enabled or not. The user can activate the electrodes by clicking the 
left mouse button on the corresponding checkbox, making a symbol appear.  Repressing the left 
mouse button, the symbol disappears and the electrode is disabled. 

3. Latitude: indicates the latitude of the electrode and can be modified by the user. Click the left mouse 
button on the interested electrode cell and type the new value or selecting the electrode visualized in 
the brain image and dragging it in the desired position.  

4. Longitude: indicates the longitude of the electrode and can be modified by the user. Click the left 
mouse button on the interested electrode cell and type the new value or selecting the electrode 
visualized in the brain image and dragging it in the desired position.  

The head contains the head image that can be loaded by user and it is represented with circles that 
represent the active electrodes. These circles can be moved inside the red circle dragging them with the 
mouse; in the latitude and longitude columns the values change automatically. The name of the electrode 
appears when the user moves the mouse over each circle. 

  

EVENTS 

BRAIN QUICK software allows the user to insert notes to distinguish events during review and acquisition.  

EVENTS DESCRIPTION 

During the exam, the user has the possibility to insert events to distinguish particular situations during the 
recorded trace. There are three main events insertion modalities, which are described in the following: 
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Direct Notes Insertion 

Direct notes insertion on the EEG page can be done with right mouse click on the part of the trace of interest: 
a text box appears if “note” is selected and the user can type the note text. Pressing Enter from the keyboard 
the note will be inserted in the EEG trace. 
 

 
 
Notes can be inserted directly typing the note from the keyboard and pressing Enter, in this case the note 
will be inserted in the middle of the EEG page. 
To avoid accidental events insertion, the events insertion can be locked using the Lock/Unlock button (which 
is present in the Home tab, in the Events tab and in the HFO tab of the Ribbon bar) shows a locked padlock: 

 
Continuous Event Insertion (from the Ribbon bar) 

The user can choose the type of event of interest from the Events tab of the Ribbon bar: 

 
  
Events can be of different types: 
• General events: such as Notes, Annotations, Digital triggers and Selections 
• Observation events: such as Eyes open, Eyes closed, Hyperventilation, Movement and Stimuli events 
• Custom events: defined by the user  

  
After clicking on a event the system enters continuous  event insertion modality. This modality is indicated 
on the bottom right of the EEG window, with a flashing red warning. For example, if the user chooses "Video 
selection" event the warning" Inserting Video Selection" will appear: 
  

 
  
Then the user has to click or click and drag on the EEG trace to insert the selected event. While event 
insertion modality is active the user can insert as many events as he wants (of the selected type). 
Continuous event insertion modality remains active until the user clicks again on the event button on the 
Ribbon bar or clicks on the Lock/Unlock button or presses Esc key from the keyboard. 
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Single Event Insertion (from drop down menu) 

If events insertion is unlocked there is the possibility to insert all kinds of events in the EEG trace. The user 
has to right-click on the EEG page in order to open the following drop down menu: 
  

 
Then the user has to select the event of interest from the menu.  
  
After clicking on a event, the system enters single event insertion modality. This modality is indicated on the 
bottom right of the EEG window, with a flashing red warning. For example, if the user chooses "Video 
selection" event the warning" Inserting Video Selection" will appear: 
  

 
  
Then the user has to confirm event insertion or click and drag on the EEG trace (in case of selection events) 
to insert the selected event. Single event insertion modality remains active until the user inserts the selected 
event or clicks on the Lock/Unlock button or presses Esc key from the keyboard. 
 
Once the event has been inserted single event insertion modality is automatically disabled. The event will 
be inserted in the exact point of the EEG on which the user clicked in order to open the drop down menu. 
   

Automatic “Reviewed By” Event Insertion 

It is possible to enable the automatic insertion of the event “Reviewed by <user>” (where <user> is the name 
of the user logged in the software) to automatically mark the part of the trace already reviewed by the user 
during page scroll. 
This option can be enabled from Application button > Preferences > Preferences > Visualization Preferences 
> Review Progress > “Automatically insert the “Reviewed by <user>” event during review. 
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The Review Progress Bar will be visible in the EEG page and as event in Event Panel together with the duration 
of the event.  
The user can remove this event from Event Panel or right clicking and pressing Delete from the Event but it 
cannot be moved or manually added. 
From Event Setup each user has the possibility to change font, color and text color of Review Progress bar 
event. 
 

Move an Event 
The user can move an event after its insertion. In order to move an event, follow these steps: 

1. Click on the event and hold down the mouse button 
2. Drag the event to the desired location and release the mouse button. 

  

Edit an Event 
The user can edit an event after its insertion. To rename an event follow these steps: 

1.  Right-click on the event you want to rename 
2.  Edit the event's name typing the new name in textbox 

  

 

Delete an Event 
The user can delete an event in two different ways: 

1. Right-click on the event 
2. Click Delete 
3. The event will be immediately deleted (no confirmation message will appear) 
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or 

1. Open Events Panel using "Open Panel" button 
2.  Select the event to be deleted 
3. Right-click on the event and click Delete (or press Canc button on the keyboard) 
4. A confirmation message will appear. The user can choose to proceed or to cancel the operation 

  

 

NOTES 

During the exam review, the user has the possibility to insert notes to distinguish particular events. Notes 
are displayed as vertical blue lines in the EEG page and in the Time bar: 
 

 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 175 of 267 

  

Insert Notes 
Notes can be inserted in three different ways: 

Direct Notes Insertion 

Brain Quick Software allows Direct Notes Insertion 

1. Right-click on the point of the EEG trace in which you want to insert the note 
2. Select "Note" 
3. A textbox appears 
4. Type the note text 
5. Press Enter from the keyboard to confirm the note insertion 

or  

1. Directly type from keyboard  
2. A textbox appears 
3. Type the note text 
4. Press Enter from the keyboard to confirm the note insertion 
5. The note will be inserted in the middle of the EEG trace page 

or (in acquisition) 
1. Use one of the keyboard keys defined in Note Setup 
2. The note associated to the keyboard key in Note Setup will be inserted in the middle of the 

EEG trace page 

 
  

Notes Insertion from the Ribbon Bar 

1. Unlock events insertion clicking on Lock/Unlock button 
2. Click on "Note" button on the Events tab of the Ribbon bar 

  

 
  

3. The warning "Inserting Note" appears on the bottom right of the EEG window 
4. Click on the point of the EEG trace in which you want to insert the note 
5. A textbox appears 
6. Type the note text 
7. Press Enter from the keyboard to confirm the note insertion 
8. When finished, click again on "Note" button or click on "Lock/Unlock" button or press Esc key from 

the keyboard to disable notes insertion modality 
  

Notes Insertion from Drop Down Menu 

1. Unlock events insertion clicking on Lock/Unlock button 
2. Right-click on the point of the EEG trace in which you want to insert the note 
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3. A drop down menu appears 
  

 
4. Select "Note" from the drop down menu 
5. A textbox appears 
6. Type the note text 
7. Press Enter from the keyboard to confirm the note insertion 

  

Move a Note 
The user can move a note after its insertion. In order to move a note, follow these steps: 

1. Click on the note and hold down the mouse button 
2. Drag the note to the desired location and release the mouse button. 

  

Edit a Note 
The user can edit a note after its insertion. To rename a note follow these steps: 

1.  Right-click on the note you want to rename 
2.  Edit the note's name typing the new name in the text box 
3. Press Enter from the keyboard to confirm the note's modification 

 

Delete a Note 
The user can delete a note in two different ways: 

1. Right-click on the note 
2. Click Delete 
3. The note will be immediately deleted (no confirmation message will appear) 

  

 
  
or 
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1. Open Events Panel using "Open Panel" button 
2.  Select the note to be deleted 
3. Right-click on the note and click Delete (or press Canc button on the keyboard) 
4. A confirmation message will appear. The user can choose to proceed or to cancel the operation 

  

 
  

SELECTIONS 

During the exam review the user has the possibility to mark a piece of trace by using a selection event. 
Selections are displayed as horizontal lines in the EEG page and in the time bar: 
  

 
  
 In particular: 
•  Video Selections are displayed as red horizontal lines and are used to mark interesting pieces of 

video 
• Hyperventilation Selections are displayed as light blue horizontal lines and are used to mark or 

measure the time duration of a particular event as hyperventilation 
• EEG Selections are displayed as green horizontal lines are used to mark interesting pieces of EEG 
• MAP Selections are displayed as orange horizontal lines and are used to mark pieces of EEG trace 

that can be analyzed 
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• Photic Selections are displayed as purple horizontal lines and are used to mark or measure the time 
duration of a particular event as photic stimulation 

Video and EEG selections can be used also during Video EEG files reduction (see section EEG Reduction). 
 

Insert Selections 
Selections can be inserted in two different ways: 
  

Selections Insertion from the Ribbon Bar 

1. Unlock events insertion clicking on Lock/Unlock button 
2. Click on one of the selection buttons on the Events tab of the Ribbon bar, for example "Video 

selection" 
  

 
  

3. The warning "Inserting Video selection" appears on the bottom right of the EEG window 
4. Click on the point of the EEG trace in which you want to insert the selection and drag the selection 

until the desired end point 
5. Release the mouse button to confirm selection's insertion 
6. When finished, click again on "Video selection" button or click on "Lock/Unlock" button or press Esc 

key from the keyboard to disable Video selection insertion modality 
  

Selections Insertion from Drop Down Menu 

1. Unlock events insertion clicking on Lock/Unlock button 
2. Right mouse click on the EEG trace 
3. A drop down menu appears 

  

 
  

4. Click on one of the selections buttons from the drop down menu, for example "Video selection" 
5. Click on the point of the EEG trace in which you want to insert the selection and drag the selection 

until the desired end point 
6. Release the mouse button to confirm selection's insertion 
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Move a Selection 
The user can move a selection after its insertion. In order to move a selection, follow these steps: 

1. Click on the selection and hold down the mouse button 
2. Drag the selection to the desired location and release the mouse button. 

  

Resize a Selection 
The user can modify a selection's duration after its insertion. To resize a selection follow these steps: 

1.  Click on the start point (or on the end point) of the selection 
2.  Drag the start point (or the end point) of the selection to the desired location and release the 

mouse button. 
  

Delete a Selection 
The user can delete a selection in two different ways: 

1. Right-click on the selection 
2. Click Delete 
3. The selection will be immediately deleted (no confirmation message will appear) 

  

 
or 

1. Open Events Panel using "Open Panel" button 
2.  Select the selection to be deleted 
3. Right-click on the selection and click Delete (or press Canc button on the keyboard) 
4. A confirmation message will appear. The user can choose to proceed or to cancel the operatio 
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ANNOTATIONS 

During the exam review the user has the possibility to mark a piece of trace by using an annotation event. 
Annotations are not-formatted text multi-line notes that can be inserted on the EEG trace. 
  

Insert Annotations 
Annotations can be inserted in two different ways: 
  

Annotations Insertion from the Ribbon Bar 

1. Unlock events insertion clicking on Lock/Unlock button 
2. Click on "Annotation" button on the Events tab of the Ribbon bar 

  

 
  

3. The warning "Inserting Annotation" appears on the bottom right of the EEG window 
4. Click on the point of the EEG trace in which you want to insert the annotation 
5. Write the annotation content into Insert annotation window 

  

 
6. Click OK to confirm annotation's insertion 
7. When finished, click again on "Annotation" button, or click on "Lock/Unlock" button, or press Esc key 

on the keyboard to disable annotation insertion modality 
  
  

Annotation Insertion from Drop Down Menu 

1. Unlock events insertion clicking on Lock/Unlock button 
2. Right-click on the EEG trace 
3. A drop down menu appears 
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4. Select "Annotation" from the drop down menu 
5. Click on the point of the EEG trace in which you want to insert the annotation 
6. Write the annotation content into Insert annotation window 

  

 
  

7. Click OK to confirm annotation's insertion 
  

Collapse or Expand an Annotation 
Annotations can be displayed on the EEG page in collapsed or expanded mode: 
  

 
To toggle from collapsed to expanded visualization mode right-click on a collapsed annotation icon and select 
Expand. All annotations will be displayed in expanded mode: 
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To toggle from expanded to collapsed visualization mode right-click on an expanded annotation icon and 
select Collapse. All annotations will be displayed in collapsed mode: 
  

 

Move an Annotation 
The user can move an annotation after its insertion. In order to move an annotation follow these steps: 

1. Click on the annotation and hold down the mouse button 
2. Drag the annotation to the desired location and release the mouse button. 

  

Edit an Annotation 
The user can edit an annotation's text after its insertion. To edit an annotation follow these steps: 

1. Right-click on the annotation you want to edit 
2. Select Edit 

 
3. Edit the annotation's text from Modify annotation window 
4. Click OK to confirm annotation's modification 

 

Delete an Annotation 
The user can delete an annotation in two different ways: 

1. Right-click on the annotation 
2. Click Delete 
3. The annotation will be immediately deleted (no confirmation message will appear) 
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or 

1. Open Events Panel using "Open Panel" button 
2.  Select the annotation to be deleted 
3. Right-click on the annotation and click Delete (or press Canc button on the keyboard) 
4. A confirmation message will appear. The user can choose to proceed or to cancel the operation 

  

 
 

DIGITAL TRIGGERS 

Triggers are synchronizing events introduced on the recorded EEG either during acquisition or during review. 
Digital triggers are composed of a numeric value that is stored within the trace and adds information to the 
trigger itself: in fact a numeric value can inform on which kind of event has generated the trigger. By 
default, digital triggers are displayed as vertical green lines in the EEG page and in the Time bar: 
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Insert Digital Triggers 
Digital triggers can be inserted in two different ways: 
  

Digital Triggers Insertion from the Ribbon Bar 

1. Unlock events insertion by clicking on Lock/Unlock button 
2. Click on "Digital trigger" button on the Events tab of the ribbon bar 
3. The warning "Inserting Digital trigger" appears on the bottom right of the EEG window 
4. Click on the point of the EEG trace in which you want to insert the digital trigger 
5. A text box appears 
6. Type the digital trigger value 
7. Press Enter from the keyboard to confirm the digital trigger insertion 
8. When finished, click again on "Digital trigger" button or click on "Lock/Unlock" button or press Esc 

key from the keyboard to disable digital trigger insertion modality 
  

Digital Triggers Insertion from Drop Down Menu 

1. Unlock events insertion by clicking on Lock/Unlock button 
2. Right mouse click on the point of the EEG trace  in which you want to insert the digital trigger 
3. A drop down menu appears 
4. Select Digital trigger" from the drop down menu 
5. A text box appears 
6. Type the digital trigger value 
7. Press Enter from the keyboard to confirm the digital trigger insertion 

  

Move a Digital Trigger 
The user can move a digital trigger after its insertion. In order to move a digital trigger follow these steps: 

1. Click on the digital trigger and hold down the mouse button 
2. Drag the digital trigger to the desired location and release the mouse button. 

  

Edit a Digital Trigger 
The user can edit a digital trigger after its insertion. To edit a digital trigger follow these steps: 
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1.  Right-click on the digital trigger you want to edit 
2.  Edit the digital trigger's value typing the new value in the text box 
3. Press Enter from the keyboard to confirm the digital trigger's modification 

 

Delete a Digital Trigger 
The user can delete a digital trigger in two different ways: 

1. Right-click on the digital trigger 
2. Click Delete 
3. The digital trigger will be immediately deleted (no confirmation message will appear) 

 
or 

1. Open Events Panel using "Open Panel" button 
2.  Select the digital trigger to be deleted 
3. Right-click on the digital trigger and click Delete (or press Canc button on the keyboard) 
4. A confirmation message will appear. The user can choose to proceed or to cancel the operation 

 

 

HFO EVENTS 

HFO software module has been developed in order to allow the user to analyze scalp and intracranial HFOs 
as candidate to represent a valuable biomarker for the localization of the Seizure Onset Zone (SOZ). 
During the exam review the user has the possibility to insert manually HFO events on the EEG trace or to 
perform an automatic HFO detection (see section External Calculation). In both cases HFO events are 
displayed as horizontal selections in the EEG page and in the Time bar. Over each HFO event its duration (in 
milliseconds) is displayed: 
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 In particular: 
• HFO ripple are displayed as red selections 
• HFO fast ripple are displayed as green selections 
• HFO gamma are displayed as light blue selections 
• HFO spike are displayed as violet selections 

  

Insert HFO Events 
HFO events can be inserted in two different ways: 

HFO Events Insertion from the Ribbon Bar 

1. Unlock events insertion by clicking on Lock/Unlock button 
2. Click on one of HFO events buttons on the Events tab of the Ribbon bar, for example "HFO ripple" 

  

 
  

3. The warning "Inserting HFO ripple" appears on the bottom right of the EEG window 
4. Click on the start point of the pattern of interest and drag the HFO event until the desired end point 
5. Release the mouse button to confirm HFO event's insertion 
6. When finished, click again on "HFO ripple" button, or click on "Lock/Unlock" button, or press Esc key 

from the keyboard to disable HFO ripple insertion modality 
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HFO Events Insertion from Drop Down Menu 

1. Unlock events insertion by clicking on Lock/Unlock button 
2. Right-click on the EEG trace 
3. A drop down menu appears 

  

 
4. Click on "HFO" and then select one of the HFO events buttons, for example "HFO ripple" 
5. Click on the start point of the pattern of interest and drag the HFO event until the desired end point 
6. Release the mouse button to confirm HFO event's insertion 

  
NOTE: Duplicate and Lock feature can be really useful during HFO insertion process, in fact it allows the user 
to visualize the same EEG trace with different filters and different time bases (see section Duplicate and 
Lock): 

 
  
NOTE: In order to better identify HFOs there is the possibility to set a “FIR” filters type from Montage Setup 
(see section Montage Editor). 
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Below 2 figures are reported in order to show the same part of an EEG trace filtered at [80-250 Hz] for RIPPLE 
visualization using a FIR filter in the first figure and an IIR filter in the second figure. As you can see the correct 
HFO visualization is available only selecting FIR filter type: 
  

 
Figure: FIR Filter between [80-250Hz] 

  

 
Figure: IIR Filter between [80-250Hz] 

  

Move a HFO Event 
The user can move a HFO event after its insertion. In order to move a HFO event follow these steps: 

1. Click on the HFO event and hold down the mouse button 
2. Drag the HFO event to the desired location and release the mouse button. 
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Resize a HFO Event 
The user can modify a HFO event's duration after its insertion. To resize a HFO event, follow these steps: 

1.  Click on the start point (or on the end point) of the HFO event 
2.  Drag the start point (or the end point) of the HFO event to the desired location and release the 

mouse button. 
  

Delete a HFO event 
The user can delete a HFO event in two different ways: 

1. Right-click on the HFO event 
2. Click Delete 
3. The HFO event will be immediately deleted (no confirmation message will appear) 

  

 
or 

1. Open Events Panel using "Open Panel" button 
2.  Select the HFO event to be deleted 
3. Right-click on the HFO event and click Delete (or press Canc button on the keyboard) 
4. A confirmation message will appear. The user can choose to proceed or to cancel the operation 

HFO Events Visibility 
There is the possibility to enable / disable HFO events visibility for each EEG window to allow the user to 
visualize only the events of interest. 

 

HFO Statistics 
There is the possibility to perform analysis on the number of HFO with or without SPIKES in the different 
channels in order to underline the channels with the major number of high frequency events that are 
candidate to represent the Seizure Onset Zone. This can be done using the HFO statistics functions in the 
HFO tab of the Ribbon bar: 

  

Statistic setup button will open the HFO Statistic Setup window, from which the user can select the statistic 
calculations to be performed: 
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The HFO statistics calculation window will open by pressing the button Process. From this window, the user 
can define settings such as the montage lines on which the statistic calculation will be applied and the 
selection of EEG trace involved. There's also the possibility to analyze only the HFO events created by a 
defined user. Pressing the button OK the calculation will start. An excel file will be created in the destination 
folder, containing all the values selected in the HFO Statistics setup menu. 
  

 
   

CUSTOM EVENTS 

In Ribbon Bar > Events tab there is the possibility to define custom events, in order to let the user create a 
new event type choosing its graphical and insertion properties.  
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Clicking on Events setup button a window will be opened, from which the user can visualize the default 
events grouped by category: 
  

 
  

Events properties 

An event is defined by the following properties: 
  

• Quick List: defines if the events are available from insertion with right click on the trace  
 

• Description: name of the Event that will be visualized in the Event tab 
 

• General Properties 
o Reference: could assume the following values: 

SingleLine: if the event will be associated to a single line (e.g. HFO event) 
AllLines: if the event will be associated to all the lines (e.g. Red Selection) 

 
o Duration: could assume the following values: 

ZeroDuration: if the event is related to a fixed moment and not with a duration in 
timing (e.g. Note event). 
Interval: if the event is related to an interval (e.g. Selection or HFO Events). 

 
o Visualization: could assume the following values: 

Text: if the events will be visualized with a text. 
Graphic: if the events will be marked with a graphic selection or line (if it is defined 
with ZeroDuration). 
Text And Graphic: both the previous. 
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• Text Properties 
o Type: could assume the following values: 

Alphanumeric 
Numeric 
Rtf: if the text related to the event is an annotation (a document rtf attached to the 
event). 
From Description: if the text displayed with the event is the Description of the Event. 

o Color: the user can define the text color. 
o Font: the user can define the text font. 
o Size: the user can define the text size. 
o Bold: the user can enable Bold if the text should be displayed in bold font. 
o Italic: the user can enable Italic if the text should be displayed with Italic font. 

 

• Graphic Properties  
o Type: the user can define the graphical visualization of the event and could assume the 

following values: 
Fill Rectangle 
Empty Rectangle 
Underline 
Vertical Line 
Image 

o Color: the user can define the graphic color. 
  

• User Interface and Permission: 
o Mouse: could assume the following values: 

One Click: if the event will be added to the trace using a single click (e.g. Note events). 
Click And Drag: if the user has to click and drag the event in order to place it in the position of 
interest with the duration of interest (e.g. HFO events). 
Two Clicks: if the event will be added to the trace using one click to start and one click to end 
the event insertion (e.g. Red Selection). 

o 1-Click Interval: the duration of the event could be fixed adding the event with a single click 
and the user can define the duration of this interval in seconds. 

o Insert: allows to define the possibility to add an event or not. 
o Delete: allows to define the possibility to delete an event or not. 
o Update Text: allows to define the possibility to modify event's text or not. 
o Update Position: allows to define the possibility to modify event's position or not. 

  
Add new events category and subcategory 

From Event setup window the user can edit existing events definitions but also create new events, events 
categories and subcategories, using the buttons available on the Event setup toolbar: 

 
  
The buttons Add category and Add subcategory open a window in which the user can define the new 
category and subcategory name and the event type to insert in the subcategory created: 
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The user can choose to insert by default an event with type All-line zero-duration, All-line interval, Single-
line zero-duration, or Single-line interval. 
NOTE: an event category cannot be empty. The creation of a new category always implies the creation of a 
new sub-category and of an event. 
NOTE: an event subcategory cannot be empty. The creation of a new subcategory always implies the creation 
of an event. 
 

Add new events 

 The four buttons on the Events group of the toolbar allow the user to define new events: 

• Add "all line instant": adds a zero-duration event which will be present in all the EEG lines. 
• Add "all line interval": adds an interval event which will be present in all the EEG lines. 
• Add "single line instant": adds a zero-duration event, which will be present in the selected EEG line 

only. 
• Add "single line interval": adds an interval event, which will be present in the selected EEG line only. 

  
New events can be customized according to the table below: 
 

Event Type Text Text and Graphic Graphic Graphic Type 

All Lines Instant 
- Alphanumeric 
- Numeric 
- From description 

- Alphanumeric 
- Numeric 
- From description 
- Memo 

YES 

- Vertical line 
- Icon (available only if 
Text and graphic with type 
"Memo" is selected) 

All Lines Interval NO From description YES 
- Filled rectangle 
- Empty rectangle 
- Underline 

Single Line 
Instant 

- Alphanumeric 
- Numeric 
- From description 

- Alphanumeric 
- Numeric 
- From description 

YES - Vertical line 

Single Line 
Interval 

NO - From description YES 
- Filled rectangle 
- Empty rectangle 
- Underline 

NOTE: Reference and Duration fields of already defined events cannot be modified. To change the event's 
Reference and Duration properties it is necessary to change event's type. The user has to delete the 
undesired event and to add a new one having the desired type. 
  



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 194 of 267 

The custom events defined by the user will be visualized in the Ribbon bar > Events tab > Custom: 
  

 
  

Rename Selected and Delete Selected 

 The function Rename Selected allows the user to rename the selected category or subcategory. This function 
is enabled only if a category or a subcategory is selected. 

NOTE: This function is not available to rename events. To rename an event just click on its name and type 
the new name, then save the changes. 
  
The function Delete Selected allows the user to delete the selected item, which can be an event, a category, 
or a subcategory. A confirmation message will appear. 
  
NOTE: Default events categories (General, HFO, Respiration, and Scoring) and their subcategories and events 
cannot be renamed nor deleted. 
  

EXTERNAL CALCULATION 

From BRAIN QUICK review window there is the possibility to run external calculation programs. In the Events 
tab of the ribbon bar you can find the button External calculation:  

 

Pressing External calculation button the following window will open: 
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From the External Calculation window it is possible to select the plugin to be used for the calculations, 
choosing from a list of available plugins. The user can also define the montage lines and the trace interval 
on which the calculations will be performed. 
 
Pressing the button Start the calculation will be launched, using the algorithm and the parameters defined 
by the user. 
 
At the end of the external calculation results will be automatically imported and displayed. 
  
NOTE: a progress bar will show the progress f the external calculation. At the end of the analysis the External 
Calculation window will automatically close. 
  

Micromed HFO Automatic Detection 

Micromed HFO Automatic Detection algorithm is implemented according to Staba's method and consists of 
detection of spontaneous high-frequency oscillation (HFO) events from continuous wideband EEG 
recordings. The wideband EEG is band-pass filtered 80–250Hz to identify high-frequency EEG events (Ripple 
oscillations). The threshold of 2.5 SD above the mean value of the rectified band-pass signal is calculated and 
used to detect HFO events. Consecutive events separated by less than 10ms are combined as one only event 
and only those with at least 6 peaks are considered. 
  
To start HFO Automatic Detection follow these steps: 

1. Click on External calculation button in order to open External Calculation window 
2. Select "Micromed HFO Automatic Detection" plugin 
3. Select montage lines (All montage lines or a selection of these) on which the calculation will be 

performed 
4. Select EEG trace interval (Whole trace, Current page, or a trace user-defined selection) on which the 

calculation will be performed 
5. Click on Start 
6. All the HFO events detected will be displayed on the EEG trace and in the Events panel. Detected 

events will be added to the events file associated to the EEG file 
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NOTE: threshold, distance between events and peaks number values used by the algorithm can be edited 
using SettingsHFO.ini file located in C:\System98\Programs\HFO. 
 

EVENTS PANEL 

The Events Panel is a tool used to visualize, analyze, and edit all the events of an EEG recording. The Events 
Panel can be opened using the Open panel button in the Events tab of the Ribbon bar: 
  

 
  
The Events Panel displays all the events sorted by default by their position in the EEG trace: 

 
  
For each event the following information is displayed: 
• Type: Note, Annotation, Digital Trigger, Video selection, etc. 
• Text: available for events with type Note, Annotation, and Digital Trigger. 
• Position: time position of the event in the EEG trace. 
• Duration: available for events with type selection or interval 
• Derivation: name of the derivation in which the event is inserted. Available for single line events 

only. 
• Value, Extra Value and Extra Text: auxiliary multi-use fields, available for all the events except from 

Notes, Digital triggers, Video; Hyperventilation and EEG selections. These additional fileds  can be 
used to group events. 

• External: True or False. This field allows the user to identify events created and imported using 
external calculation tools. 

• Created by: the user who created the event. 
• Creation date: date and time of the creation of the event. 
• Updated by: the user who modified the event. 
• Update date: date and time of the event modification.  

On the top of the Events Panel, the total number of events present in the EEG recording is displayed. 
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NOTE: All the events visible in the current EEG page are marked with a blue rectangle on the left. Using up 
and down arrow keys the user can scroll the events list. The blue mark will scroll too, in order to underline 
always those events, which are currently displayed. 
NOTE: All the events belonging to derivations ,which are not visible in the current montage, instead, are 
highlighted in yellow. 

Jump to Event  
Click on any event in the Events Panel and the trace display automatically jumps to that point in the 
recording. 
If you scroll to a new page in the recording, the first event on that page is highlighted in the Events Panel. 
If a duration event of any type is clicked in the Events Panel, the event is centered on the screen display. If 
the duration event is too long to fit fully on the screen, the left edge of the event will be displayed. 

Sort 
All events in the Events Panel can be sorted by Type, Text, Position, Duration, Derivation, Value, Extra Value, 
Extra Text, External, Created by, Creation date, Updated by and Update date, just by clicking on the column's 
header. Click the header a second time to reverse the order. 

Reordering the Column Headers 
You can reorder the Events Panel's columns by clicking on the column's header and dragging it to the desired 
position. For example, you can rearrange the headers from Name: Time : Duration to read Time : Name : 
Duration or in any other sequence you want to view them. 

Delete  
To delete events from the list of the Events Panel select the event, right-click on it with the mouse and 
choose Delete from the popup menu. A confirmation message will appear. 
Otherwise you can select the event and press the Canc key on the keyboard. In this case no confirmation 
message appears before deletion. 
NOTE: if you delete an event from the Events Panel, it will also be deleted from the EEG trace. 

Filter 
There is the possibility to filter events visualization in the Events Panel by Type, Text, Derivation, Value, Extra 
Value, Extra Text, External, Created by, Creation date, Updated by and Update date. 
To filter events click on the funnel icon on the column header and select the items you want to visualize in 
the list: 
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On the bottom part of the Events Panel a summary of the applied filters will appear: 
  

 
  
Clicking on the checkmark next to the filter properties you can disable on enable again the filter. Clicking on 
the X button on the bottom right, instead, you can clear all filter settings. 
Under the filter settings the number of currently visible events is displayed: this number takes into account 
events, which are visible after the filters application. 
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VISUALIZATION SETTINGS 

The user can enable Events Panel visualization pressing "Open Panel" button that is available from different 
points of the EEG window: 
- From Ribbon bar > Home tab (Events group) 
- From Ribbon bar > Events tab 
- From Ribbon bar > HFO tab 
- From Time bar: 
  

 
  
Events Panel can be floating in the position of interest in the EEG window or can be docked to one of the 
preset positions in the EEG window (see sections “Dock Panel Layout” and “Windows Placement”). Events 
Panel can also be placed on a second screen. To move Events Panel, just click on its header and drag it to the 
desired position.  
The height and width of Events Panel can also be modified. To resize Events Panel just hover the mouse on 
one of its edges. When the cursor turns into a two-sided arrow, click and drag the window edge until the 
desired dimension is reached. 

 

LOCAL EVENT MANAGER 

Brain Quick software implements a local event manager for the display of alarms. To enable the event 
manager, the user has to enable the alarms of interest in the software preferences. 

 

By clicking on Application Button > Preferences > Acquisition Saving Options the user can access the local event 
manager options: 

 

In this page it is possible to enable the Local Event Manager and to select whether to be alerted by the either 
or both the following possible events: 

• Patient button/Amplifier button 

• Analysis alarm threshold 
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Once the Local Event Manager is enabled, it is possible to open its window in the status panel by clicking on 
the relative icon in the home tab of Brain Quick Software: 
 

 
 
Once enabled, the Local Event Manager will be visible in the status panel: 
 

 
 
With the Local Event Manager window open, the software will prompt information regarding alarms during 
the recording of an EEG exam. Once an alarm is triggered, a sound will start playing to alert the user and a red 
flashing icon will appear to the left of the information box. No alarm will be issued if the current EEG exam is 
not currently been saved. 
 

Amplifier button and patient button 
Alarms triggered by pressing the amplifier button or the patient button a sound alarm will start ringing and a 
red man-shaped icon will start flashing to the left of the information box: 

 
By pressing the Reset button to the right of the information box, both the red icon and the sound alarm will 
stop and the text in the information box will be preserved. 

 

Analyzer threshold alarm 
If an analysis protocol is set for the current analysis and the analysis panel is open, the software will 
automatically notify the user of alarm threshold been triggered. To setup an analysis threshold alarm, refer to 
the Analyzer section of the manual. 
When an analyzer threshold alarm is triggered, a sound will start playing and a red bell-shaped icon will start 
flashing to the left of the information box: 

 
By pressing the Reset button to the right of the information box the alarm sound will stop. The red icon will 
continue to flash up until the analyzer signal is no longer in the alarm region. Furthermore, no more sound will 
be played until the graph that triggered the alarm goes back into the safe region or a different graph triggers 
a new alarm. 
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MEASURE CURSORS 

Measure cursors are tools which allows to measure oscillations amplitude, duration and frequency in a quick 
way.  They can be enabled by clicking on the Cursor section from the Home tab of the Ribbon bar: 

 

Finally there is the Distance cursor, another tool that allows the user to measure time differences between 
two defined points on the trace. 

These features and how to use them are explained below. 

DISTANCE CURSOR 

Distance cursor is a tool that allows the user to measure time differences between two defined points on 
the EEG trace. It is composed of two vertical red lines with red arrows, which identify the start and end point 
selected for the distance measurement. A textbox displays the distance measured between the selected 
start point and end point. 
  
The user can enable and disable distance cursor by directly clicking with the mouse on the EEG trace: 

1. Double-click on the EEG trace to set the start point for distance measurement 
2. Double-click on the EEG trace to set the end point for distance measurement 
3. Distance information is displayed  
4. Double-click on the EEG trace to close distance cursor 

  

 
  

RULER MEASURE CURSOR 

Ruler cursor is a tool that allows the user to measure oscillations amplitude in a quick and qualitative way. 
It can be enabled by clicking on Ruler button from the Home tab of the Ribbon bar: 
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A floating ruler with graduated axis appears when hovering the mouse on the EEG trace. The ruler can be 
positioned in correspondence with the oscillations of interest to measure their amplitude and it can be fixed 
on the EEG page using shortcut CTRL+F and unfixed using again CTRL+F. 

 

The ruler cursor y-axis is equal to the gain and the x-axis is equal to 1 second.  
 

STANDARD MEASURE CURSOR 

Standard Measure Cursor is a tool which allows to measure oscillations amplitude, duration and frequency 
in a quick way.  It can be enabled by clicking on Standard button from the Home tab of the Ribbon bar: 
  

 
  
When clicking on Standard button the Standard Measure Cursor directly opens in the middle of the EEG 
page. It is composed of a red area, which delimits the part of the EEG trace to be measured. The selection 
applies to all the montage lines.  
Standard Measure Cursor displays information updated in real time about the: 
  
•  Initial and final timing position of the vertical selection 
• Temporal duration of the interval 
• Peak-to-peak amplitude of the interval 
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The area selected by the Standard Measure Cursor can be resized by clicking with the mouse on the start 
point (or on the end point) of the selection and dragging it to the desired position. The selection can also be 
moved by clicking with the mouse on the red area and dragging it to the desired position. 
  
Standard Measure Cursor allows also to fit frequency of the selected waves: the cursor provides 9 vertical 
bars within the selected area that split the selection in 10 parts, which allow the user to fit the interesting 
wave's peaks. Just selecting with the cursor the wave of interest and reshaping the selection in order to fit 
the peaks you can obtain a direct measure of the frequency of the selected wave. Frequency value calculated 
is displayed in the results box which appears on the top left of the measure cursor. 

  

ADVANCED MEASURE CURSOR 

Advanced Measure Cursor is a tool which allows to measure oscillations amplitude, duration and frequency 
in a quick way.  It can be enabled by clicking on the Advanced button from the Home tab of the Ribbon bar: 
  

 
 

 When clicking on the Advanced button the Advanced Measure Cursor directly opens in the middle of the 
EEG page. It is composed, as the Standards Measure Cursor, of a red area that delimits the part of the EEG 
trace to be measured. The selection applies to all the montage lines and by default the first montage line is 
selected.  
 
The user can select the area of interest by clicking and drag the selection directly from the EEG page. 
 
Advanced Measure Cursor displays information updated in real time about the: 
  
•  Initial and final timing position of the vertical selection 
• Temporal duration of the interval 
• Peak-to-peak amplitude of the interval 
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The area selected by the Advanced Measure Cursor can be resized by clicking with the mouse on the start 
point (or on the end point) of the selection and dragging it to the desired position. The selection can also be 
moved by clicking with the mouse on the red area and dragging it to the desired position. 
  
Advanced Measure Cursor allows also to fit frequency of the selected waves: the cursor provides 9 vertical 
bars within the selected area that split the selection in 10 parts, which allow the user to fit the interesting 
wave's peaks. Just selecting with the cursor the wave of interest and reshaping the selection in order to fit 
the peaks you can obtain a direct measure of the frequency of the selected wave. Frequency value calculated 
is displayed in the results box, which appears on the top left of the measure cursor. 
  
In addition to Standard Measure Cursor's features, Advanced Measure Cursor provides a panel showing two 
graphs. The upper graph displays a zoom of the selected part of the EEG trace. The lower graph displays the 
spectrum of the selected part of the EEG trace, with indication of the peak frequency: 
  

 
  
  
Hovering the mouse over the Advanced Measure Cursor's graphs the user can obtain additional information 
about the amplitude or the power of the trace: each graph provides a vertical cursor which is displayed when 
the mouse hovers on the plot. When the vertical cursor is active a box displays information about the 
position and amplitude of the selected point for the zoom graph and about frequency and power of the 
selected point for the spectrum graph. 
 
Double clicking on the amplitude graph it is possible to add a fixed reference to visualize information about 
the position and amplitude difference between the fixed value and the actual position of the mouse over 
the amplitude graph:  
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It is possible to double click to fix and compare two different values on the amplitude graph and in this case 
the active box will show information about the difference between the selected peaks: 

 
 
The user can also modify both graphs' axis scale by clicking on the axis cursor's extremity and dragging it: 
  

 
  
Advanced Measure Cursor allows to analyze more than one EEG segment at the same time. The user can 
select more than one EEG segment using Ctrl + mouse click on the lines of interest. If more lines are selected, 
their graphs are superimposed with different colors in Advanced Measure Cursor panel:  
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ANALYZER 

ANALYZER DATA PROCESSING 

 

Introduction 
The EEG Analyzer software is a dedicated instrument for analysis of EEG and Polygraphic signals (in the 
following they will be both referred as EEG signals). It provides quantitative analysis of data both in frequency 
and time domain, with display of evolution of any of the calculated parameters over the time.  
  
The EEG Analyzer is designed to fulfill the analysis needs in the following activities: 

1. Monitoring EEG Signals in Intensive Care Units – Adult/Pediatric/Neonatal 
2. Monitoring SpO2 and HR in Long Term Monitoring for Epilepsy 
3. Analyzing EEG and Polygraphic Signals for Reporting LTM and/or Ambulatory Recording 

  
The design of the User Interface is defined for two main groups of users: 
A.    Basic Users:  very simple User Interface, a Quick Startup, a few pieces of information that is clear and 
condensed. 
B.    Advanced Usesr: sophisticated Analysis with the possibility to configure any single detail, in a User 
Friendly manner, which simply need to be fast in term of calculation and efficient in term of display. They 
might choose to display lot of information and to export lot of data for further analysis. 
  

Data Processing Scheme 
The calculation is based on a segmentation of the signal into 2 sec. epochs, the so called “minimum epoch.”  
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Already Calculated Parameter will be saved, storing ONLY the really used parameters. For sure an offline 
modification of the displayed parameters will require a recalculation of the data. 
  

Spectral Analysis 
Spectral analysis is a process that is based on the transformation of the trace from the time domain to the 
frequency domain. The advantage of such an operation consists in the possibility to condense information 
contained in trace segments of several seconds or up to several hours into a single graph. This analysis 
supplies information about the structure of the trace, but does not supply information regarding any 
eventual morphology present in the signal, which is however not the real objective of long term monitoring. 
Spectral analysis is based on the principle that any signal can be viewed as a sum of pure sinusoidal 
components that differ in frequency and phase. 
  

   
  
The signal display in the form of a spectrum is simply a graph that shows, for each pure frequency 
component, its power, also called PSD - Power Spectral Density. This graph should be shown in columns, but 
typically is always drawn as a continuous graph where the X-axis shows the measured frequency in Hertz or 
cycles/sec and the Y-axis shows the power, where the unit measurement is uV²/Hz. The computation of this 
decomposition is obtained by the DFT - Discrete Fourier Transform, of which a rapid calculation version was 
introduced in 1970 and took the name of FFT - Fast Fourier Transform.  
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Frequency analysis consists in the segmentation of the EEG trace in multiple epochs of 2 seconds or more, 
transformation of each of these according to Fourier, then averaging the various spectrums and displaying 
the results obtained as a graph. 
 
As already stated, spectral analysis is not a punctual methodology, but median, in such that it highlights the 
harmonic content of the signal contained in fixed epochs; if we add the fact that we average the results 
obtained from multiple epochs, we can clearly understand why such an analysis is not capable of highlighting 
sporadic low power events present in the trace. 
  

Signal Conditioning (Pre-Processing) 
To improve the performance of both Time Domain Analysis and Spectral Analysis a conditioning of the 
original signal can be performed as follows: 
  
• Overlapping: this is a technique consisting in analysis of superimposed epochs. This consists in the 

analysis of, for example, preset epochs of 2 seconds selecting consecutive epochs every second (1 
sec, following figure). This permits the analysis of each trace element in a manner that they are 
centrally located within the analysis epoch. 

  

 
  
• Detrending: this is a technique consisting in the removal from each epoch of any eventual DC or 

their derived components. This consists in removing the straight -ine components from the signal 
that best approximate the trace tendency within the epoch. The result obtained is notable, because 
the very slow components that are suppressed are usually of no interest, while any rapid 
components are highlighted, as they are the most important ones within analysis. 
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• Tapering: this technique has the aim to reduce the phenomena of spectral leakage which, 

distributing the signal power in a wide band of the spectrum, risk masking other important low 
power components of the trace. The resulting improvement is considerable, especially with signals 
characterized by a dominating rhythm, whose dispersed components could effectively mask other 
real components of the trace. This operation consists in multiplying the epoch of the signal by a 
known constant function, which is usually 0 at the extremes of the epoch.  
 

Signal Referencing 
The following Referencing algorithm can be applied to the signal, prior to any signal re-combination: 
  
Average Reference (AVG) 

 
Bi-Auricular Reference (A1-A2) 
  
Source Reference (SRC) 
  

Signal Recombination 
The EEG Analyzer allows the selection of the following channels for the analysis: 
 

MONOPOLAR EEG CHANNEL 

This is a monopolar EEG Channel “As Recorded”, that is with the physical Common Reference used during 
acquisition (i.e. Fp2-G2). 
Processing allowed on this kind of data are the following: 
 Average Reference 
 Biauricular Reference 
 Source Reference 
No need to predefine these channels for the analysis as they are derived from the list of recorded channels. 
 

BIPOLAR POLYGRAPHIC CHANNEL 

This is a Polygraphic Channel “As Recorded”, that is then a Physical Bipolar signal. 
No processing is allowed on this kind of data. 
No need to predefine these channels for the analysis as they are derived from the list of recorded channels. 
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BIPOLAR EEG CHANNEL 

This is a Bipolar EEG Channel derived from 2 Monopolar EEG Channel by simple subtraction (i.e. Fp2-C4 
derived from Fp2-G2 and C4-G2). 
Processing allowed on this kind of data (prior to bipolar calculation) are the following: 
 Average Reference 
 Biauricular Reference 
 Source Reference 
The list of possible “Bipolar EEG Channels” need to be defined in the protocol Setup 
 

MONOPOLAR EEG CHANNELS GROUP 

This is a Group of Monopolar EEG Channels, which specify to calculate the average activity of any of the 
parameters over the selected Monopolar EEG channels. 
Processing allowed on this kind of data (prior to average group activity calculation) are the following: 
 Average Reference 
 Biauricular Reference 
 Source Reference 
The list of possible “Monopolar EEG Channels Group” needs to be defined, with the detailed composition of 
each group, in the Protocol Setup 
 

BIPOLAR EEG DATA GROUP 

This is a Group of Bipolar EEG Channels, which specify to calculate the average activity of any of the 
parameters over the selected Biopolar EEG channels. 
Processing allowed on this kind of data (prior to average group activity calculation) are the following: 
 Average Reference 
 Biauricular Reference 
 Source Reference 
The list of possible “Bipolar EEG Channels Group” needs to be defined, with the detailed composition of each 
group, in the Protocol Setup  

Signal Filtering 
The following Filtering can be applied to the signal: 
  
High Pass Filter 
Low Pass Filter 
Notch Filter 
“Rectangular Like” Filter 

Period of Calculation 
This parameter defines the duration of the super epoch for the calculation of the values to be displayed, i.e. 
the number of epoch to consider in order to produce an output (which is not always the “Average” of the 
values of single epochs). It must be defined in seconds. 

Interval Type 
This parameter defines the duration of the super epoch for the calculation of the values to be displayed, i.e. 
the number of epoch to consider in order to produce an output (which is not always the “Average” of the 
values of single epochs). It must be defined in seconds. 

Parameter List 
All the parameters used in the EEG Analyzer are calculated any time the user runs the EEG Analyzer program. 
The list of these parameters is the following: 

1. PSD (Power Spectral Density): this parameter is calculated using the Fourier Transform: 
further information is described in the following section (Spectral Analysis) 
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2. Absolute Power 
3. Relative Power 
4. Spectral Edge Frequency (SEF) 
5. Peak Frequency 
6. Main Dominant Frequency (MDF) 
7. Median Frequency (MF) 
8. User Index 
9. Burst Suppression Ratio (BSR) 
10. Average Coherence 
11. Signal Value 
12. Integrated Amplitude (IAEEG) 
13. Tachogram in bpm 
14. Tachogram in sec 

ANALYZER PROTOCOLS 

 

PSD-Power Spectral Density 
This parameter is calculated using the Fourier Transform: further information are described in the “Spectral 
Analysis” part. 

Absolute Power 
The absolute power on a band is calculated as the area of the spectrum delimited by the frequency band 

limits (mathematically it is the integration, in the frequency domain, of the PSD). The unit of measure is V². 
In the figure below the absolute power of the alpha band is shown as the area under the graphic of the PSD 
(Power spectral Density) within the Alfa Band limits. 

 

Absolute power of the Alfa band shown as a shaded area of the spectrum. 

Relative Power 
Calculated as the ratio between the absolute power in a specific band and the total spectral power (equal to 
the total sum of the power in all bands). Taking as an example the 4 standard spectral bands, we can obtain 
the following: 

 
Being a ratio between two similar quantities, the result has no dimension and is usually expressed as a 
percentage. 

Spectral Edge Frequency (SEF) 
This is defined as the width of the spectrum. Its calculation can be derived in different ways but it is most 
often calculated as the frequency, which delimits 95% of the total spectral power (figure 6). Its dimension is 
in Hz or cycles/sec. 
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Example of the SEF value derived from an EEG spectrum 

Peak Frequency (PF) 
This is the frequency where the power of the spectrum, reaches its maximum value or peak. This value can 
also be defined as the maximum value reached in each of the specific bands. Its dimension is in Hz or 
cycles/sec. 

 
  

Main Dominant Frequency (MDF) 
This is the dominant frequency of the spectrum, defined as the weighted average of the power at various 
frequencies and is calculated by the following formula: 

 

Its dimension is in Hz or cycles/sec. 
  

Median Frequency 
Median frequency is the specific frequency value that divides the spectrum into two regions, each containing 
50% of the total power (figure 8). Its dimension is in Hz or cycles/sec. 
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Burst Suppression Ratio (BSR) 
This is a parameter that quantifies the degree of suppression of the trace. It is calculated on preset epoch 
lengths as a ratio of the period where the signal remains stable and below a specific threshold, for example 

±5 V, and the duration of the epoch (figure 9). To qualify the trace considered in suppression, the threshold 
must be surpassed for at least 400 - 500 msec. If there are multiple intervals of suppression during a single 
epoch they are summed. This parameter shows the percentage of suppression present in each data interval. 
Normally the program visualizes a value of BSR every 8 seconds but the calculation is of a sample every 2 
seconds, so there will be 4 values of BSR calculated every 8 seconds. In the EEG Analyzer setup the user can 
setup if visualizing the higher, lower or the mean of these 4 values. (In general the option “Mean” is 
choosen). 
  

 
  

Inter Burst Interval - IBI 
This is a parameter that quantifies the degree of suppression of the trace. It is calculated as the Interval 
between two burst of activity if the signal in that interval keep on staying within a predefined threshold (the 
same amplitude threshold of the BSR). 
As the calculation can be based on several consecutive epochs, particular precautions need to be taken into 
its calculation and or recombination over epochs. 

Average Coherence 
This is the parameter that quantifies the average coherence between 2 channels. It can be defined as 
Coherence between 2 “Monopolar EEG Channels” or between 2 “Bipolar EEG Channels” 

  

Signal Value 
This is the parameter that visualizes the numerical value of the signal selected. As it refers to a signal epoch, 
it should be displayed as the “Maximum”, “Minimum” or “Mean” value within the epoch. 
If “Maximum” or “Minimum” are selected, when “averaging” values over epochs the “Maximum” of all the 
“Maximum” of each epoch must be calculated as well as the “Minimum” of all the “Minimum” of each epoch 
must be calculated. 

IAEEG (Integrated Amplitude EEG) 
This parameter is calculated on a channel as the “Lower Edge” and “Upper Edge” of an “Amplitude 
Integrated” processed channel. Amplitude Integrated of an EEG channel means pre-filter the signal (with a 
pass-band filter 2-20 Hz), rectify smooth and compress the values in time in order to obtain the desired 
values. 

User Index 
All the parameters already described can be used singularly as a variable to be monitored, or in combination 
to define new variables also known as Indexes. A typical example often found in literature is the Theta/Alfa 
quotient, which is calculated as the ratio of the absolute power in Theta and the absolute power in Alfa of 
any given signal. It is obvious that many other indices can be defined, including the definition of different 
signal ratios. An index can be defined as follows: 
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Tachogram in bpm 
ECG channel is pre-filtered (with a pass-band filter 4-40 Hz) and a detection algorithm is applied for peak R 
recognition. This parameter is a measure of the heart rate variability and represents the number of beats 
per minute (BPM). 

Tachogram in sec 
ECG channel is pre-filtered (with a pass-band filter 4-40 Hz) and a detection algorithm is applied for peak R 
recognition. 
“Tachogram in sec” is an analysis of variation in the instantaneous heart rate time series using the beat-to-
beat RR intervals and it describes the duration of interval RR in seconds. The RR interval is the time measured 
between the R wave of one heartbeat and the R wave of the preceding heartbeat. 

 

 

HOW TO PERFORM EEG ANALYSIS 

EEG analysis can be executed either online during acquisition or offline during review of EEG traces. 
EEG Analyzer panel can be opened from Ribbon bar > Analyzer tab pressing Open button. In case of online 
analysis, panel is automatically opened if the user set an analysis program from acquisition protocol. 
  
The following steps explain how to perform an online analysis: 

1. Click on Open button to open EEG Analyzer panel 
2. Select an analysis protocol from the available protocols in the combo box (only trends type) 
3. Start the EEG acquisition 
4. Calculation starts and the analysis results are progressively displayed in the Analyzer panel 

 

 
 
Instead, to run a new offline analysis, follow these steps: 

1. Click on Open button to open EEG Analyzer panel 
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2. Select an analysis protocol from the available protocols in the combo box 
3. Click on Process button to start calculation 
4. Calculation starts and the analysis results are progressively displayed in the Analyzer panel. Below 

the protocols combo box a progress bar is displayed to show the calculation's progress 
5. Wait until the calculation is complete, otherwise click again on the Process button to stop the 

calculation  
  

 
  

 
  
NOTE: the analysis process can run also in background, so the user can keep EEG Analyzer panel closed during 
calculation and open it later (either during calculation progress or when calculation is complete). 
  
When the process is completed, from the Archived Analysis combo box is possible to review it. The maximum 
limit for conducting analyses on a single EEG examination is 2. When this limit is reached, the user must 
delete one or both analyses from the archive window to initiate additional analyses, as indicated by the 
displayed alert. 
 

 
 

EEG Analyzer panel 
EEG Analyzer panel provides a toolbar that allows the user to configure Analyzer graphs visualization 
settings. 
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From left to right: 
o Toggle One/Two Columns: this feature allows the user to switch EEG Analyzer graphs visualization 

from one column to two columns and vice versa. This feature is enabled only when two of more graphs 
are displayed in the EEG Analyzer panel. 

o Analysis Interval: this feature allows the user to modify EEG Analyzer graphs time base. Available 
values for Analysis interval go from 10 seconds to 7 days. 

o Link Analysis Interval to Time Bar Overview Interval: this feature allows the user to apply to EEG 
Analyzer graphs a time base equal to Time bar's overview interval. Time bar's overview interval can 
be set from BRAIN QUICK Application menu > Preferences > Time bar settings. When Link analysis 
interval to time bar overview interval is enabled Analysis interval combo box is disabled. 

o Show Time-Events Control: Time-events control is a bar displayed at the bottom of EEG Analyzer 
panel. Time-events control replicates Time bar's information, is aligned with EEG Analyzer graphs and 
provides #day and time information. If Time-events control is already present clicking on "Show time-
events control" button will hide the bar. 

  

 
o Hide Panel Caption: this feature allows to hide/show EEG Analyzer panel's title bar. 

  
  
  
Moreover, each EEG Analyzer graph has its own toolbar: 
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This toolbar allows the user to modify visualization properties for each Analyzer graph independently one 
from the others. From left to right: 
o Protocol Name: current analysis protocol name is displayed just above the corresponding Analyzer 

graph.  
o Grid Options: this menu allows to show/hide EEG Analyzer graphs X-grid and Y-grid.  
o Scale Options: these menus allow to modify Y scale or to set Auto-fit Y-scale. Analyzer graphs are 

updated according to the scale set. Auto-fit Y scale feature allows the display of the graph using the 
best scale.  

o Color Scale (available for DSA protocols only): this menu allows the user to select one of the available 
color scales for DSA analysis. 4 different color scales are available. 

o Synchronize All DSA Plotters To This (available for DSA protocols only): this feature allows to apply 
current DSA graph visualization options to all the other available DSA graphs. 

In case of EEG Analyzer protocols containing more different analysis cells it is possible to re-arrange cells 
position within the EEG Analyzer panel with CRTL+ mouse clicking on the cell and dragging it to the desired 
position: 
  

 
 

EEG ANALYZER PROTOCOL SETUP 
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There is the possibility to define custom EEG Analyzer protocols. To do that click on Protocol setup button 
from the Analyze tab of the Ribbon bar: 
  

 
  
Analyzer Protocol Setup window opens: 
  

 
  
Analyzer Protocol Setup window is composed by 5 different tabs: Layouts, Trend List, Channel List, Frequency 
Bands and User Indexes. 
  

Layouts 
A Layout includes all the calculation and graphical properties of an analysis protocol. Each Layout is 
composed of one or more cells, which correspond to the EEG Analyzer graphs that will be displayed. 
The list of all available layouts is displayed in the left column of Layouts tab. In the middle column general 
properties and cells of the selected layout are shown. In the right column there is a preview of the cells' 
position within EEG Analyzer panel.  
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To setup a new analysis protocol, follow these steps: 
  

1. Click on Add Layout button. A new layout named "New Layout" is created on the left column of the 
window. "New Layout" contains a cell by default. 

2. To edit the new layout's name, click on it and type the new name 
3. To edit the cell's description, click on it and type the new name 
4. Select cell type by clicking on Cell Type combo box. Available cell types are: Dsa, Trends, Cfm and 

Indexes 
  

 
  

5. Select Trend definitions by clicking on Trend Definitions combo box. Available trends are displayed 
according to the selected cell type.  

The user can select one or more trend definitions for the same cell. If more than one trend definition is 
selected their graphs will be superimposed with different colors in the EEG Analyzer panel. 
Click on OK button to confirm trend definitions choice. 
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NOTE: for cells with type Dsa it is not possible to select more trend definitions per cell. If the user tries to 
add more than one trend definition to a Dsa cell the following error will appear and it will not be possible to 
save nor to exit from Analyzer Protocol Setup window: 
  

 
  

6. Select on Alert Threshold Type by clicking on Alert Threshold Type button. From this options it’s 
possible to enable an alert if the analysis is inside or outside two bounds, above or below one 
threshold. Each Threshold are settable using Inferior and Superior Alert Threshold options. 
 

 
7. Click on Edit cell details button to set cell's grid and scale properties and to enable/disable Auto Fit 

feature. Edit cell details menu can be opened also with mouse right-click directly on the cell 
  

 
  
NOTE: color scale and frequency scale properties are available only for cells with type Dsa. 
  

7. Click on Add Cell button to add another cell to the selected layout 
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8. Click on Remove Cell button to remove the selected cell 
9. Set layout's General Properties:  

o Page Length: is the EEG Analyzer graphs page length. Available values go from 10 seconds to 
7 days. 

o Set page length equal to overview interval: allows the user to set EEG Analyzer graphs page 
length equal to EEG trace page length. 

o Grand Epoch: super-epoch value used for the calculations. Available values go from 2 
seconds to 10 seconds. 

  

 
  

10. Set cell's orientation (vertical/horizontal) using the toggle button: 
  

 

  
  
Layouts tab provides also the possibility to duplicate an existing layout, by selecting it and click on Copy 
Layout button and to remove an existing layout by selecting it and clicking on Delete Layout button. 
   

Trend List     
A Trend defines which kind of calculation will be performed and which channel or group of channels is 
involved in the analysis. 
Trend List tab displays a list of all the available Trends: 
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For each of the defined Trends a Name, a Description, Trend type and Channel Definitions/Numerical values 
are displayed. 
 
All Trends defined in Trend List tab will be automatically displayed in the Trend Definitions combo box of 
Layouts tab. 
  
To set up a new Trend Definition follow these steps: 
  

1. Click on Add Trend Definition button. A new trend will be added at the end of the Trend List 
2. Type a Name and a Description for the new trend 

  
3. Select the Trend Type. Available Trend Types include the following: 

  
o Power Spectral Density 
o Absolute Power 
o Relative Power 
o Spectral Edge Frequency 
o Main Dominant Frequency 
o Median Frequency 
o Burst Suppression Ratio Max 
o Burst Suppression Ration Min 
o Burst Suppression Ratio Mean 
o Signal Value Max 
o Signal Value Min 
o Signal Value Mean 
o Tachogram Max (bpm) 
o Tachogram Min (bpm) 
o Tachogram Max (sec) 
o Tachogram Min (sec) 
o Tachogram Mean (sec) 
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o Integrated Amplitude 
  

4. Select a monopolar channel, a bipolar channel, a group of channels, or a constant from the list of 
available items in Channel Definitions/ Numerical Values column. 

5. Click on the newly created Trend and then click on Edit Trend details. A menu opens showing all the 
customizable Trend properties. According to the selected Trend type different modifiable settings 
will be displayed. 

Below there is a list of all modifiable Trend settings:  
o FFT Epoch: 2 seconds or 10 seconds 
o Overlapping: enabled or disabled 
o Tapering: enabled or disabled 
o Detrending: enabled or disabled 
o Reference type: G2, AVG,A1A2 
o High pass filter cut off frequency: from OFF to 800 Hz 
o Low pass filter cut off frequency: from OFF to 1 kHz 
o Notch filter: enabled or disabled 
o Frequency Bands: the user can select a frequency band from the list of available frequency 

bands 
o Bsr duration: from 200 msec to 750 msec (available for Burst trend type only) 
o Bsr threshold: from 5 uV to 50 uV (available for Burst trend type only) 
o Cfm threshold: from 10 uV to 300 uV (available for Integrated amplitude trend type only) 

  

 
  
NOTE: In Channel Definitions/Numerical Values combo box, different items are displayed with a different 
color. In particular: 
o Group of channels are displayed in green 
o Bipolar channels are displayed in light blue 
o Monopolar channels are displayed in deep blue 
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NOTE: Not available channels or groups of channels are displayed as strikethrough text, as shown in the 
figure below: 
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Channel List 
Channel List tab displays a list of all the available bipolar channels and groups of channels. Bipolar channels 
list is displayed in the left column, while groups of channels are displayed on the right column. 
 
In this tab the user can define new bipolar channels or channels groups or delete them. 
  
To create a new bipolar channel, follow these steps: 

1. Click on Add bipolar channel button. A New Bipolar Channel will be added at the end of the channel 
list on the left 

2. Edit the bipolar channel's name 
3. Set Input+ and Input- from the list of available derivations 
4. Click on Save button 

  
To remove a bipolar channel, follow these steps: 

1. Select the bipolar channel you want to delete 
2. Click on Remove bipolar channel button 
3. A confirmation message will appear: "Are you sure to remove the selected bipolar channel?" Click on 

Yes to permanently remove the bipolar channel, click on No to cancel the operation 
  
To create a new group of channels follow these steps: 

1. Click on Add channel group button. A New Channel Group will be added at the end of the groups list 
on the right 

2. Edit the channel group's name 
3. Select the channels belonging to the group from the list of available channels 
4. Click on Save button 

  
To remove a group of channels follow these steps: 

1. Select the group of channels you want to delete 
2. Click on Remove channel group button 
3. A confirmation message will appear: "Are you sure to remove the selected channel group?" Click on 

Yes to permanently remove the channel group, click on No to cancel the operation 
  

 
  
  

Frequency Bands 
Frequency Bands tab displays a list of all the available frequency bands. There are four default frequency 
bands: Delta, Theta, Alpha and Beta. 
 
The Add Frequency Band button allows the user to add new frequency bands with the desired name and 
limits. Remove Frequency Band button, instead, allows the user to delete selected frequency bands (a 
confirmation message will appear before deletion is started).  
Each frequency band can be renamed and its frequency limits can be changed choosing them from the popup 
menu or directly typing them in the correct cell. Frequency bands limits can be set from 0Hz to 512Hz. 
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NOTE: default frequency bands (Delta, Theta, Alpha and Beta) cannot be removed. 
  
  

User Indexes 
User Indexes tab displays a list of all the available indexes. The user can add new indexes or delete existing 
ones. 
  

 
  
To add a new User Index, follow these steps: 

1. Click on Add User Index button. New Index will be inserted at the end of the indexes list 
2. Type a name and a description for the new index 
3. Set K, Numerator and Denumerator for the index, according to the following formula:  index = 

K*(trendA op trendB)/(trendC op trendD) 
4. Click on Edit Index Details button. A drop down menu opens: 

  

 
  

5. Set trendA, trendB, trendC and trendD to be used in the index formula 
6. Click on Save button 

  
To remove a User Index, follow these steps: 

1. Select the User Index you want to delete 
2. Click on Remove User Index button 
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3. A confirmation message will appear: "Are you sure to remove the selected index?" Click on Yes to 
permanently remove the User Index, click on No to cancel the operation  

MAPS 

MAP DESCRIPTION 

BRAIN QUICK SOFTWARE provides the possibility to display EEG data as brain maps. In a brain map the 
patient's head is represented as a circle and each electrode is depicted as a point on the circle.  
The value of the map in the points corresponding to the electrodes is determined by the EEG data and by 
the mapping method chosen. Interpolation is used to obtain a value for every point of the map, which is 
then represented on the screen using color-coded scaling. 
The software allows MAPS offline analysis during EEG review. 
  
It is possible to enable Amplitude and Frequency Maps from Analyze tab: 
  

 
  

AMPLITUDE MAPS 

Amplitude maps represent the distribution of the EEG amplitude in the brain in a determined timing of the 
EEG recording. 
Clicking on Amplitude map button on Analyzer tab of the Ribbon bar Amplitude maps panel opens. Together 
with the panel a vertical cursor appears on the EEG trace. The cursor is made of 1/4/8/32 (according to the 
number of Amplitude maps displayed) equally spaced vertical bars which can be dragged or stretched using 
the mouse in order to select exactly the points in the EEG trace to be analyzed. Amplitude maps are 
automatically calculated when the vertical cursor is placed on the EEG trace. 
Below each Amplitude map the timing of the EEG recording in which the analysis is performed is displayed. 
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Hovering the mouse on the map's electrodes information about the electrode and the EEG Amplitude value 
(in μ V) corresponding to that electrode is displayed: 
  

 
 

Amplitude Maps Settings 

 

 Amplitude maps panel provides a toolbar that allows the user to configure analysis parameters and 
visualization settings: 

o Settings: this menu allows the user to set up 
•  The number of maps to be displayed: 1, 4 ,8, or 32 
• The algorithm to be used for the interpolation: Knn, Planar spline or Spherical spline 
• Filter settings: HP filter cutoff frequency, LP filter cutoff frequency, Notch filter 

o Auto-fit: this button allows the user to automatically adjust the scale in order to visualize Amplitude 
maps using the best scale. 

o Color Scale: min and max values can be directly typed into the scale text boxes. 
o Show Electrodes: this button allows the user to show/hide electrodes positions on the maps. 

  

3D Amplitude Maps 
BRAIN QUICK SOFTWARE provides the possibility to display three-dimensional Amplitude maps. 3D 
Amplitude maps can be displayed by clicking on 3D View button on Amplitude maps panel's toolbar. This 
feature allows the user to display the already calculated Amplitude maps in three dimensions. 
  

 
  
  
Enabling 3D Amplitude maps view the following features are available from Amplitude maps panel's toolbar: 
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o Show Grid: this feature allows to display/hide the grid on 3D maps. When 3D View of the maps is 

disabled Show grid button is disabled too. 
o Synchronize Positions: if enabled this feature allows the user to rotate all the 3D maps together, 

otherwise only the selected Amplitude map is rotated. When 3D View of the maps is disabled 
Synchronize positions button is disabled too. 

o Nasion: this feature allows the user to put Nasion in front of view. 
o Inion: this feature allows the user to put Inion in front of view. 
o Left: this feature allows the user to put the left ear in front of view. 
o Right: this feature allows the user to put the right ear in front of view. 

  
  
  

FREQUENCY MAPS 

Frequency maps represent the topographic distribution on the patient's brain of the original signal 
transformed in the frequency domain and divided in spectral bands, each one covering a determined 
frequency range. 
The analysis is based on average and therefore the user has to define the interval where it is performed. 
  

 
  
  
Hovering the mouse on the map's electrodes information about the electrode and the EEG power spectral 
density value  (in μ V2/Hz) corresponding to that electrode is displayed: 
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Frequency Maps Settings 

 

  

Frequency maps panel provides a toolbar that allows the user to configure analysis parameters and 
visualization settings: 
o Settings: a menu allows the user to set up 

• The algorithm to be used for the interpolation: Knn, Planar spline or Spherical spline 
• Filter settings: HP filter cutoff frequency, LP filter cut off frequency, Notch filter 

o Frequency Bands: from the menu below the user can set up the frequency ranges in which the 
analysis is performed. A Frequency map is created for each frequency band defined. Indication of 
the frequency band on which the calculation is performed is displayed below each Frequency map. 

  

 
  
o Process on Whole Trace: this button allows the user to calculate Frequency maps on the whole EEG 

recording. 
o Process on Selected Interval: this button allows the user to calculate Frequency maps on a specific 

part of EEG recording. The part of EEG recording to be analyzed is identified by a selection event. 
The user can choose one of the available selection events from the combo box on Frequency maps 
panel's toolbar. 

o Auto-fit: this button allows the user to automatically adjust the scale in order to visualize Amplitude 
maps using the best scale. 

o Show electrodes: this button allows the user to show/hide electrodes positions on the maps. 
  
To start Frequency maps calculation the user has to press the button "Process" on Frequency maps panel's 
toolbar: 
  

 
  
  

3D Frequency Maps 
BRAIN QUICK SOFTWARE provides the possibility to display three-dimensional Frequency maps. 3D 
Frequency maps can be displayed clicking on 3D View button on Frequency maps panel's toolbar. This 
feature allows the display of the already calculated Frequency maps in three dimensions. 
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REACTION MONITOR 

The "Reaction monitor" function is an analysis tool that highlights EEG modification after an event or a patient 
stimulation. In particular, this tool allows to have quantified data (Spectral bands power) to see signal 
components difference BEFORE / AFTER an event, with the adjustment of the % threshold between BEFORE 
and AFTER to highlight only the important changes. 
 

HOW TO PERFORM REACTION MONITOR ANALYSIS 

Reaction Monitor panel can be opened from Ribbon bar > Analyse tab pressing Open button in the “Reaction 
Monitor” group. 
 

 
 
When clicking on the Open button, the Reaction Monitor directly opens in the middle of the EEG page. It is 
composed of a highlighted area that delimits the part of the EEG trace which corresponds to the "Reject 
Time”. On the left side of the eeg trace appears a table with some comparison values before/after the reject 
time, as detailed in this section. Finally, moving the cursor on one of the values of the table, it is possible to 
visualize in detail the graph of the trend type chosen, with a comparison between BEFORE / AFTER the Reject 
time. 
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The width of the Reject Time area can be set by opening the Reaction Monitor setup: 
 

 
 

As can be seen from the previous picture, it is also possible to set the analysis interval before/after the event 
in the Reject Time area. 
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From Reaction Monitor Setup, it’s also possible: 

• choose trend type selection: the default value is Absolute power, but other choices are available 
(Relative power, Peak Frequency, SEF, Median Frequency, Main dominant Frequency); 

• define the frequency bands and activate the display of the band; 

• define for each band a threshold in %  (Difference in % Power AFTER - BEFORE). For example, if 
difference between Power AFTER / Power BEFORE is less than 40% threshold, bargraph is displayed 
in RED:  

 
In the case of Power After lower than Power Before, the bargraph is blue. On the other hand, in the 
case of Power After higher than Power Before, the bargraph is green. Deep of blue/green colour 
depend of % of difference. 

 
 

DATA AVERAGE 
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The synchronized average, called "data average,” is a particular procedure that uses the trigger events 
positioned in an automatic way or manually on the trace during acquisition or review; the program in a second 
moment can perform trace scan in search of such events to perform the average of channel per channel of 
periods of trace delimitation from such events and which the user is set by the user (from 10 msec to 10 sec). 
On the trace both analog and digital trigger can be placed; the two types of triggers are generated in an 
automatic way from different units (stimulators) to synchronized with particular events; the following grid 
indicates the main differences between the two types of trigger: 

Analog trigger Digital Trigger 

Positioned on one channel only (it is possible in 
the same trace to position the analog trigger on 
different channels) 

Appears as an event and does not interest a single 
channel 

Appears as a variation of level of the signal 
(vertical peak) 

The instant and numerical code is memorized 

The triggers can not distinguish one from the 
other (apart from the channel where they are 
positioned) 

The trigger are distinct from a numerical value; it is 
possible to perform synchronized average on groups of 
trigger having the same code. 

The number of triggers that can be inserted is 
limited only by the length of the file (two triggers 
must be distant at least a minimum of three 
samples one from the other) 

Maximum of 8192 triggers can be inserted 

NOTE: it is not possible to perform the data average by using digital triggers and analog triggers at the same time. 

The window of synchronized average is accessible by selecting the item Data Average from the menu Analyze 
– Erp Manager. 

HOW TO PERFORM DATA AVERAGE ANALYSIS 

Data Average panel can be opened from Ribbon bar > Analyse tab pressing Erp Manager button in the 
“Math” section. 
 

 
 
When clicking on the button, the Data Average directly opens on the right of the EEG page. It is composed 
of a new eeg window, which corresponds to the ERP Preview, and a panel with ERP Processing settings. 
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DATA AVERAGE PARAMETERS 

This tab is subdivided into various sections that are listed from top to bottom. 

Processing Interval 
The Processing interval section allows to select the whole trace or one of the selection interval already present 
in the trace. Next the combo box there is the Process button to realize the ERP preview. 

 

 

Next the combo box there is the Process button to realize the ERP preview. When it is pressed, the process 
starts and a loading bar appears. 
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Trigger Type 
Two options are visible, Digital triggers, and Analog triggers. 

Digital Triggers: enables the use of digital trigger for the synchronized average and excludes analog trigger. 
The following controls become visible: 

Trigger Type: It’s a dialog window that allows the user to select which triggers to consider for the trace 
scan to perform the data average. When “Digital” option is selected, if there are digital triggers in the 
EEG trace it’s possible to select all the triggers or only a particular trigger. 

 

Trigger condition: if “Patient Response” option is checked then the user can set a "condition,” that is 
how to consider the different triggers as they are disposed on the recorded trace; for example a 
particular trigger can be considered as a response trigger and has to follow another trigger (the stimulus 
trigger) before a specified interval of time; if the stimulus trigger is followed by a different response 
trigger then it can be considered as a "wrong response" and rejected from the calculation of data 
average. When this option is checked, it opens a dialog window where to set the following values 

Correct Answer Trigger Value: from the popup menu you can select the value of trigger that has 
to be considered as the "correct response" of the patient which receives the stimulus. 

Correct Answer Interval: max time interval (in milliseconds) from the "correct answer" trigger 
and the previous trigger (the stimulus trigger). 

Wrong Answer Trigger Value: value of triggers that have to be rejected and not considered in 
the calculation of data average. 

 

 

Analog Triggers: enables the use of the analog trigger for the synchronized average and excludes the use of 
digital triggers. 

Channels trigger: a popup menu in which the user selects the channels of trace in which the scanning 
of the analog triggers is performed.  
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NOTE: if this field appears blank, the user cannot proceed with the calculation of the synchronized average. 

Sweep Length 
ERP Processing settings panel allows to set and visualize the sweep length, defining the Pre-trigger and Post-
trigger intervals. 

Pre-trigger Interval (msec): interval (in milliseconds) of considered trace in the construction of the average 
BEFORE of the trigger event. 

Post-trigger Interval (msec): interval (in milliseconds) of trace considered in the construction of the AFTER 
trigger event. 

Total (msec): sum of the time of pre-trigger and post-trigger, in milliseconds. 

 

Pre-processing 
During the trace scanning a pre-processing on the channels can be performed: before this can be used for the 
average, the signal can be conditioned with the filters (high-pass, low-pass and notch) and rectification (the 
negative part of the signal is inverted). 

 

Rejection 
Enable Rejection: enables/disables rejection. 

Set Rejection Parameters: opens a dialog window that allows the user to set the parameters for the rejection. 
In a grid all the channels of the trace appear: channel by channel, it is possible to enable/disable the rejection 
to set the threshold intervention (in µV).  

 

Post-processing 
ERP Processing settings panel allows to enable or disable an Offset correction on Post-processing. 
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View parameters 
From the view parameters section, it’s possible to change Master Gain on ERP Preview. 
 

 
 

Trace Export 
After the process to realize the ERP Preview, it’s possible to export to EEG the processed average trace 
according to the defined parameters. In this section the user can define the Analsys title, the Signal window 
and select if the signal window shall be applied to the Polygrafic channels too.  
 

 
After clicking “Export to EEG” button, a message appears: 

 

 

Calculation Report 
The last section allows to give a Calculation report containing: 

• the number of triggers averaged;  

• the number of triggers rejected; 

• the number of correct responses (if Patient Response option is enabled); 

• the number of wrong responses (if Patient Response option is enabled); 

• the number of missing responses (if Patient Response option is enabled); 

• Tavg: Correct response average time (if Patient Response option is enabled); 

• σ: Standard Deviation of the Correct response time (if Patient Response option is enabled); 

• R: Correct responses / number of triggers (if Patient Response option is enabled). 
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BACKGROUND REDUCTION 

EEG REDUCTION IN BACKGROUND  

Brain Quick software allows files reduction in background to consent the user to keep in memory only the 
important segments selected of an acquired EEG trace and to allow the user to do different activities during 
the reduction process. 

To perform a file reduction, the user can select the segments of the trace of interest, during acquisition and 
reading phase of an EEG exam and define the Reduction Protocol opening Reduction Setup from Reduction 
tab. 

 

From Reduction Protocol Setup it is possible to add, delete and modify reduction protocols. 

 

Each protocol is described with a “Protocol Name” and it is possible to define: 

• How reduced exam comments are handled (protocol name, original exam comment, trigger or none 
comments) 

• If reduced sections are combined or separated (possibility to define if trace selections will be reduced 
into SAME FILE composed by different segments), a “Section Start Annotation” and a “Section End 
Annotation”. It is also possible to use the following tokens to create a unique annotations in sections: 

o %# = Section Count 

o %sd = Section Start Date 

o %st = Section Start Time  
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o %ed = Section End Date 
o %et = Section End Time 

Example: “Part #%# %sd %st” = “Part #1 08/04/2021 07:39” 

• How exam date/time is handled (original, real, now) 

 

Each reduction protocol can be composed by one or more reduction “Conditions”, that is used to detect 
what part of the EEG/Video should be kept: 

 

a. Text to Text, to keep V/EEG from X seconds/minutes before a user defined “Trigger Start Text” to Y 
seconds/minutes after a user defined “Trigger End Text”, where X and Y are defined by user and with 
the possibility to choose to enable or not “match case” for Trigger Texts 
 

 
b. Text, to keep V/EEG from X seconds/minutes before a user defined “Trigger Text” to Y 

seconds/minutes after that “Trigger Text”, where X and Y are defined by user and with the possibility 
to choose to enable or not “match case” for Trigger Texts 
 

 
 

c. Interval Event, to keep V/EEG from X seconds/minutes before a user selected “Event” from the list of 
available interval events to Y seconds/minutes after that event, where X and Y are defined by user. 
 



BRAIN QUICK Software User Manual  

 

Rev. E                                    Page 242 of 267 

 
 

d. Instant Event, to keep V/EEG from X seconds/minutes before a user selected “Event” from the list of 
available instant events to Y seconds/minutes after that event, where X and Y are defined by user. 
 

 
 

e. Periodic, to keep n amount of V/EEG every n time, it is possible to define the duration of the V/EEG to 
keep and the interval between the segments. 
 

 
 

f. Exam start, to keep V/EEG X minutes after beginning (where X is defined by user). 
 

 
 

g. Exam end, to keep V/EEG X minutes before end (where X is defined by user). 
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h. All, to keep the entire V/EEG exam. 
 

 
 
Select/Unselect the cinema bar in each condition to keep or not the Video together with EEG: 
 

 

 

From Reduction tab it is possible to select one of the saved protocols to visualize on the open trace a Preview 
of the reduction that can be performed and to Run it to start the reduction. Reduction can be even launched 
from File Manager interface, right clicking on an EEG exam, and selecting “Reduce”. Available protocols are 
the ones defined in Brain Quick. 
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REPORT 
Brain Quick software and Neurowerk software manages the creation of reports, which can be realized both 
during the acquisition and the review of EEG and EMG traces. 

Instead, FILE MANAGER software can open, edit and delete these documents, as well as create new anamnesis. 

It has a default editor, but the user can use Microsoft Word as default editor for report management. Anyway, 
the software has an editor that is independent from Word, in order to be used without installing Microsoft 
Office license. 

REPORT MODELS 

The model is a prebuilt document that can contain information, headers and so on. The user can modify this 
information such that the report model adapts to the user (doctor, lab, or hospital) needs. 
  
The model can contain automatic fields, that is, referrals to record fields of the patient.  
When the report of an exam of a determined patient is created, instead of the referrals, the patient data 
automatically appears.  
  
Different doctors or different type of exams can have different models for the creation of a report. 
 
The model is a prebuilt document that can contain information, headers, etc. The user can modify this 
information such that the report model adapts to the user (doctor, lab, or hospital) needs. 
  
The model can contain automatic fields, that is, referrals to record fields of the patient.  
When the report of an exam of a determined patient is created, instead of the referrals, the patient data 
automatically appears.  

ANAMNESIS 

In FILE MANAGER it is possible to create an anamnesis for a selected patient by clicking the New Anamnesis 
button on the ribbon bar (Home Tab). 
 

 
 

A dialog will open allowing to choose a predefined model; if no default template has been created, an empty 
anamnesis document will open. Once the model is selected, the Report editor panel will appear allowing the 
user to enter observations and patient information. If the anamnesis template contains referrals to patient 
record fields, patient information is automatically filled in with the selected patient data. 
When anamnesis is saved, it will appear in the list of exams for the selected patient as a separate “study”. 
 
Double clicking on anamnesis exam or file, it is possible to open and edit it directly from in the Report editor 
panel. Report Editor is dockable, so it can be moved and pinned to the top, bottom, left, or right of the 
application window, and it can be resized as desired. 
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Anamnesis Models 
The Models button of the ribbon bar (Home Tab) allows the creation of new models for anamneses or the 
modification of an existing one; the “Models Management” dialog will open with the collection of all available 
templates. It is possible to edit an existing model or define a new one.  
 

 
 
Clicking the “New” button on the toolbar the Windows “Save As” dialog will appear allowing to enter template 
name and save it in the Templates folder. Once saved, it is possible to select the model and open it with the 
Report Editor for the template definition. 
Report Editor offers different tools to setup layout, style, define header and footer etc.; in addition, the Insert 
tab allows to add to the model referrals to some patient record fields. 
 

 

Anamnesis Models Management 

Note. Anamnesis models are saved locally and are shared among all users. 
 

HOW TO CREATE A NEW REPORT MODEL? 

To create a new model or to modify an existing one, the user must select the Report Models button in the 
BrainQuick bar of the Archive window. 
The Model window is shown, in order to let the user choose the Model file to modify or to allow the creation 
of the new model.  
  

 
  
To create a new model, the user must click on New Button and save the document in the folder chosen.   
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When a new model is created, the user can insert a lot of information, for example the patient's name, the 
hospital, the street, the telephone number, etc. This can be done by simply typing the text and modifying its 
dimension, font, and position. See Report Editor. 

REPORT EDITOR 

In the report editor the creation of a report or anamnesis consists on the creation of a new document 
containing all the information about the patient and the exam diagnosis. 
For each exam, the user can assign a report. 
  
There are various ways to assign a report: 
  
• From Review window (during exam review phase), choosing Open Report from Ribbon bar > Home 

tab.  
If a report associated to the exam in review already exists, it will be opened to allow the user to add diagnosis 
information to the report. 

If there are no reports related to the opened exam, a new report file will be created and opened to allow 
the user to type patient or diagnosis information and observations to the report. 
  

  

 

• From the FILE MANAGER archive ribbon bar under Brain Quick tab, pressing New Report button 
when it is positioned on the visit or exam of interest. 

  
A dialogue window appears, that asks the user to specify the type of model to be used for the report.  
  

Report Window 
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The report window appears like a text document and it is composed of: 
  

1. The Report TITLE BAR, that contains an indication about the "type" of document ("REPORT") with 
First and Last Name of the patient and Date and Time of creation of the report. There will be also the 
possibility to enable "anonymous" function in order to hide patient name from the title bar 
 

 
  

2. Report RIBBON BAR, containing all the toolbars placed on several tabs, grouped by functionality. The 
Ribbon bar uses tabs to expose different sets of controls, eliminating the need for many parallel 
toolbars 
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The ribbon bar could be minimized, keeping only tabs titles displayed: 

 
  
The user has the possibility to visualize Ribbon bar in Normal Mode or in Minimized mode. 
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The ribbon bar is designed to help the user to quickly find the commands that he needs to complete a task. 
Commands are organized in logical groups, which are called together under the tabs. Each tabs relates to a 
type of activity, such as writing or laying out a page.  
 

• FILE tab contains principal commands for writing, save and print the report 

• HOME tab contains Clipboard, Font, Styles, and Editing menus 

• INSERT tab allows the user to add pages, tables, pictures and hyperlink to the document. From this 
tab there is also the possibility to add FIELDS and BLOCKS: the report can contain automatic fields that 
refer to record information of the patient. 
When the report of an exam related to a patient is created, instead of the FIELD, the patient data 
automatically appears: this information are typically patient's name, birthdate or other items. 
BLOCKS let the user insert preset blocks of text. It opens a window that asks to the user to specify the 
name of the block to insert. From the same menu the user can create a new block with the selected 
text (or add the selected text to an existing block) and eventually define a shortcut in order to 
automatically add a specific block to the report pressing the shortcut key 

• PAGE LAYOUT contains Page Setup and Page Background menus and describes how each page of the 
document will appear when it is printed 

• VIEW tab allows the user to change the view  

• HIS tab allows to export PDF (only if HL7 settings is activated) 

• VOICE tab allows to dictate in order to write in the report (present only if it’s activated in settings, for 
more details see “Report Dictation” section). 

  
3. REPORT AREA, that is the real body of the text document, where the user can type his own comment 

about the exam 
  

 
  

The report will be saved in.docx format and can be open from all the computer using all the commercial .docx 
reader (like Microsoft Office Word or WordPad) without any compatibility problems. 
 
When the new report is saved, it appears in the exams list associated to the EEG study; by double clicking on 
report file it is possible to edit report information or add notes and observations through the Report Editor. 
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When double clicked, the editor will open the report to edit. 
 

 
 

Report Dictation 
Report Editor is integrated with Voisis dictaphone, a voice recognition system able to convert the speaker 
voice into written text which helps making reporting activity easier and immediate. 
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Thanks to such integration it is possible to dictate report and anamnesis content directly from the Report 
Editor. 

Note. Dictation functionality is protected by a specific license (FMS SPEECH). 
 

Report Editor toolbar has a dedicated Voice tab with a Dictation button; to enable dictation click with the 
mouse on the document position where you want to enter some text then click the Dictation button. 
 

 

Dictation – Report Editor 

Voisis EasyWriter console will automatically appear; the user currently logged in (*) will be used for the 
connection to Voisis dictaphone and the transcription will be automatically enabled. 

(*) Important Note. In order to guarantee the access to the dictation console the username of the logged user 
must match with one of the Voisis users registered in Voisis server; for example, if currently logged in user is 
micromed, in Voisis server there must be a “micromed” user defined. 
 

 

Voisis EasyWriter console 
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In case of anonymous access, Voisis login dialog will appear: enter valid credentials, i.e username and 
password of a Voisis user registered in Voisis server, in order to access dictaphone console; then enable the 
transcription by clicking the “microphone” button on the toolbar.  
Note. Voisis users shall have username and password equal. 
 
You can start dictate: your voice will be recognized from the Voisis dictaphone and text will automatically 

appear inside the report document starting from the cursor position. 

 

Voisis EasyWriter dialog window can be kept opened: in the panel with yellow background all words and 

phrases recognized (automatically entered in the report document) will be displayed. 

 

Report Dictation 

When you finished click again on the Dictation button to disable the transcription and disconnect from the 
dictaphone. 
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ADVANCED FEATURES and CONFIGURATION 

USER MANAGEMENT 

As illustrated in the Access to the Software paragraph, it is possible to protect access to FILE MANAGER, and 
other Micromed softwares, by username and password and to assign different rights to the different users.  
 
In a typical networked environment, Micromed security framework is based on a centralized Users database 
which collects the list of users who can access FILE MANAGER (and Brain Quick software) and all roles assigned.  
 
Micromed security framework offers the following features: 

• Authentication services: users are allowed or denied accessing parts of system functionality 
according to the role assigned, i.e. to their permissions. 

• Login management: if logon system is enabled, users can log in and out of FILE MANAGER and 
current logged-in user is tracked. 

• Audit services: user interaction with single machine is tracked and key functions/operations are 
recorded in an audit log. 

 

MICROMED SUITE 

Micromed Suite is an external utility intended to support in system configuration at installation time; in 
particular, it allows to setup: 

• Active Directory integration with the possibility to enable Active Directory user authentication and bind 

entire Active Directory groups to File Manager user Roles in order to keep the central Users database 

automatically synchronized with the linked domain users credentials (central configuration). 

• Logon preferences, i.e. enabling user authentication on single workstation. 

• Network Configuration, i.e. setting up the communication between the local File Manager Core service 

running on single workstation and the central File Manager Core service running on server (distributed 

system configuration only). 

• Network Key Reading, i.e. enabling the read of network license key(s) (optional). 

• License Key Activation via Key Updater tool. 

• Configuration of other archiving features: 

• Automatic archiving procedure 

• Persyst cleaning procedure 

• Background Transfer 

• Dictation 

• Databases conversion  

  

 

Note. The above configurations are advanced features that must be performed by authorized personnel 

only. 

LOGON SYSTEM CONFIGURATION 
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In a networked environment, logon preferences are centralized, that is user authentication can be enabled or 
not, even if it is always highly recommended. 
 
Logon preference can be setup through the Micromed Suite external application; this operation is typically 
performed at installation time by authorized personnel. 
Note. Authorized users only can access Micromed Suite: a password is required. 
 

From Micromed Suite users tab, click on Logon and then “Enable Logon” toggle switch to enable user 
authentication and click “OK” button to save preferences. If the users’ database is not present, it is 
necessary to create it to start adding users and roles to it. 
 

 

 
The FILE MANAGER logon system supports both online and offline user authentication; offline user 
authentication is based on a local copy of the centralized Users database which is kept synchronized; only 
users registered in local User Database can access FILE MANAGER in off-line mode. 

 

ACTIVE DIRECTORY INTEGRATION 

In a networked environment where Active Directory groups are established, FILE MANAGER logon system can 
be configured to link Active Directory groups to FILE MANAGER Roles. This represents a great advantage since 
it allows to bind group membership on network domain to medical device system restrictions. 

Note. Each Role can be linked to specific Active Directory group only: all domain users belonging to the 
group will share the same permissions. 

Active Directory Configuration   
The Active Directory authentication enabling and related configuration must be performed centrally on server 
by authorized personnel at installation time through Micromed Suite.  

In Micromed Suite menu select the Users tab and click the Active Directory configuration button; the Active 
Directory Configuration wizard will open.  
In the first configuration step, it is possible to enable Active Directory authentication (“Enable LDAP” toggle 
switch) and setup the LDAP (Lightweight Directory Access Protocol) server details; in particular, it is necessary 
to specify the LDAP Server name and the port on which to contact it. Moreover the LDAP Base DN indicating 
the starting point of the search should be entered. 
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     LDAP Server details        AD Groups Linking and Synchronization 

The Get Default button allows to retrieve the standard values of these parameters (or it is possible to specify 
them manually). 
 
Alternatively, AD Authentication over SSL (“Enable LDAPS” toggle switch) allows to communicate with Domain 
Controller through sign a secure communication protocol. 

Clicking the Test Authentication button it is possible to test the correctness of entered parameters by testing 
authentication from a username and a password known. 
 
Once AD authentication has been enabled, clicking on the “Next” button it is possible to proceed and enable 
the automatic synchronization with one or more Active Directory groups linked to FILE MANAGER pre-defined 
user role.  
The synchronization timeout can be set and Active Directory groups can be manually linked to available roles 
by entering the Active Directory group name (among the existing ones in the reference domain) in 
correspondence of the chosen role. 
Note. FILE MANAGER roles have a default set of permissions assigned; each role, except for the Administrator one, can 
be customized according to specific needs. 
 

Click “Ok” to save Active Directory configuration; it will apply to all stations belonging to the networked 
environment ensuring the possibility to login to FILE MANAGER using domain credentials (username and 
password) for all users belonging to any linked Active Directory group. 
 
If automatic synchronization is enabled, all Windows users belonging to the linked Active Directory group are 
added to Users database and can access FILE MANAGER (and Brain Quick software).  
Main advantage is that linked groups are kept synchronized, so if a new user is added to the group by the IT 
he is automatically allowed to login to FILE MANAGER; similarly, “obsolete” user removed from the group by 
the IT will be no more allowed to login.  
 

USERS DATABASE CONFIGURATION 

IMPORTANT NOTE. It is highly recommended that Users database configuration is performed by expert 
technicians only, i.e. by authorized users with a complete understanding of FILE MANAGER software 
architecture and the networked environment where Micromed softwares are installed.  
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As mentioned above, in a networked environment users are centrally administered, and all users are stored 
in the central Users database. 
The Users database can contain both Windows users (Active Directory users) and workgroup users (non-AD), 
i.e. it is possible to choose whether to authenticate only with Micromed defined users (non-AD) or to 
authenticate using Active Directory. 

 
Administrator user only can (directly within FILE MANAGER in a dedicated and protected area) manage the 
central Users database with possibility to: 

• Add/modify/delete users (non-AD) to database 

• Customize user Roles 

• Setup the “generic” protection password used to specific operation  

• Manually synchronize linked Active Directory groups 

From Micromed Suite, it is possible to access the Users Database Manager area. Go to Micromed Suite users 
tab, click on Logon and then on “Users Database” button. 
 
“Users Database Manager” window is composed by a toolbar and the Users Area which displays all users 
stored inside the Users Database, both Windows and not, grouped by role. If the role is linked to a specific 
Active Directory group also group name is shown between brackets. 
For each user the following information is shown: full name, username (used for the authentication), and 
whether it is a Windows user imported from Active Directory.  

 
The toolbar contains all buttons organized in functional groups: Users, Roles and Generic Password. 

 
 

Adding a new user 

Clicking the New button it is possible to create a non-AD user and assign it some “special permissions” (role). 
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User Database Manager - New User 

In the “New user” dialog window, the following information is mandatory: first name and last name, birthdate, 
username and password, and user role (to be selected among the available ones).  

Note. A double confirmation is required for both username and password.  

 
To change an existing non-AD user information or the assigned role, select it and click the Modify button. It is 
also possible to delete a non-AD user, i.e. to remove it from database, by clicking the Delete button; once 
deleted the user cannot access FILE MANAGER anymore. 
Note. Active Directory user management is demanded to IT department, that is domain users can only be 
imported with their own credentials and associated to a set of pre-defined permissions by linking the 
domain group to which they belong to a specific FILE MANAGER role. 
 

Customizing Roles 
To give specific permission to user or group of users, it is possible to customize one of the available Roles. 

From the Roles tab, click the Setup button to open “Role management” dialog. 

 
All available Roles are listed with the possibility to customize each one, except for the Administrator, i.e. to 
change the collection of default permissions assigned.  

 

 

 

 

 

 

 

 

 

 
 

 
 

 
 

 
 

             Roles               Role Permissions 

Clicking the “Edit role” icon a dialog will open with the list of all user permissions available for the selected 
role; simply check or uncheck single to change pre-defined permissions associated to the role and click “Ok” 
to confirm. It is also possible to change the default name assigned to each role, except for the Administrator. 
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Generic Password Setup 
Critical operations are furtherly protected by password, i.e. user needs to enter a “generic” protection 
password, to access specific FILE MANAGER functionalities or confirm specific operation. 
In a networked environment, the “generic” password is shared by all stations and can be changed by 
authorized user only. 
 
Clicking the Setup button in the Generic password group it is possible to change the default password; a double 
confirm is required. 

 

Generic password Setup 

SYSTEM98 SQL MANAGER 

The System98 SQL Manager tool is a Micromed application which allows to create Micromed Patient Database 
that is managed and used by the FILE MANAGER.  

The application is comprised of two selectable macro areas; clicking the button with the “computer” icon will 
allow the user to set up the Patient Database. 

 

CREATING A PATIENT DATABASE 

In System98 SQL Manager main window select the “computer” icon and choose the “New SystemPlus 
Database” option to create a new Patient Database 

 

System98 SQL Manager - New Database Creation 
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In the “New SystemPlus Database” dialog, enter the name of the SQL Server where you are going to create 
the database and the Database name. 

Important Note. Do not use special characters like “?”, “/”, “.”, “,” and blank spaces into the Database Name; only use 
letters and the underscore character as separator. 

It is also possible to specify valid credentials (username and password) if needed to access the SQL server. 
Finally, select the Database directory, i.e. the path where to save the database; if changing the default folder, 
ENSURE THAT THE FOLDER EXISTS WITHIN THE COMPUTER WHERE THE SERVER IS DEFINED. Click “OK” to 
confirm database creation. 

 
IMPORTANT NOTE. THE PATIENT DATABASE NEEDS TO BE UPDATED IN ORDER TO BE USED BY THE FILE 
MANAGER. WHEN A RESOURCE LINKED TO THE PATIENT DATABASE IS DEFINED FILE MANAGER WILL ASK 
THE USER TO PROCEED WITH THE UPDATE, REMIND TO ANSWER “YES”.  

 

ADDING NEW WINDOWS USER TO SQL SERVER 

To guarantee the access to Patient Database to a specific Windows user choose the “New login” option. 
In the “New Login” dialog, enter the SQL server name to which add the Windows user and the name of the 
Windows user to add. 

 

System98 SQL Manager - New Login  

Enter valid credentials (username and password) if needed to access the SQL server. Click “OK” to confirm the 
new login. 
 

OTHER FUNCTIONALITIES AVAILABLE 

From System98 SQL Manager, in the area dedicated to Patient Database there also the following options 
available: 

• Backup of SystemPlus Database, to perform a backup of the selected database. The target folder 
for backup must exist within the computer where the server is defined. 

• Restore of SystemPlus Database, to restore a database from the backup folder and to save it to the 
target folder.   

• General Information, to obtain information about the selected server. This shows which database 
are defined within the server and which users have access to the server. 
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• Test of SystemPlus Database, to test the selected database. Both in case of success or failure, it is 
possible to view the test result in the Windows registry. 

• Delete a Database, to delete the selected database 

• Import SystemPlus database – Access to SQL Server, to import data from one database to another. 
The fields to fill in are: 

o Name of the server to copy the database to 

o Username and password to access the database 

o Target database name 

o Folder of the target database 

o Source folder to copy the data from 

• Move Database fields, to switch the database fields. 
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KEY UPDATER 

The Key Updater tool is an external application used to activate and update the license keys of the FILE 

MANAGER and other Micromed software.  

It is installed as part of the Micromed Suite installation and can be launched from the Network menu of the 

suite itself.  

 
 

As shown in the figure below, the Key Updater main window is divided in three columns: 

• the first column (on the left) shows all the keys that can be viewed in the Key Updater, their ID, their 

type, days left to expiration, if network keys and the related number of seats. At the bottom, there 

is a Key Tools panel with two buttons: 

o Save Computer Fingerprint, which allows to generate the fingerprint of the machine for 

which requiring a new license key. 

o Load Requested Licenses from V2C, which allows to activate a new license key or to 

update an existing key with the additional licenses required starting from the V2C file 

received from Micromed. 

• The second column (in the middle) lists all the available licenses for the selected key, those that have 

already been activated (“Is Enabled” column) and those to add, in case of existing key update. 

• The third column (on the right) shows the options enabled related to the sets of mutual exclusive 

licenses with the possibility to select those to add. At the bottom there is the Generate C2V button 

which allows to generate a key update request with the selected licenses to add. 
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The Key Updater allows users to view and update all keys managed by Micromed; keys can be grouped as 

follows: 

• Hardware keys, which are simple USB dongles. 

• Local software keys, which are codes saved on the computer. These keys can only be used on the 

computer for which they were generated and cannot be recognized by any other computer.  

• Network software keys, which are a special type of software keys that can be used by a predefined 
number of computers (workstations) simultaneously. 

 

UPDATING KEYS 

The process of updating licenses for hardware and software keys follows these steps: 

1. If updating a hardware key, connect it to the computer. Launch the Key Updater: the key will appear 

on the left column in the list of available keys. If updating a software key, ensure that the computer 

with the software key of interest is being used. 

2. Select the key to update in the left-hand column. 

3. Select the licenses to add by enabling them in the “To Add” column of the license list in the middle 

pane and/or selecting option to add/change in the dropdown menus related to mutual exclusive 

licenses on the right pane. 
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4. Click the Generate C2V button to generate the “.c2v” file in the defined path. 

The “.c2v” file needs to be sent to Micromed, which will use it to generate the codes needed to unlock the 

requested licenses. These codes will be stored in a “.v2c” file that Micromed will send back to you. 

 

In order to update the key after receiving the “.v2c” file with the code, the user needs to: 

1. Ensure that the hardware key is connected to the computer or use the computer with the software 

key. 

2. Launch the Key Updater and select the key to update in the left column. 

3. Click the Load Requested Licenses from V2C button to load the received “.v2c” file. 

When the .v2c file is successfully loaded, the updated key and the new licenses will be immediately available 
to the FILE MANAGER.  
 

CREATING SOFTWARE KEYS 

To create software keys, the user will need to generate the fingerprint for the machine where the licenses will 

be installed. The fingerprint is a file containing the digital print of the machine and is therefore specific to each 

computer.  

 

To generate the fingerprint, launch the Key Updater and click the Save Computer 

Fingerprint button (in the Key Tools pane on the left) which allows to save the 

fingerprint in the desired folder.  

A message will confirm if operation is successful. 

 

The fingerprint file needs to be sent to Micromed, which will use it to generate a 

“.v2c” file containing the requested software key.  
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Note. Since the “.v2c” file is generated using the fingerprint of the computer for which the software key was 

requested, it is not possible to use the same “.v2c” file for a different computer.  

 

In order to load the received “.v2c” file, the user needs to: 

1. Launch the Key Updater. 

2. Click the Load Requested Licenses from V2C button in the Key Tools panel on the left to load the 

received “.v2c” file with the requested key. 

3. After clicking “Open”, the software key will be created and it will appear in the list of keys in the left 

column. A message will notify if operation is successful. 

 

 
The software key and related licenses will be immediately available to the FILE MANAGER. 
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APPENDIX 

SHORTCUTS 

Events Shortcuts 

Previous event CTRL + P 

Next event CTRL + N 

  
Paging Shortcuts 

BEGIN Home 

END End 

Interval Back Page Down 

Interval Forward Page Up 

Auto Back Down Arrow 

Auto Forward Up Arrow 

Page Left Left Arrow 

Page Right Right Arrow 

½ Page Left SHIFT + Left Arrow 

½ Page Right SHIFT + Right Arrow 

1 Sec Left CTRL + Left Arrow 

1 Sec Right CTRL + Right Arrow 

Increase Speed * 

Decrease Speed / 

Place/Move ruler cursor CTRL + F 

Go to time CTRL + T 

  
Video Shortcuts 

Play/Stop Video Space 

 

TERMINOLOGY  

Review Window 

The EEG review screen is the part of the program that is used to review and analyze EEG exams. In the review 
section it is possible to review more than one trace at the same time and this allows the user to compare 
the different exams of the same patient or of different patients. 
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Ribbon Menu 

The upper part of BRAIN QUICK SOFTWARE review and acquisition window containing the toolbars 
commands that allow access to all the review and acquisition functions. 
  

Events Panel 

The list of events placed in the trace opened in review and acquisition. 
 

HFO 

Filters 

BRAIN QUICK SOFTWARE allows the possibility to set Low/High pass frequency from Montage Setup and 
directly from acquisition/review window and to apply the same filter at the same time to all the lines or it 
can be applied separately on the selected line.  
A popup menu appears in order to let the user choose the value of the cut off frequency of the filter.  
  
The review software is HFO compatible and contains possibility to set band filters for High Frequency 
Oscillation visualization allowing the possibility to filter at high frequency bands and to set “FIR” filter type, 
instead of the “IIR” filter type for the spike visualization 
  

 
  
Below 2 figures are reported in order to show the same part of an EEG trace filtered at [80-250 Hz] for RIPPLE 
visualization using a FIR filter in the first figure and an IIR filter in the second figure. As you can see, the 
correct HFO visualization is available only by selecting FIR filter type: 
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Figure: FIR Filter between [80-250Hz] 

 
Figure: IIR Filter between [80-250Hz] 

  
As you can see, the typical filter commercially available (IIR Filter) does not permit the correct HFO 
visualization. Micromed software permits to have both filters available in Montage Setup.  
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